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1. Osnove Photoshopa - I deo 
2. Color Settings 
3. Stari papir 
4. Displace mapa 
5. Oblaci 
6. Stvorite vlastiti brush 
7. Pattern Factory 
8. Gel Text 
9. Golden Text 
10. Burnt - in text 
11. Alien Text 
12. Kako da fotografiju pretvorite u crtež 
13. Retuširanje - kako da se podmladite bez   
      plastičnih operacija 
14. Kako eliminisati crvenilo u očima 
15. Slikanje u photoshop-u 
16. Crno-belo u kolor 
17. Panoramska fotografija 
18. Fade 
19. Fade 2 
20. Tekstura 
21. Nešto između – Duotone 
22. Mesečina 
23. Tonirane fotografije 
24. Kreiranje providne sfere 
25. Vizit karte – dizajn 
26. Foto montaža 
27. Obrada portreta – Retuširanje 
28. Retuširanje lica 
29. Izbeljivanje zuba 
30. Stapanje više fotografija u jednu 
31. Natpis od fotografije 
32. Dodavanje TV linija na fotografiju 

33. Dodavanje mreže na fotografiju 
34. Dodavanje kiše na fotografiju 
35. Nebo - kako ga "doterati" i intezivirati 
36. Promena boja na fotografiji 
37. Veštački DOF (Depth of field - dubinska  
       oštrina) 
38. Izrada bar koda 
39. Efekti na fotografiji 
40. Popravka loših fotografija 
41. Manipulacija slojevima 
42. Zabava sa kanalima 1  
43. Zabava sa kanalima 2  
44. Novo za staro 
45. Art foto - tekstura 
46. Korekcija boja 
47. Stilovi slojeva 
48. Spirala 
49. Dreamy efekat 
50. Contact sheet (kako da odštampate  
      veliki broj fotografija) 
51. Save for web 
52. Vatreni tekst 
53. Clliping group 
54. Plakat- Total football 
55. Popunjavanje bojom (filling) 
56. Kreiranje sličice za Desktop 
57. Isecanje slike 
58. Upotreba "magnetnog lasoa" 
59. Minijaturne 3D tačke 
60. Korišćenje Plug-In modula 
61. Kreiranje plastičnog dugmića 
62. Kreiranje sloja sa grafičkim objektom 
63.Smooth Blending Old and Young Faces 
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Osnove Photoshopa - I deo 
 
Dakle, ovaj će tutorial pokriti osnove photoshopa. Ovo je I deo koji će se baviti alatima, keyboard 
shortcutima, i nekim trikovima koji svi zajedno olakšavaju korištenje te omogućavaju ugodniji rad u 
Photoshopu. 
Uputstvo: Na kraju sekcije o svakom alatu se nalazi shortcutova. Ukoliko je shortcut prikazan samo kao 
jedna taster (Ctrl) to znači da trebamo koristiti taster Ctrl kada je željeni alat već označen. Ukoliko se radi o 
kombinaciji tastera (Shift+M) to nam govori da se ovaj shortcut koristi simultanim pritiskom na taster Shift, 
zatim taster M.  
 
 
 
 

 

Najčešće korištene PS shortcuti 
U ovoj sekciji bih htio navesti neke, najčešće korištene shourtcutove (prečice). Ovo su sc-ovi 
koje ja osobno najviše koristim.  
Ctrl + N  New file  
Ctrl + O  Open file  
Ctrl + S  Save 
Ctrl + Alt + Shift + S  Save for web  
Ctrl + Q  Quit Photoshop  
Ctrl + Z  Undo 
Ctrl + Shift + Z  Redo (history back)  
Ctrl + C  Copy 
Ctrl + V  Paste 
Ctrl + M Cut 
Ctrl + A  Select All  
Shift + Del  Cut 
Shift + Ins Copy 
Ctrl + W  Close window  
Ctrl + D  Deselect 
Ctrl + H  Hide extras (guides, itd.) 
Ctrl + R  Hide Rulers  
Ctrl + U  Hue / Saturation  
Ctrl + T  Transform 
Ctrl + Shift + I  Invert Selection  
Ctrl + Shift + N  New layer  
Ctrl + E  Merge layers  
Ctrl + (klik na layer) Precizna selekcija  
X Promena prednje i zadnje boje  
D  Vraćanje na belu / crnu boju  
Desni klik  Dodatne opcije, kao veličina brusha, odabir boje, itd.  
Dupli klik na Hand  Zoom to fit  
Dupli klik na Zoom  Vraćanje na 100%  
Ctrl + Tab  
(Ctrl + Shift + Tab) 

Prebacivanje unutar otvorenih photoshop dokumenata 
 

 
 

 
 

 

Prednje područje je "Foreground color", dok je zadnja, "Background color", tj. pozadinska 
boja. Sa strelicama ta dva područja izmjenjuju boje koju su sadržavali, dok se sa malom 
ikonicom u donjem levom kutu vraća stanje na početne boje (Crna / Bela) 
 
Shortcut za promenu ekrana između 1. Standardnog ekrana / 2. Full ekrana sa izbornikom / 
3. Full ekrana bez izbornika. je taster F. 

 
 
 
 

 
Svaki alat ima svoj pod menu (izbornik). Po defaultu se nalazi ispod glavnog File-Help izbornika, te je 
drugačiji za svaki alat. 
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Rectangular Marquee Tool (M)  
Prvi alat na paleti alata (Window > Tools) je RM Tool, ali ćemo ga od milja zvati alat za selekcije. 
Alat za selekciju nam omogućava da selektiramo, tj. označimo željene pixele. Uoćavamo odmah da 
neki alati imaju u donjem desnom kutu strelicu, dok ostali nemaju. To nam sugerira da se još neki 
alati nalaze pod istom grupacijom. Malo dužim klikom na RM Tool, prikazuje nam se grupa od 
četiri alata. 
 

 
 
Kvadratić pokraj RM Toola oznacava da je trenutno baš taj alat iz cele grupe selektiran. Uz taj, 
postoji i vrlo slični, samo eliptični alat. Znaci, ukoliko se njime radi selekcija, ona neće biti kvadrat 
/ pravokutnik vec kružnica / elipsa. Alati Single Row, te Single column, označe sve pixelu u koloni 
ili redu, te imaju selekcijske oznake 1, visina dokumenta, ili širina dokumenta, 1. 
Shortcuti: 
Shift + M Prebacivanje između RM te EM Toola. 
Shift Ukoliko nema selekcije > Selektiranje "pravilne" selekcija (kvadrat, kružnica) 
Alt Ukoliko nema selekcije > Znaci, x, y udaljenost od početne tačke se uzima, a 

selekcija radi pravilni pravoknutik 2x, 2y 
Ctrl Ukoliko nema selekcije > Privremeno selektiranje Move (V) Toola  
Shift Ukoliko ima selekcije > Dodavanje selekcije na već postojeću.  
Alt Ukoliko ima selekcije > Oduzimanje selekcije od već postojeću.  
Ctrl Ukoliko ima selekcije > Micanje selekcije unutar layera  
Ctrl + T  Ukoliko ima selekcije > Editiranje selekcije (Free Transform)  
Q Ukoliko ima selekcije > Editiranje selekcije (Free Transform) Ulaženje u Quick 

Mask  
  

 
 
 
 
 
 
 
 

Move Tool (V)  
Drugi po redu alat, je Move Tool, alat za micanje objekata. Mislim da netreba puno objašnjavati, 
ukoliko postoji selekcija sa alatom se miče selekcija, u suprotnom se miče sadržaj celog layera.  
Shortcuti: 
Alt Kopiranje sadržaja  
Shift "Pravilno" micanje (po zamišljenim linijama na 0,90 i 45 stupnjeva od prvobitnog 

položaja). 
Alt+Shift "Pravilno" kopiranje sadržaja.  

 

Lasso Tool (L)  
Lasso Tool služi također za selekciju, samo malo nepravilniju. 
 

 
 
Lasso Tool manje-više prati pokret miša te radi selekciju. Polygonal Lasso Tool je alat kojeg volim 
zvati alat na pokrete te stvara ravne linije izmedu tačaka (kontrolne tačke) i radi nekakvu n-
terokutnu (nepravilnu) selekciju. Treći alat iz grupe, Magnetic Lasso Tool, radi polu automatsku 
selekciju. Prati pokret miša, sa klikom mu određujemo kontrolne tačke. 
Shortcuti: 
Shift + L  Prebacivanje između L, PL i ML Toola. 
Alt Stvara tačku koja će zatvoriti selekciju (Povući liniju od te tačke do početne)  
Shift Kod PL Toola, crta "pravilne" linije, pod 0, 45 i 90 stupnjeva. 
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Magic Wand Tool (W)  
Sa MW Toolom, radi se automatska selekcija približnih boja. Nakon klika na neko područje označi 
se selekcija oko središta koja sadrži pixele u bojama iz ranga prosječne vrednosti. 
Shortcuti: 
Alt Ukoliko ima selekcije > Oduzima selektirano područje 
Shift Ukoliko ima selekcije > Dodaje selektirano područje 
   

 

Crop Tool (C) 
Vrlo sličan alat kao i Select tool (Rectangular Marquee Tool), vrede svi shortcuti kao i kod njega. 
Razlika je što radi selekcije, ali nakon odobravanje selekcije (Ctrl+Enter) veličina slike (canvas) 
se smanjuje na samo odabrano, tj. selektirano područje. 
 

 

Slice Tool (K)  
Slice Tool, "alat za rezanje". Njega služimo pretežito pri kreiranju web stranica. Kada je layout 
(predložak) složen u PSu, treba ga razrezati na mnogo malih dijelova. Uz pomoc slice toola, onaj 
stari proces (select - ctrl c - ctrl n - ctrl v - save for web) nije potreban. Kod Save for web opcije, 
bit će ponuđeno saveanje određenog slicea (sekcije). 
 

 
 
U grupi sa Slice Toolom nalazi se i Slice Select Tool, koji omogućuje selektiranje sliceova, micanje 
po hijerarhiji naprijed, nazad, te promoviranje u user slice (za razliku od "Auto Slices" koje PS 
kreira sam prilikom stvaranjem naših)  
Shortcuti: 
Shift + K  Prebacivanje alata između S i SS Toola  
Shift Kreiranje "pravilnog" slicea, kvadratnog oblika 
   

 

Healing Brush Tool (J)  
Slično idućem alatu, Clone Stamp Tool-u, i HB alat radi kopiranje određenog dela slike. Razlika kod 
HB Toola, je što on "pazi i gleda" orginal sliku, te klonirani dio prilagođava. Vodi računa o bojama 
te osvjetljenju na originalnoj slici. 
 

 
 
Patch tool, s druge strane, koristi sličnu metodu,. Nema source centar, nego se selektira područje, 
koje se zatim pomiče te se tako da krajnje i početno područje spajaju. Kod selektiranja, u gornjem 
izborniku možemo izabrati source ili destination (izvor ili cilj). 
Kod oba alata uz source opciju se može izabrati i 'Use pattern', gdje se umesto izvora koristi 
pattern. On se na selektirano poručje primijenjuje ali naravno uzima se uz obzir detalji te izgled 
tog područja 
 

 

Brush Tool (B) 
U ovoj grupaciji nalazimo Brush i Pencil Tool (mi bi rekli kist i olovka). Zapravo vrlo jednostavno, 
jedni od najosnovnijih alata za crtanje, pogotova za PS "crtače". U gornjem izborniku za oba alata 
biramo vrstu, velićinu, opacity, te flow. Opacity bi mogli nazvati kao i postotak vidljivosti dok je 
flow brzina nanošenja boje. 

 
 
Alt Privremeno prebacivanje na Eye Drop alat.  
Shift Pravilno nanošenje boje, vertikalno ili horizontalno.  
Ctrl Privremeno prebacivanje na Move alat.  
0-9 Mijenjanje postotka opacitya ili flowa 
Shift + B Prebacivanje između Brush i Pencil alata 
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Clone Stamp Tool (S) 
CS Tool (alat za kloniranje) je sličan Healing Brush Toolu kojeg smo nešto prije spomenuli. Velika 
razlike između ta dva alata je što kod Clone Stamp alata, ne dolazi do nikakvog prilagođavanja 
originalnoj slici, samo se kopira iz željenog sourcea (izvora). Isto tako imamo i Pattern Stamp Tool, 
koji funkcionira isto kao i CS Tool, osim što umesto izvora uzima pattern (teksturu) te primenjuje 
na zadano područje. 
 

 
 
Alt Uz Alt i klik se određuje cetar područja izvora 
Shift Klonira se po vertikalnim i horizontalnim linijama 
Shift + S  Prebacivanje između CS i PS alata  
  

 

History Brush Tool (Y) 
HB Tool rani nešto slično kao i Undo akcija, samo što to radi na određenom području koje dodiruje 
naš brush (četka). Uz pomoć Art History Brush zapravo ponovno crtamo sliku, uzimajući proizvoljni 
brush, gdje ps gleda source (tj izvor) slike. 
 

 
 
Ctrl "Pravilno" korištenje, pod kutem od 0 i 90 st.  
0-9 Mijenjanje opacitya 
Shift + Y  Prebacivanje između HB i AHB alata  
  

 

Eraser Tool (E) 
Mislim da Eraser Tool netreba posebno objašnjavati. Uglavnom - briše pixele. Kod Magic Eraser 
Toola, zapravo nam je proces Select Magic Wand Tool > Delete skraćen. Tako, svakim klikom na 
magic eraser tool, briše se područje sa sličnim bojama oko tačke gdje smo spustili Eraser Tool. 
 

 
 
Ctrl "Pravilno" korištenje, pod kutem od 0 i 90 st.  
0-9 Mijenjanje opacitya 
Shift + E  Prebacivanje između E, BE i ME alata  
  

 

Paint Bucket Tool (G) 
Paint Bucket Tool, kantica sa bojom, služi za bojanje većih površina gdje nanosi boju na područje 
od zadanog (gdje smo kliknuli) to bilo kakvih granica. Ukoliko te granice ne postoje, nanesena je 
boja na ceoi dokument. Gradient Tool, slično kao i Paint Bucket, nanosi boju. Razlika je u tome što 
Gradient ne nanosi "solid" boju, nego naravno, gradient (frelauf, iris, prijelaz iz boje u boju). 
 

 
 
Ctrl "Pravilno" korištenje, pod kutem od 0, 45 i 90 st.  
0-9 Menjanje opacitya 
Shift + G  Prebacivanje između PB i G alata  
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Blur Tool (R) 
E, ovo je zabavna Grupa. U ovoj grupaciji alata nalazimo Blur, Sharpen i Smudge Tool. 
Spomenuću šta rade, premda sam siguran da kužite. Blur zamutnjuje, Sharpen izoštruje, dok 
Smudge "razmazuje", na neki naćin. Alt kratica radi drukčije za svaki alat. Kod Blur alata, 
prebacujemo se privremeno na Sharpen. Kod Sharpen alata, sa Alt se prebacujemo na Blur. Kod 
Smudge alata, sa Alt "razmazujemo" (smudgeamo) dokument sa foreground bojom. 
 

 
 
Ctrl "Pravilno" korištenje, pod kutem od 0, 45 i 90 st.  
0-9 Mijenjanje opacitya 
Shift + R  Prebacivanje između B, S i S alata  
  
 

 

Dodge Tool (O)  
Grupa ova tri alata, Dodge, Burn i Sponge Tools, služe za fino editiranje slika. Mogli bi reći, Dodge 
i Burne su komplementarni alati. Dodge alat služi za osvjetljivanje nekog područja koje je na 
udaru našeg brusha. S druge strane sa Burn alatom, potamnjujemo podrućje. Osim biranja 
brusha, mjenjanje rangea (dometa) postoji i također opcija mijenjanja ekspozicije. 
 

 
 
Kod Sponge alata, imamo opcije Saturate te Desaturate. Kod Saturate varijante naravno dodajemo 
boju dok kod Desaturate pretvaramo sliku u crno belu, grayscale. Mislim da je to dovoljno 
razumljivo.  
Ctrl "Pravilno" korištenje, pod kutem od 0, 45 i 90 st.  
0-9 Mijenjanje opacitya 
Shift + O  Prebacivanje između D. B i S alata 
 
 

 
 

 

Path Selection Tool (A) 
Na ove ćete alate naletiti isključivo ukoliko koristite pathove, inače će ostati nezapaženi i 
neinteresantni zauvijek. Ukoliko ste radili sa nekim vektorskim programima (Illustrator, Flash), 
tada ste manje više upoznati sa mogućnostima te razlikama ova dva alata. Oba alata, kao što piše, 
služe sa selekciju. Razlika je u tome što Path Selection Tool služi za selekciju celog patha kao 
jedne celine, dok Direct Selection Tool koristimo za odabir pojedinog dela, sekcije celog patha. S 
njime, možemo ili označiti pojedinu "kontrolnu tačku" (Anchor point) ili pojedini path između dvije 
takve tačke. 
 

 
 
Na Path selection Tool se primijenjuje iste kratice kao i za Move Tool, jednako se ponašaju. Kod 
direct selectiona jedini shortcut ikakve koristi je Shift, gdje možemo (kao i inače sa shiftom) micati 
"pravilno", po zamišljenim kutevima od 0,45 i 90 stupnjeva.  
Alt Kopiranje sadržaja  
Shift "Pravilno" micanje (po zamišljenim linijama na 0,90 i 45 stupnjeva od prvobitnog 

položaja). 
Alt+Shift "Pravilno" kopiranje sadržaja. 
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Horizontal Type Tool (T) 
Grupa alata koja se bavi tekstom, ergo, jako važan alat. Ipak, prvi alat, Text Tool (ili službeno 
Horizontal Tyle Tool), je alat koji se koristiti u 95% slučajeva. Klikom na dokument se stvara novo 
text polje, dok klik+drag izaziva stvaranje text boxa. U tom trenu PS prelazi u text mode, tako da 
razne varijante tipa idem stisnut V i pomaknut si text neće funkcionirati jer se u tom modu još 
uvijek. Iz moda se izlazi sa klikom na kvačicu gore na pod meniju alata, ili lakšim i bržim načinom, 
pritiskom na ctrl+enter. 
 

 
 
Samo par reči o ostalim alatima, neću ulaziti u nikakvu podrobniju analizu. Vertical Type Tool, 
znači samo ime govori. Radi istu stvar samo po vertikali a ne horizontalni kao standardni Type 
Tool. Mask Tool po pisanju texta te izlaska iz tog moda ostavlja nam isključivo selekciju. On ne 
stvara text static field kao Type Tool koji je moguće kasnije editirati, nego samo selektirane pixele 
tog teksta.  
Alt Dobivamo upit za visinom te širinom text boxa nakon čega ga PS kreira što 

zamjenjuje ručno povlačenje text boxa te "pogađanje" veličine.  
Shift Konstruiranje "pravilnog" text boxa, kvadratnog oblika. 
0-9 Mijenjanje opacitya 
 
 

 

Pen Tool (P)  
Grupa alata koja se bavi crtanjem, te editiranjem pathova. Također, ponavljam, neko tko je radio 
sa nekim vektorskim programom zapravo shvaća što ovi alati rade. Naravno, budući da mnogi 
nisu, ja ću ukratko opisati te alate. Pen tool stvara nekakav oblik (shape). Shape koji se stvara je 
vektor. Ukoliko želimo raditi po tom obliku, moramo ga pretvoriti u raster. Desnim klikom na layer 
sa njime te klikom na "Rasterize Layer" dobivamo iz vektora raster. On to crta puneći oblik koji 
smo mi stvorili postavljanjem kontrolnih tačaka (Anchor point) širom dokumenta. Ukoliko ne 
želimo "crtati na poteze", koristi se Freeform Pen Tool. On je više poput olovke, gdje nakon 
odcrtane sekcije, on sam stvara kontrolne tačke. Micanje celog shape-a, te micanje pojednih 
kontrolnih tačaka se radi pomoću Path Selection Toola, koji je opisan ranije. 
 

 
 
U ovoj grupi alata osim dva glavna, nalazimo još tri pomoćna alata. Add Anchor Point dodaje te 
kontrolne tačke, recimo na pathu kojem želimo promijeniti oblik, te smanjiti kut (npr.) a 
nemožemo sa postojećim, dodajemo još jednu tačku. Delete Anchor Point radi drukčije nego kad 
sa Select Toolom označimo tačku i pritisnemo taster delete. Kad bi napravili ovo zadnje, stvorila bi 
se rupa između prethodne te sledeće tačke. Uz pomoć Anchor Point Toola, ps sam povezuje 
prehodnu i sledeću tačku na najkraći mogući način.  
 
Convert Point Tool, pretvara Anchor point (kako sam ih iz milja nazvao kontrolne tačke) u "obične" 
tačke. Znači Anchor Point u Point. Razlika između dva navedena, je to što Anchor Point sadrži path 
od prethodne do te tačke. S druge strane, "obični" point, sadrži samo poziciju ali ne i nikakav path 
(put) te tako se stvara samo najkraća dužina izmeđju prethodne i te tačke. 
(Možda malo komplikovano zvuči, ali igrajte se dva minuta s time i sve će vam biti jasno) 
Ctrl Privremeni prelazak u Direct Selection Tool  
Shift Konstruiranje "pravilnih" pathova pod 0,45 i 90st.  
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Rectangle Tool (U) 
Ova grupa od 6 alata sadrži Rectange (Kvadrat), Rounded Rectangle (Zaobljeni kvadrat), Elipse 
(Elipsa), Polygon (Poligon, tj. n-terokut), Line (Linija; crta) i Custom Shape (Vlastiti oblik) Tool. Sa 
svakim od alata crtamo istoimene oblike. Cela grupa se ponaša kao nekakav path, te oblik koji 
dobijemo nije rasteriziran. 
 

 
 
Dodatne opcije za alata se nalaze u pod meniju od alata koji se nalazi ispod File-Help menija. 
Shift + U  Prebacivanje između svih alata  
Shift Konstruiranje "pravilnih" oblika 
  
 

 

Notes Tool (N) 
Ako želimo ostaviti poruke sebi (zaboravni smo), dizajneru kojem predajemo psd ili recimo poruku 
za sve korisnike nekakvog javnog psda (template avatara) koristit ćemo notes tool. To su interne 
poruke koje se ne prikazuju u niti jednom programu osim PSa. Možemo ostaviti taj Post-it (notes 
tool) ili zvukovnu poruku. Ovo je jedan od dodatnih funkcija koja je svoju premijeru doživjela tek u 
sedmici PS-a. 
 

 
 
 

 

Eyedopper Tool (I)  
Definitivno jedan od korištenijih alata. Osobno ne potežem baš za slovom I na tastaturi, nego 
ukoliko koristim brush/bucket tool obično potežem za alt pa klik. To je ono "privremeno 
prebacivanje" na Eyedropper o kojem sam govorio ranije u tutorialu. Sa Eyedropper alatom 
uzimamo vrednost jednog pixela na koji smo kliknuli te nam po defaultu ulazi u "foreground color" 
polje na tools paleti. Color Sampler Tool nam stvara do 4 eyedropper tačke. Njihova vrednost boje 
prikazana je u info prozoru kao #1, #2, #3, #4 te, kao i osnovnu boju, može prikazivati u RGB, 
CMYK, Grayscale, itd. Kod Color sampler polja, možemo birati boju centralnog pixela, prosječnu 
boju polja 3x3pixela, ili prosječnu boju polja 5x5 pixela (average 5x5).  
Measure Tool mislim da netreba puno objašnjavati, ono je digitalno ravnalo koje nam mjeri 
udaljenost od tačke A do tačke B. Dužina je ispisana u Info windowu PSa. 
 

 
 
Shift + I  Prebacivanje između svih alata  
Alt Uzimanje background boje  
Shift Privremeno prebacivanje na Color Sampler Tool  
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Hand Tool (H) 
Ukoliko imamo enormne veličine dokumenta, ili smo jednostavno na 1200% povećanja, micanje 
pozicije bi moglo stvarati probleme. Hvala bogu, postoje tri načina da nam se to olakša. Prvi način 
je pomicanje crvenog prozorčića (koji označava aktivno područje na dokumentu) na Navigator 
windowu PSa. Drugi način je uz pomoć pomicanja strelica (tj. scrolovanja, dole-gore te levo-
desno). 
Treći način, ujedno i najlakši, je uz pomoć Hand Toola. Sa njime zagrabimo dokument te ga 
guramo ili vučemo, po želji.  

Space Kad si na bilo kojem alatu, space poziva hand (space + klik, tj drag) 
 
 

 
 

 

Zoom (Z) 
Zoom Tool, uvećanje te umanjenje dokumenta. Maximalno je 1600%, dok je minimalno zavisno o 
svakom dokumentu te njegovoj veličini.  

Alt Zoom Out  
Click+Drag Uvećanje određenog dijela 
Ctrl+0 (num 0) Fit to screen 
ctrl+alt+0 (num 0) Actual size 
ctrl+"num+"  Zoom In (Ctrl+"+") 
ctrl+"num-"  Zoom Out (Ctrl+"-")  
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Color Settings 
 
Umesto da kažemo na koji način koje settinge treba namestiti, radije ćemo 
objasniti što koja opcija radi. Na taj način naučiti ćemo sami namestiti opcije i u 
nekakvim drugačijim uvjetima. Color Setings dialog se otvara u Photoshopu 
kroz menu Edit -> Color Settings. Trebalo bi odmah uključiti Advanced 
mode, kako bi se prikazale sve moguće opcije Color Settingsa..  
 

 

 
Working spaces, su tzv. kolor profili koji se koriste za obradu slika. To bi trebali biti profili koji imaju dobro 
nameštenu neutralnu komponentu. Neutralne boje na slici vrlo su bitne jer od njih mozak polazi kada 
promatramo sliku. Ako su na slici (bilo otisnutoj ili na ekranu) neutralne boje pogrešne, utisak je da je cela 
slika pogrešna. 
 

 
 
Krenimo prvo na RGB working space, budući da ćemo u njemu obavljati sve kolor korekcije.  
(4) AdobeRGB1998 je dobar izbor za korigovanje i snimanje slika. Ima izvrsnu neutralu, a dovoljno ima 
velik gamut tako da se u njemu mogu snimiti izvorne boje sa raznih uređaja. sRGBIEC61966 je 
Microsoftov i HPov pokušaj izrade prosečnog kolor profila sa prosečni monitor. Ukoliko Windowsi nemaju 
izabran monitor profil u Display optionsima (a većina ljudi to nema namešteno), Windowsi pretpostavljaju da 
se radi o slikama u sRGBu. Ovaj profil se koristi kod izrade za Web. Ako je on izabran kao working space, 
slike će izgledati isto u Photoshopu kao i u programima poput Dreamweavera. 
(3) "Monitor RGB - ime profila" pokazuje koji se trenutni monitor profil koristi. Monitor profil također se 
može izabrati kao working space, ali korisnost toga je vrlo upitna jer monitor profili u pravilu nemaju dobru 
neutralu i imaju manji gamut od tiska, čime sami sebe ograničavamo već u startu. 
(2) Load RGB i Save RGB omogućavaju učitavanje profila koji se ne nalazi na standardnom mestu gdje su 
profili i snimljeni (pod WinXP to je ..Windows/System32/spool/driver/color/ folder) 
(1) Custom RGB omogućava samostalno definisanje RGB working space-a, no ovde se nećemo baviti time. 
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Kod CMYK working space-a vidimo trenutno aktivni working space (3). (2) Također možemo učitati 
spoljašnji profil koji se ne nalazi na nekoj drugoj lokaciji na disku (vidi iznad), te samim time nije na listi 
profila. Ukoliko nemamo separacijski profil od tiskare, možemo i sami napraviti separacijske settinge i snimiti 
ih kao ICC profil - Custom CMYK (1). 
 

 
 
 
Custom CMYK dijalog na prvom mestu nudi ime profila (ime profila trebalo bi biti opisno tipa: ime, datum, 
opis). (1) Ink Options - Ink Colors koristimo za definiciju boja koje se koriste u tisku. Uz određene 
standardne settinge boja, mi možemo upisati i svoje, izmjerene Custom vrednosti boja (vidi ispod). U 
pravilu ovaj pristup daje tačnije rezultate od predefiniranih ink boja.  
Dot Gain ili prirast tačke je razlevanje tinte po papiru, izraženo u postotku. Primerice, ako u tisak 
predamo 50% raster, zbog razlevanja boje na papiru prilikom tiska i upijanja te boje u papir, 50% raster vrlo 
lako može u tisku biti tamniji i gušći, bliže npr. 70%. Photoshop pri izradi separacije može kompenzirati dot 
gain, tako da kod separacije odmah oduzme zadanu dot gain vrednost i time kompenzira za dot gain koji će 
se dogoditi u tisku. Dot Gain: Standard XY%, je u biti dot gain na 50% rastera i vredi za sve separacijske 
boje jednako. U stvarnosti se neke separacije više 'razlevaju / prirastaju' od drugih, pa je bolje koristiti 
Curves umesto Standard, još bolje ukoliko posjedujemo podatke za Dot Gain svake separacije posebno. 
 
(2) Separation Options 
Separation Options: GCR - Gray Component Replacement / UCR - Under Color Removal  
Najjednostavnije rečeno, kod UCR-a, crna boja se koristi samo u neutralnim i tamnim dijelovima slike, dok 
kod GCR-a crna separacija ide puno 'dublje' u obojani dio slike na način da tamo gdje su podjednake 
vrednosti Cyana, Magente i Yellowa tamo Photoshop "skida" određeni postotak CMYa a dodaje black (K). 
   
UCR ima vrlo strmu krivulju za crnu separaciju što znači da ista je vrlo blaga a posebno je dobar za 
reprodukciju slika koje imaju detalje u tamnim i saturiranim tonovima. Kod GCRa to nije slučaj ali da bi to 
nadomestili imamo UCA opciju (vidi ispod).  
   
Tiskare preferiraju GCR zbog jednostavnije reprodukcije neutralnih tonova. 
   
Black Generation kod GCRa namješta krivulju crne separacije. Light je dobar setting za većinu slika jer 
ako se koristi neki 'teži' black generation, dobivamo crni raster čak i u srednjim i svijetlim tonovima boja što 
može dati dojam da su boje 'prljave'. 
   
Black Ink Limit postavlja najvišu vrednost K (black) komponente, tj. s koliko posto crne će se separirati 
najtamnija tačka. Primerice, kod settinga 100%, crna boja 0R 0G 0B će se separirati kao 100%K + 
odgovarajuće CMY vrednosti unutar zadanog Total Ink Limita. 
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Total Ink Limit je maksimalni dozvoljeni ukupni zbroj postotaka separacija. Cyan % + Magenta % + 
Yellow % + blacK % nikad ne smeju biti veći od zadatog Total Ink Limita. Ovo je jedna od prednosti 
korekcije slika u RGBu. Ako papir ne može podnijeti Total Ink Limit veći od 260% ovdje ga unesemo i kod 
separacije Photoshop pazi da se taj postotak ne prekorači. U protivnom bi količina tinte ako je veća od Total 
Ink Limita mogla uzrokovati veliko razlevanje boja pa čak i raspadanje papira (npr. novinskog) zbog 
prevelike količine (nanosa) boje. Kod korekcije slika u CMYKu vrlo je lagano prekoračiti Total Ink Limit, a 
Photoshop skoro nikako ne upozorava da se to dogodilo. 
 
UCA amount dodaje CMY boje u tamne neutralne tonove (sjene) i time se dobiva veće zacrnjenje u 
neutralnim tamnim tonovima. 
 

 
 
Ink Colors - Custom je definicija boje separacija. U nekim tiskovnim procesima otisnute boje su drugačije 
od standardnih. Na to utječu razni faktori, od boje podloge (papira) pa sve do kiselosti vode koja se koristi u 
boji. Najbolje je tražiti od tiskare zadane vrednosti (C, M, Y, MY, CY, CM, CMY, K i W - boja papira) i to za 
100% raster tih boja. Tiskare u pravilu posjeduju Spektrofotometre i mogu izmjeriti i dati te vrednosti, 
najčešće u Lab koordinatnom sustavu. Boje podloga, tj. papira mogu varirati od žućkastih do ekstremno 
belih (zavisno koliko je izbeljivača dodano prilikom proizvodnje papira). Boja papira također utječe na boje 
otisnutih separacija te ih može izmijeniti. Zato je radi tačnosti potrebno izmjeriti vrednosti (C, M, Y, K, CM, 
CY, MY, CMY i K baš na papiru na kojem će se na kraju i tiskati). 
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1) Color Management Policies bi trebalo postaviti na Preserve Embedded Profiles kako bi se prilikom 
učitavanja slike učitao i sam profil ugrađen u sliku. Ukoliko se profil u slici razlikuje od Working Space-a, 
Photoshop će to javiti i ponuditi konverziju ili rad u color spaceu koji je ugrađen (embedded) u sliku. 
Najčešće se slika konvertira u working space. Da bi to stvarno bilo tako, treba uključiti Profile 
Missmatches: Ask when opening i Ask when pasting. U celom postupku trebalo bi pripaziti da bude 
čim manje konverzija jer se kod svake konverzije iz profila u profil gubi određeni dio podataka (out of gamut 
boja a time i detalja sa slike). 
Uključen Missing Profiles: Ask when opening nam javlja kod otvaranja slike ako ta slika nema ugrađeni 
profil. Nudi nam se i opcija da Assign-amo, tj. dodamo profil slici što se u pravilu svodi na nagađanje color 
space-a u kojem je slika snimljena. Bitno je pogoditi tačan ili što bliži profil, napraviti korekcije i onda 
konvertirati sliku u output profil. 
 
(2) Conversion options nudi izbor Engine-a. Engine je program koji radi konverziju iz profila u profil. 
Adobe (ACE) se pokazuje puno boljim (tačnijim) od ostalih. Kod Windowsa možemo birati i "Windows ICM" 
(tj. Linocolor CMM) a kod Mac-a ColorSync koji onda koristi engine koji je izabran u ColorSyncu. 
Use black point compensation, pazi da se crna tačka source profila pomakne u crnu tačku destination 
profila. 
Use dither 8-bit/channel images je korisna opcija koja dodaje dither noise kod konverzije 8 bitnih slika 
iz profila u profil, i time prikriva neželjenu posterizaciju. Kod rada sa 16 bitnim slikama taj problem je puno 
slabije izražen (ili ga čak i nema ponekad) tako da je ova opcija usmjerena prvenstveno na konverziju 8-
bitnih slika. 
   
(3) Desaturate Monitor Colors By može se koristiti da se kompenzira blještavilo (emisija svjetlosti) iz 
monitora. Pošto monitor emitira svjetlost (a papir reflektira) boje na monitoru često izgledaju saturiranije o 
kontrastnije nego u tisku. Ova opcija se u pravilu ostavlja isključenom, ali ako baš smatrate da je bolji prikaz 
sa uključenom, treba je uključiti i upisati postotak. 
   
Blend RGB Colors Using Gamma - OFF 
 

 



PHOTOSHOP - Tutorijali 

 14 

 
Stari papir 
 

 

1. Novi dokument Ctrl+N 150x200 pix sa belim 
Backgroundom. 
 
Ctrl+Shift+N novi layer i na njemu napravi 
pravougaonu selekciju i oboji je u crno. 
 
Ctrl+D deselect. 

 
 

2. FILTER - BRUSHED STROKES - SPRAYED 
STROKES i namesti setinge kao ja. 

 

3. U alatima izaberi Magic Wand i klikni bilo gdje 
unutar crnog kvadrata. 

 
 

4. Ctrl+Shift+I invertiraj selekciju i stisni Delete.  
 
Ctrl+D deselect. 

 
 

5. Ctrl+KLIK na layer i odaberi boju R:240, 
G:225, B:205 i pobojaj crni "podrapani" kvadrat. 
 
Ctrl+Shift+N novi layer. 

U Brushes prozoru odaberi soft Brush  i spusti 
opacity na 20% zatim smiksaj R:116, G:74, B:0 
boju i opcrtaj rubove. 
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....sada Ctrl+KLIK na layer na kojem je kvadrat da 
loadaš njegovu selekciju, zatim Crtl+Shift+I da ju 
invertiraš i stisni Delete. 
 
PAZI: layer na kojem si opcrtavao rubove mora biti 
plav u Layers prozoru tj. selektiran. 

 
 

6. Linkaj layere i idi Merge Linked. 
 
FILTER - EFFECTS - Outer Glow i namesti setinge 
kao ja. 

 
 

...FILTER - EFFECTS - Drop Shadow. 

 

7. Idi IMAGE - ADJUST - Brightness/Contrast i 
malo pojačaj oboje, dodaj text ili sliku ili oboje te 
odnesi na općinu i reci da ti je pradjed ostavio hrpu 
para te si došao po njih :) 
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Displace mapa 
 
S ovim poprilično cool efektom dobiva se to da se slikovni element prilagođava pozadini. Znači da prati 
teksturu podloge. Koje god vrste ona bila. No, može se upotrebiti i u druge svrhe, kao što je npr. 
deformacija određenih objekata. 
 
Prvo ćemo malo o teoriji. Znam da vam se neda, ali cool je znati zašto dešava to što se dešava.  
Za displace filter koji se nalazi u izborniku Filter-Distort mnogi misle da radi glupavi efekt distorzije slike na 
principu nekih valova. Kada ga primijenimo ne daje neke cool rezultate. Ali njegova snaga leži negde drugde. 
U kombinovanju dve slike. Originalne slike i displace mape koju koristimo za distorziju slike. Slika koju ćete 
upotrebiti za mapu će varirati o vrsti efekta koji želite postići. Postoje dvije vrste mapa, gradient (verlauf) 
mape i blur mape. 
 
Količina distorzije ovisi o vrednostima korištenima za displace mapu. Displace filter pomiće selekciju koristeći 
vrednost boje u displace mapi. 0 je maksimalni negativni pomak, a 255 je maksimalni pozitivni pomak. Siva 
vrednost od 128 rezultira time da se dio slike koji se nalazi na tom mestu ne iskrivljuje. Za mapu je moguće 
koristiti grayscale ili RGB mape. Svaki kolor mod rezultira drugačijim efektima. Jako je bitno napomenuti da 
se slika koju koristimo za mapu mora spremiti s .psd ekstenzijom ili vam ga u Photoshop formatu bez lejera.   
 
Grayscale mape 
Krenimo s grayscale mapama. Za primer ćemo uzeti najprostiju sliku crno belih pruga. Tek toliko da shvatite 
o čem se radi. Kao mapu ćemo uzeti grayscale gradient iz crne do 50% sive i natrag u crnu. Znači napravite 
jednu sliku istih dimenzija kao i original i na nju primijenite navedeni gradient. Spremimo ga kao psd koji 
ćemo posle pozvati na kraju menija Displace filtera. 
 
Kada koristimo grayscale sliku naša crno bela rešetka ce se deformirati po dijagonali onoliko koliki joj 
namestimo Horizontal i Vertical scale u meniju Displace filtera. Odaberite Stretch to fit da se mapa poveća ili 
Tile da se uzorak mape ponavlja. Kliknemo također i na Repeat Edge Pixels. Kiknimo na OK i izaberimo 
displace mapu. Odaberemo našu gradient sliku i kliknemo OK. Primjetit ćete da se naša slika deformirala 
tamo gdje je crna podloga mape a gdje je sivo ostala je ista. Kada bi koristili Beli gradient prema 50% crnoj i 
natrag u belo slika bi se deformirala nasuprot crnom primeru. Ovaj primer je dovoljan da shvatite kak to 
funkcionira. 

     
 
 
RGB mape 
Ako naša mapa ima više od jednog kanala, crveni se koristi za horizontalni displace a zeleni za vertikalni. 
Plavi kanal će biti ignoriran. Prednost ovoga je više kontrole nad distorzijom slike. Za slijedeći smo primer 
uzeli veći horizontalni scale od vertikalnog što znaći da će crveni kanal više uticati na sliku od zelenog. 
Kombinacije su naravno bezbrojne. 
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Slike kao mape 
Nakon što smo skužili kak to sve radi i želimo postići bolje rezultate od nekakvih psihodeličnih iskrivljenja 
krenimo na slike na koje želimo aplicirati našu mapu. Ovo je odlčno za postizanje efekta montaže kada neki 
objekt želimo stopiti sa slikom. Napravimo duplikat originala (Image-Duplicate). Prebacimo ga u grayscale i 
spremimo kao .psd. Lagano joj damo blur, tek toliko da omekšamo prelaza izedu crno belih tonova. Koliki 
blur, ovisi o slici. Ne preveliki, a ne ni mali. Bez blura bi prelazi bili nazubljeni. U našem slucaju imamo 
Komad svile koja sama po sebi ima mekane pregibe, ali mi ćemo ih omekšati jos malo. U našem slučaju 
radius od 10 pixela je bio dovoljan. Naravno slika je u grayscaleu. Sejvamo kao *.psd. Sliku koju želimo 
deformirati (u našem slučaju patak) prebacimo na sliku svile i namestimo na željeni položaj. Izeberemo 
Filter-Distort-Displace odaberemo opcije i pozovemo naš grayscale psd dokument. Dolazi do transformacije 
objekta ali djeluje neprirodno. Odaberemno Multiply pod blending mode. Koji puta se dobri rezultati dobiju i 
s nekim drugim blending modovima. Poigramo se s postavkama za boju (levels, H&S, replace color...) 
omekšamo malo rubove s Layer-Matting-Defringe, mada ja to više volim raditi s blur alatkom i to je to. 
Osim patka tu je još par primeraka. Kako dodati grafit na drvo ili kako napraviti efekt zastave na vjetru. Moji 
primeri su čisto jednostavni. Poigrajte se i rezultati će biti mnogo bolji. Ja sam malo lijen :) 
 

     
 

   
 

   
 
 
 
 
 
 
 
 
 



PHOTOSHOP - Tutorijali 

 18 

Oblaci 
 
Ok, "render clouds" zna biti dobar, ali nikad kada ga se koristi za ono za što je "deklariran nazivom" pošto je 
finalni produkt toga sve samo ne fini oblak. Stoga, brush u ruke, klik-o-metar na nulu i krenimo.  
Nije teško za "naslikati" a ovakvi oblaci mogu izgledati jako fensi. Pogotovo što mi je za ovo trebalo cca 5 
minuta. So, give it a try. Here we go!!!1 KLIK-KLIK-KLIK-KLIK... 
 
Zapamtite: "Lens flare" is not an option!  
Također, iz ovih thumbova se baš i ne kuži što se radi po koracima, stoga pročitajte "poglavlje" pa kliknite na 
sličicu da bi dobili neki uvid. Isto tako, tko se slijepo bude držao tutoriala i ne skuži da je ovo samo 
demonstracija tehnike je konj :). 

 
 

Image size: cca 1200x600 (size matters...) 
Za početak je oke postavit neku plavičastu pozadinu. Ovdje sam koristio 
#B5D0E3, ali "tačna" boja i nije jako bitna, to ćemo ionako posle srediti sa raznim 
adjustment layerima. 
 

 
 

Postavite brush size na 100px i opacity na 5%. Dodajte novi layer. Kružnim 
potezima i s brdo klikova nanesite osnovni oblik vašeg oblaka. 

 
 

Nakon kojih 400-500 klikova (ne broji!1 ovo je loša šala!) smanjite brush na 65px, 
dodajte novi layer i pojačajte highlighte oblaka (tamo gdje ima više bele, dodajte 
još malo bele, jel...). 

 
 

Dodajte novi layer i postavite ga iznad plave pozadine. 
Brush size naštimajte na nekih 200px, opacity smanjite na 5%, ubodite neku sivu 
boju (cca #666666) i popunite rupe izmedju belih površina. Time dodajemo 
početni kontrast. 

 
 

Opet bela boja, novi layer na vrh, 45px brush s opacitiyem od kojih 14% i opet 
naglasite svijetlije dijelove. 

 
 

Ubodite opet onu sivu boju, povećajte brush, smanjite opacity i u novom layeru 
iznad svega popunite donju desnu stranu oblaka tamnijom boju, da se još više 
istakne "3d" oblik, da ne bude flat. 
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Iznad pozadinskog layera napravite novi, ubodite neku tamniju boju i povucite 
ferlauf iz tamnijeg u transparentno od vrha prema dnu... negde do polovice 
canvasa otprilike. 

 
 

Povrh tog ferlaufa dodajte adjustment layer hue/saturation -> colorize u neku 
plavkastu boju. 

 

Na vrh svega dodajte combo adjustment layera hue/saturation + 
brightnes/contrast te upeglajte oblake da liče na nešto. 

 
Ako ste ikad gledali oblake, znate da se oni svakog trenutka mjenjaju, teško da će dva puta ponovit isti oblik. 
Također, sigurno ste videli razne face, likove itd. u njima. Pomognite vašim gledateljima da i oni vide iste, 
usmjerite ih u željenom smjeru ;). 
Oblaci na ovoj mojoj slici napravljeni su gore demonstriranom "tehnikom". 
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Stvorite vlastiti brush 
 
Ovaj basic-photoshop tutorial se bavi stvaranjem vlastitih ps brushova. Uz par malih trikova, on se vrlo 
jednostavno može napraviti. Zgodno je kad nemorate koristiti tuđe, nego znam, JA imam copyright.  
 
 
U ovom tutorijalu stvorit ćemo jednostavan ps brush. Koristim primer na nekakvom 'bezveznom' objektu, 
naravno, kad znate kako se radi, budite maštovitiji od ovoga, radite setove brusheva. 
 
 
 

 
 
 

Korak 1! 
Sa Ctrl+N kreirajte novi dokument, sa standardnim settingsima. Primera 
radi uzmite dokument veličine 150x130. 
Za kreiranje brusha potrebna je nekakva fotografija. Ne bilo kakva! :) Šalim 
se. Otiđite fino do imagebanka ili nekog drugog stock photo site, i nabavite 
neku zgodnu sliku. Možete i uzeti fotografiju koju sam ja koristio za ovaj 
primer. 
 

 
 
 

Korak 2! 
Ctrl + U koristimo za pretvaranje slike u crno belu. Nakon toga mijenjamo 
parametre pod image > adjustments > brightness and contrast. Ja obično 
stavim contrast do maximuma te se igram sa brightnessom ovisno o tome 
kakav brush želim. 

 
 
 

Korak 3! 
Sa lasso toolom (L) uzimamo selekciju na fotografiji, tj. definiramo budući 
izgled našeg brusha. 
Sa još uvijek postojećom selekcijom iz izbornika biramo edit > define brush, 
nakon čega se prikazuje ekran gdje možemo mijenjati ime brusha, te nam 
je prikazana slika njega sa leve strane. 
 

 
 
 
 
 
 
 
 

Nakon clicka na OK, naš brush je kreiran te se nalazi na zadnjem mestu u 
brush setu koji je bio nazadnje otvoren. 
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//Ukoliko želite imati set vlastit, kao vanjski file, tada, nakon što ste kreirali 
brush/eve pobrišite ostale koji su defaultno bili tamo. Zatim, pod brush 
window idite pod save brushes i odaberite ime. Kliknite na reset defaults, te 
potom samo loadajte vaš brush set. 
Defaultni direktorij za držanje istih je 
...\adobe\photoshop 7.0\presets\brushes 
 

 

Voila! 
Naš prvi brush je stvoren. Bilo je poprilično jednostavno, jelda?  
Sada, enjoy, i kreirajte malo zabavnije brusheve nego ja u ovom tutorialu. 
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Pattern Factory 
 
Ovaj tutorial se bavi stvaranjem vlastitih patterna (textura) uz pomoć Photoshopa (korišten je 7.0). 
Zapravo je cela stvar vrlo jednostavna. 
 
Napomena: Pokušat ću koristiti keyboard shortcute, tako da ih naučite maksimalno. Jako je zgodno ukoliko 
ih znate, kao i kombinacije kombinacije istih sa shift, alt i ctrlom. Korištenje Photoshopa postaje lakše i brže 
ukoliko nemate potrebu potezati s mišem za toolsima svako malo. 
 

 
 

Korak 1! 
Sa Ctrl+N kreirajte novi dokument, sa standardnim settingsima. Primera radi uzmite 
dokument veličine 100x100. 
Prvo što treba učiniti nakon toga je uzeti pencil tool (B) i selectati difoltni brush set i 
brush veličine 1px. 
Nakon toga pomaknuti zoom slider do kraja u desno, znači zoomati na 1600% 
 
 
 

 
 

Korak 2! 
Nacrtat ćemo osnovni, trivijalni pattern samo da bi se pokazala tehnika i trikovi. 
Pattern se mora crtati sa okolinom, znaći moramo paziti kako će se tileat dotični 
pattern. 
Sa brush toolom složite nekakv jednostavan pattern, nešto slično sam napravio na 
slici levo. Ovaj dio je teže objasniti. Kakav pattern napraviti, šta nacrtati? Nemam 
odgovora, napravite isti kao i ja, a kad znate trikove i tehniku, onda ćete biti 
kreativni i to :) 
 
Budući da je ovo vežba, nije potrebno da se radi o nekom kompleksnom patternu. 
Korištenje dviju ili više boja je preporučljivo (:) budući da onda pattern bolje izgleda. 
 
 

 

 
 

Korak 3! 
Pixele koje imamo moramo pretvoriti u pattern.  
Najvažniji dio je pozicija patterna te selekcija. Važno je razmišljati unaprijed o 
finalnom izgledu patterna, kada će pokrivati površinu od 1000x1000px 
Također, primer gdje piše 'krivo' je kriv budući da ciljamo na nekakav pravilni, 
simetrični pattern. Da želimo napraviti bilo kakav pattern tada bi i prva selekcija bila 
OK 
Pokazat ću primer gdje je jako važno kako će cela stvar izgledati, te ovisi o samoj 
selekciji prije kreiranja patterna. 

 

 
 
Na primeru je vidljivo da selekcija bez 'okoline' kreira pattern koji nije ništa sličan 
željenom rezultatu. Zato se treba brinuti o okolini :) 
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Korak 4! 
Kada smo nacrtali osnovu i pripazili na sve 'trikove', dalje je stvar trivijalna. 
Sa još postojećom selekcijom odemo na Edit > Define Pattern, i naš je patter 
kreiran. Bravo! 
Uzmemo Paint bucket tool (G), označimo u fill selekciji > pattern, i pod patterns 
nađemo zadnju kućicu koja bi trebala sadržati naš, upravo kreirani pattern. 
 

 

EDIT! 
 
Ukoliko želite istu stvar napraviti samo bez postojeće pozadine (kao na slici levo), 
ponovite celi proces samo što radite bez background layera. Kada definirate pattern 
photoshop će uzeti samo pixele od patterna, ne i od pozadine. Kad imate takav 
pattern možete ga šiknuti bilo gdje, i lakše se mijenja pozadina patterna. 
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Gel Text 
 
Ovaj tutorial ce vas naučiti kako da napravite tekst koji izleda kao da je od gela. Cool! 
 
1. Ukucajte bilo koji tekst, u boji po Vasoj želji. Font koji je u ovom tutorialu koriscen je DomCasual BT , ali i 
Comic Sans MS može da posluži. Kliknite Layer-> Rasterize-> Type, a onda drzite [CTRL] i kliknite na layer, 
da bite selektovali tekst. 
 

 
 
2. Sada, napravite layer iznad ovog sa tekstom. Onda kliknite Select-> Modify-> Contract i tamo ukucajte 
npr. 5 (zavisi od debljine fonta koji koristite). Izaberite svetliju nijansu boje koju ste koristili, pa pritisnite 
[ALT] i [Delete] da biste selekciju popunili bojom. Onda pritisnite [CTRL] i [D] da biste deselektovali 
selekciju. 
 

 
 
3. Onda, kliknite Filter-> Blur-> Gaussian Blur, pa otkucajte 2.0 (Takođe zavisi od debljine i veličine fonta). 
 

 
 
4. Kliknite Layer-> Layer Style-> Bevel and Emboss, pa podesite podešavanja ovako: 
 
Style: Inner Bevel  
Technique: Smooth  
Depth: 61%  
Direction: Up  
Size: 8  
Smooth: 0  
Use Global: štrikirano  
Altitude: 30  
Gloss Contour: Rolling Slope  
Highlight: Screen with 100%  
Shadow: Multiply with 100% 
 
5. Takodje štrikirajte Drop Shadow i Inner Shadow (na levoj strani Layer Style prozora), ali podešavanja za 
njih ne menjajte. Dobićete nešto nalik ovome. Isn't it COOL? 
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Golden Text 
 
Ovo je najlakši tutorial na svetu!  
Napiši nešto u žutoj boji. Zatim klikni Layer-> Layer-style-> Bevel and Emboss.  
Ništa ne diraj, samo promeni Gloss Contour, kao što je prikazano na slici. 
 

 
 
Sve u svemu, to bi trebalo da izgleda otprilike ovako: 
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Burnt - in text 
 
Ovaj tutorial će vam objasniti kako da napravite tekst koji izgleda kao da je urezan u podlogu.  
 
1. Nađite neku teksturu (npr. drvo). Onda izaberite alat Horizontal Type Mask Tool. Otkucajte neki tekst, pa 
kliknite Layer-> New Adjustment Layer-> Hue/Saturation. Kliknite OK. Stavite da Lightness bude -50. To 
izgleda ovako: 
 

 
 
 
 
2. Selektujte layer na kome je tekstura, pa kliknite Select-> Load Selection..., pod Channel selektujte 
Hue/Saturatin 1 Mask, pa OK. Pritisnite [CTRL] i [C] odjednom. Onda pritisnite [CTRL] i [V] odjednom i 
dobicete novi layer. Preimenujte ga u Text. Onda layere poređaj kao na slici, selektuj layer Hue/Saturation 1 
i pritisni [CTRL] i [E] istovremeno. 
 

 
 
 
 
3. Kliknite Select-> Load Selection..., pod Channel selektujte Text Transparency, pa OK. Kliknite Layer-> 
New Adjustment Layer-> Hue/Saturation, pa OK. Stavite da Lightness bude +75, pa kliknite OK. Layere 
poređajte kao na slici: 
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Izaberite Move Tool, selektujte layer Hue/Saturation 1 pa pritsnite na tastaturi jedanput strelicu desno i 
jedanput strelicu dole. To bi trebalo da izgleda ovako: 
 

 
 
 
To je to! Probajte malo da eksperimentišete, ako hoćete, mada ja mislim da je ovako najbolje. 
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Alien Text 
 

 

1. Podesite da Vam je Background Color crna boja, a Foreground Color zelena (kao na 
slici) 
 
 
 
2. Kliknite Edit -> Fill -> Background Color, pa izaberite alat Horizontal Type Mask Tool, pa 
napišite neki tekst. Izaberite Edit-> Fill-> Forground Color. Onda kliknite Select-> Feather i 
ukucajte 2. 

 
3. Onda kliknite Filter-> Blur-> Radial Blur, pa podeite sve kao na slici: 
 

 
 
4. Onda pritisnite istoveremeno [CTRL] i [F], pa [CTRL], [SHIFT] i [I], pa opet [CTRL] i [F]. Toje kraj. Slika 
bi trebala da izgleda otprilike ovako : 
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Kako da fotografiju pretvorite u crtež 
 

 
 

Ovaj tutor je jednostavan a rezultati su fantastični. Odaberite 
fotografiju koju želite da »nacrtate« i otvorite je u Fotošopu. 
Idete na File-Open i pronađete fotografiju koju imate na 
svom hard disku ili drugom mediju (CD, flopi, kamera itd.). Ja 
sam odabrao jednu fotografiju iz toplijih krajeva i nazvao sam 
je jednostavno »Palma« . 

 
 

OK, sad kad smo otvorili fotografiju da bi smo dobili crno beli 
crtež (jer to nam je namjera, zar ne) moramo skinuti ovu 
boju sa fotografije. To ćemo uraditi na vrlo jednostavan 
način. Idemo na liniju menija i pronađemo Image-
Adjustments-Desaturate . Na slici dole je prikazana ta 
jednostavna operacija.  
Sada smo od kolor fotografije napravili »crno belu« kako mi 
to zovemo iako to baš nije tačno. Crno bele fotografije se 
inače stručno zovu »Grayscale mod« . Jedina namjera što vas 
davim oko ovoga je da ako nastavite da se bavite sa 
fotošopom moraćete da znate razliku između Greyscale i 
Black& White fotografije, ali da vas ne gnjavim dalje, da 
nastavimo. 

 

Sledeće što je potrebno uraditi je da napravimo duplikat ove 
fotografije i postavimo ga preko ove. To bi u stvarnom životu 
izgledalo kao da dvije istovetne fotografije stavimo jednu 
preko druge. Normalno da u stvarnom životu to ne daje 
nikakve rezultate ali u fotošopu daje itekakve.Tako 
postavljene fotografije u fotošopu zovu se slojevi ( Layers ) i 
fotošop ima mogućnosti da pomeša boje donje i gornje 
fotografije (sloja) i pokaže sasvim neočekivan rezultat ili 
možda očekivan kao u ovom slučaju. Kako god bilo idemo da 
napravimo još jednu fotografiju (sloj).U donjem desnom uglu 
potražite paletu Layers (siguran sam da je tu). Na toj paleti 
su prikazani svi slojevi ( fotografije) koje ste poslagali jedne 
preko drugih. Kliknite desnim dugmetom miša sloj (jedini za 
sada koji imate) i u konteksnom meniju odaberite opciju 
Duplicate Layer . Na slici dole možete da vidite tu operaciju. 
 

 

Kada se otvori ovaj prozorčić samo kiknite OK i to je sve. 
Sada se na paleti pojavio novi sloj iznad sloja »Background« 
pod imenom » Background copy « osim ako mu vi niste dali 
drugačije ime u ovom prozorčiću. 
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Ovaj sloj Backgruond Copy trebamo da pretvorimo u 
fotonegativ.Kliknite na njega ako kojim slučajem nije izabran 
(aktivan sloj je obojen u plavo) i upotrijebite komandu 
Image-Adjustments-Invert (prikazano na slici levo) 

 
 

Sad kad smo dotjerali ovaj novi sloj na njemu ćemo i dalje da 
radimo. Sad se vraćamo na priču o slojevima i mešanju boja 
(možda vam se ta priča učinila suviše dosadna ali imala je 
svoju svrhu). Da bi se pomešale boje dve fotografije moramo 
da upotrijebimo jedan od Modova stapanja . Modovi stapanja 
se nalaze na paleti Layers i na donjoj slici vidite gdje možete 
da ih nađete. Crvena strelica vam pokazuje gdje da pritisnite i 
u padajućem meniju ( u ovom slučaju je rastući meni) 
izaberite Color Dodge . 

 

Posle ove operacije nešto se desilo sa vašom fotografijom. 
Potpuno je pobelila ili je ostala samo neka mrlja na beloj 
pozadini.  
Nema problema niste pogrešili sve je kako treba. Tu belu 
površinu ćemo za tren oka pretvoriti u crtež pomoću filtera 
Gaussian Blur .  
 
Još jedna od komandi koju ću pokušati da objasnim 
jednostavnim rečnikom. Filteri su naročite komande koje vaše 
pixele obrađuju na osnovu matematičkih formula koje je unio 
proizvođač ovoga softvera i nemojte me mnogo pitati oko 
toga jer nemam pojma kako to tačno funkcioniše. Kako god 
funkcionisalo rezultati su spektakularni. I da završim sa 
teorijom. Najbolje je da sami isprobate razne filtere i vidite 
šta dobijete kada vašu fotografiju »propustite« kroz neki od 
njih a mi idemo dalje da nešto napravimo od ovoga što smo 
»pokvarili«.  
 
Filter Gaussian Blur ćemo naći tako da pritisnete na liniji 
menija Filter-Blur –Gaussian Blur (jel' da sam pametan) i to 
možete videti na slici dole. 
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Kliknite Gaussian blur i pojaviće vam se mali prozorčić kao na 
slici dole u kome trebate da izvršite podešavanja. Podesite 
vrednost kao na slici ili sami eksperimentišite dok ne dobijete 
najbolji rezultat , sve zavisi od slike. Uglavnom neka vam se 
vrednost kreće između 1 i 10 pixela .  
 
Nekim čudom crtež vaše fotografije se pojavio i potrebno je 
još napraviti par sitnica da bismo priveli kraju ovaj tutor. 

 
 

Potrebno je još slepiti ove slojeve i to ćete uraditi naravno uz 
pomoć komande na paleti Layers. Pogledajte donju sliku 
pritisnite strelicu na paleti i u meniju odaberite Merge Visible . 

 
 

Nakon ove operacije na paleti Layers vidite samo jedan sloj 
što znači da smo i ovo uspješno završili. Moja fotografija sada 
izgleda ovako (slika levoe). Nadam se da ste i vi zadovoljni 
kao i ja. 

 

Ja sam još uradio par detalja koji nisu obavezni ali da vam ih 
pokažem. Uzeo sam gumicu iz kutije sa alatima i pobrisao 
rubove fotografija i dodao natpis , čini mi se da je sada 
lepše(pogledajte sliku dole). Pokušajte ništa vas ne košta. 
Ostaje još da snimite vaš rad. Idete na File-Save As i u 
prozoru izaberite mesto gdje ćete ga snimiti, dajte mu neko 
ime i odaberite format u kom ćete ga snimiti. Preporučujem 
JPEG ili TIFF (Kodakov format) ali to je sve stvar izbora i 
potrebe šta želite da uradite sa vašim malim umetničkim 
djelom. 
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Retuširanje - kako da se podmladite bez plastičnih operacija 
 

 
 

Verovatno ste se upitali kako ove pjevačice 
izgledaju super na slikama sa savršenim tenom i 
bez bora a imaju sto godina. Prvo na šta ste 
pomislili je da su bile na plastičnim operacijama 
i skupim kozmetičkim tretmanima što je sasvim 
sigurno istina ali istu stvar možemo napraviti i u 
fotošopu, doduše samo na fotografijama. Ovo je 
naročito pogodno za nas koji nemamo para za 
takve operacije a želeli bi da izgledamo mladi 
(kao nekad).  
 
Ideju za ovaj tutor sam dobio prelistavajući 
knjigu »Photoshop 7 Biblija« autora Deke 
McClelland-a gdje je prikazao ovu vežbu. Za one 
koji još nemaju tu knjigu neka pokušaju sa 
mojom verzijom.  
 
E sada, obično je pošteno da se krene od sebe 
pa sam za ovu malu vežbu iskoristio jednu moju 
fotografiju koja me baca u očaj . Na slici dole 
možete videti moju malenkost u pravom svetlu i 
pomoću tehnika fotošopa pokušaćemo da 
popravimo stvar. 
 

 
 

Možda vam se na prvi pogled i ne čini tako 
strašno(a možda i čini) ali kada se malo bolje 
zagledate videćete kesice ispod očiju koje su 
rezultat predugog sjedenja za kompjuterom u 
duvanskom dimu, loš ten i ožiljci od davno 
preležanog puberteta u vidu kratera na licu 
(pogledaj sliku dole). 
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Da bi popravio stvar uzeo sam alatku Healing 
Brush specijalno napravljenu za popravku 
ovakvih i sličnih stvari. Pritisnite tipku J na 
tastaturi da je odaberete ili kliknite na paleti sa 
alatima. Ona deli mesto sa još dve alatke u 
paleti pa je pronađite. Uglavnom možete je 
videti na slici dole pored broja 1. 

 
 

Pomoću slike gore idemo po koracima da rešimo 
ovu sasvim delikatnu situaciju.  
 
   
Korak 1. Uzmite alatku Healing Brush ako to već 
niste uradili  
 
Korak 2. Na liniji svojstava (Options) proverite 
svojstvo Aligned (mora biti isključeno) i podesite 
veličinu četkice prema potrebi (kod mene je 
veličina 18 i Hardnes-tvrdoća 100%)  
 
Korak 3. Pritisnite tipku Alt na tastaturi i držite 
pa potom kliknite sa alatkom(kursor se pretvara 
u nišan kao na slici) na dio kože koji vam se čini 
najčistiji. Sada ste uzeli uzorak kože kojim ćete 
ispraviti nepravilnosti na licu. Naoružajte se 
strpljenjem i bacite se na glađenje bora i 
ožiljaka. Nanesite uzorak na sve delove 
oštećene kože klik po klik 
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Na slici gore vidite kako stvar napreduje kod mene. Nemojte povlačiti sa ovom alatkom po licu jer to 
uglavnom daje loš rezultat. Ispravljajte nepravilnosti klik po klik i po meni to daje najbolji rezultat. Na ovome 
dijelu sa bradom starom dva dana sam popravio nepravilnosti tako što sam uzeo čist uzorak kože sa bradom 
a i nanio ga na oštećeni dio.  
Uglavnom posle malo strpljivog rada možete dobiti super rezultate (ali šta je to u poređenju sa večnom 
mladosti) . Pogledajte sliku dole pre i posle ovoga kozmetičkog tretmana u fotošopu (čak mi i glava izgleda 
malo manja). 
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Kako eliminisati crvenilo u očima 
 

 
 

Problem crvenih očiju na fotografijama u fotošopu 
možete rešiti sa nekim od alata za korekciju boja kao 
što su Color Balance, Hue-Saturation, Replace Color 
ili Chanel mixer i svi se nalaze u meniju Image . 
Kako, vrlo lako i za nekoliko minuta.  
 
Istini za volju postoji još nekoliko komandi pomoću 
kojih se mogu postići isti rezultati ali za 
objašnjavanje svake posebno bi nas odvelo daleko i 
mislim da bi ovaj tutorijal bio previše dosadan i 
obiman. Zbog toga pokušajmo sa jednom od njih a 
zove se Replace Color .  
 
Za ovu vežbu sam uzeo fotografiju Claire Forlani i o 
njoj neznam ama baš ništa osim da ima prelepe oči. 
Na početku pogledajte originalnu fotografiju na slici 
dole. 

 
 

Za potrebe ove vežbe sam inače sasvim dobru 
fotografiju malo unakazio i pocrvenio joj oči i to sada 
izgleda prilični loše. 

 
 

Možda nije baš kao što se napravi sa fotoaparatom 
ali poslužiće. Da bismo eliminisali crvenu boju 
potrebno je da izaberemo područje na kom se nalazi 
crvenilo, u ovom slučaju na zenici i šarenici oka. 
Uzmite neku od alatki za izbor i izaberite to područje. 
Ja sam to uradio sa alatkom Elliptical Marquee tool 
(pošto je oko naravno ovalno ili okruglo). Ovu alatku 
možete videti na slici levo. 
 

 
 

Kada ste izabrali ovu alatku krenite na posao. 
Pritisnite sa njom u gornji levi ugao oka i povucite 
dijagonalno da selekcijom obuhvatite čitavo oko pa 
čak i malo beonjače (pogledaj sliku levo). Prilikom 
povlačenja držite taster Shift da bi selekcija imala 
oblik savršenog kruga 
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Smisao »stavljanja« oka u selekciju je sledeći. Na 
ovaj način kažemo programu na kom području 
fotografije želimo da izvršimo korekciju boja. U 
suprotnom da nismo ništa odabrali (selektovali) 
program bi pomislio da želite da izvršite korekciju 
boja na čitavoj slici .  
 
Bilo kako bilo nakon stavljanja oka u selekciju idite 
na Image-Adjustments-Replace Color i otvoriće vam 
se prozor kao na slici dole. Dalje idemo u koracima 
prateći  sliku. 
 
Korak 1. Kliknite ikonicu pipete u ovom prozoru i sa 
pipetom uzorkujte (kliknite) crvenu boju na oku .  
 
Korak 2. Kliknite ikonicu pipete koja ima znak plus i 
sa njom uzorkujte sve ostale boje koje se nalaze na 
oku (npr.crnu). Na ovaj način ćete obuhvatiti sve 
boje sa oka koje želite da promijenite  
 
Korak 3. Pomićući klizače za opcije Hue, Saturation i 
Lightnes pronađite željenu boju. 

 
 
 
 

Najepše u svemu ovome je da možete da vratite 
prirodnu boju očiju osobe na fotografiji, svakako ako 
je znate. Postupak ponovite i na drugom oku s tim 
što ne bi bilo loše da prije svega zapišete ili 
zapamtite vrednosti Hue, Saturation i Lightnes koje 
ste koristili na prvom oku i potom ih primenite na 
drugo oko da vam se ne bi desilo da vam dva oka u 
jednoj glavi budu različite boje (ovo mi je nešto 
poznato). 

 
 
 

Na slici levo možete videti moj rezultat i mislim da je 
to tu negdje. Vjerovatno uz malo truda to možete 
napraviti bolje od mene.  
 
Ništa vas ne sprečava da se malo igrate i 
eksperimentišete sa bojom očiju na fotografijama.  
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Nešto mi se ova vežba brzo završila pa bih iskoristio 
priliku da vam pokažem još jednu komandu za 
korekciju boja koja se zove Hue-Saturation i ona se 
takođe nalazi u istom meniju kao i Replace Color.  
Otvorite neku fotografiju-portret za izrabljivanje sa 
vašeg diska a ja ću upotrebiti istu sliku. Ponovite prvi 
dio tutora i izaberite oko sa Elliptical Marquee Tool 
kao u prethodnoj vežbi. Nakon ovoga idite na 
Image-Adjustments-Hue/Saturation i otvoriće vam se 
prozor kao na slici. 

 
 

 

Pomoću klizača kao u prethodnoj vežbi podesite 
željenu boju. Prilikom podešavanja izmene će se 
direktno videti na slici (opcija Preview mora biti 
potvrđena kao na gornjoj slici).  
 
Na sledeća dva primera možete videti eksperimente 
sa različitom bojom očiju. Na svakoj slici su upisane 
vrednosti HUE, SATURATION i LIGHTNES početnim 
slovima ovih opcija u okviru komande 
Hue/Saturation.  
 
Nemojte se držati mojih brojeva već sami pomičite 
klizače i tražite najoptimalnije ili najzabavnije 
rešenje. 
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Slikanje u photoshop-u 
 

 
 

Uz malu pomoć filtera, u fotošopu možete simulirati 
slikanje i od fotografije napraviti pravo malo 
umetničko delo i sve to za deset minuta. Zvuči 
primamljiv zar ne ? Da krenemo od početka. Otvorite 
neku fotografiju sa vašeg diska i bacite se na posao. 
Ja sam otvorio fotografiju koju možete videti 

 
 

Sama po sebi, fotografija je odlična i teško se tu šta 
može dodati ili oduzeti ali hajde da pokušamo i usput 
nešto naučimo. Na paleti Layers pritisnite 
Background i prevucite ga na ikonicu koju označava 
strelica na slici dole da napravite još jedan sloj. 

 
 

Sada kada ste napravili još jedan sloj promijenite 
imena slojeva. Kliknite dva puta Background i u 
prozoru koji će vam se otvoriti upišite » boja «. 
Kliknite dva puta sloj Background copy i promijenite 
mu ime u » olovka «. Sada bi vaša paleta Layers 
trebala izgledati kao na slici dole. 
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Pošto smo završili sve pripreme preostaje da se 
bacimo na ozbiljan posao.  
Aktivirajte sloj » olovka « ako nije aktivan i idite na 
Filter-Stylize-Find Edges .  
Idite na Edit-Fade Find Edges i kada vam se otvori 
prozor kao na slici dole podesite vrednost kao na 
slici. 

 
 
 
 

Nakon ovoga idite na Image-Adjustments-Desaturate 
da oduzmete boju sa ovoga sloja  
 
Idite na Image-Adjustments-Brightness/Contrast i 
kada vam se otvori prozor kao na slici dole podesite 
vrednosti kao na slici. 

 
 
 
 

Na kraju smo posla na ovome sloju i preostaje još 
samo da promijenite model stapanja ova dva sloja 
na paleti Layers . Ja sam koristio model Soft Light ali 
to je različito od slučaja do slučaja. Pogledajte na 
slici dole moju paletu Layers . 

 
 

Završili smo posao na ovome sloju u uradili većinu 
posla. Preostaje da dotjeramo sloj » boja « i to je to.  
 
Aktivirajte sloj » boja « klikom na njega i nastavite u 
koracima.  
 
   
Idite na Filter-Noise-Median i kada vam se otvori 
prozor kao na slici podesite vrednost kao na njoj. 
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Idite na Image-Adjustments-Hue/Saturation i kada 
vam se otvori prozor kao na slici dole podesite 
vrednost kao na njoj. 

 

To bi sada bilo gotovo i nadam se da ste zadovoljni 
rezultatom. Na slici dole možete pogledati moju sliku 
i nadam se da će i vaša biti kao i moja. 
 
Neko će reći da smo pokvarili odličnu fotografiju i 
možda je to i istina ali bar smo nešto i naučili. 
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Crno-belo u kolor 
 

 

Nekada davno kada nisu postojale fotografije u boji majstori 
svog zanata su manje više uspješno to radili ručno (kako ko). 
Danas se to može uraditi u fotošopu pa ako imate neku crno 
belu fotografiju koju želite da obojite ovo je način kako da to 
uradite . Zato u ovome tekstu pokušajmo da oživimo 
sjećanje na taj stari zanat. Na žalost kao što je i nekada to 
bio mukotrpan posao tako je i danas, naročito ako na 
fotografiji imate mnogo detalja. Najviše posla imate dok 
izaberete područje na fotografiji pomoću nekog od alata za 
selekciju a samo bojenje je brzo što ćete videti u nastavku. 
Zbog dužine tutorijala ja sam izabrao jednu sa relativno malo 
detalja i pomoću nje ću pokušati da vam objasnim način na 
koji se to radi.  
 
Savjet: pronađite neku sliku sa malo detalja kao što je i ova 
moja bar za početak , a kada savladate tehniku možete da 
radite i mnogo komplikovanije fotografije. Za ovu vežbu ja 
sam našao jednu kolor fotografiju koju sam »preveo« u sive 
tonove pomoću komande Image-Mode-Grayscale i dobio sam 
crno belu fotografiju spremnu za obradu. Bacimo se na 
posao. 
 

 
 

Priprema fotografije : Pojačajte kontrast na ovoj fotografiji 
pomoću komande Levels i možete je naći Image-
Adjustments-Levels . Istu stvar možete uraditi pomoću 
komande Image-Adjustments-Brightnes/Contrast . 

 

Korak 1. Pomoću klizača kao na slici gore pojačajte kontrast 
na slici povlačeći vanjske klizače kao što pokazuju strelice na 
slici prema unutra. Uglavnom trebate ih podesiti da se nalaze 
na početku i kraju dijagrama koji je prikazan.  
 
Na slici levo možete videti rezultat prethodnog koraka. Pazite 
da ne preterate. 
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Korak 2. Pošto je vaša slika u Gray scale modu (crno-belo) i 
ima samo jedan kanal da biste počeli sa bojenjem morate 
promijeniti mod u CMYK i dobiti tri kanala da bi bojenje 
uopšte bilo moguće i to možete uraditi pomoću komande 
Image-Mode-CMYK  
 
Zašto je ovo važno ? Sve boje koje možete zamisliti mogu se 
dobiti mešanjem tri boje  
Cyan-nijansa plave  
Magenta-nijansa crvene  
Yelow-nijansa žute  
 
Upravo ova skraćenica vam govori da ćete mešanjem ove tri 
boje i crne koja reguliše svjetlost obojiti vašu fotografiju.  
 
Korak 3. Pritisnite taster D da izaberete default boje za 
foreground i background boje (crna i bela) i one će nam 
služiti za nanošenje maske što je jedan od načina za biranje 
(selekciju) pojedinih dijelova fotografije.  
 
Prva stvar koju ćemo obojiti na ovoj slici je koža i moramo 
prvo da je izaberemo i potom obojimo . Ovaj put 
upotrebićemo komandu Quick Mask i možete je naći u kutiji 
sa alatima odmah ispod ikonica za fore-background boje.  
 

Korak 4. U kutiji sa alatima pronađite ovu ikonicu  i 
kliknite na nju da nabacite masku preko fotografije. Ništa se 
nije dogodilo ali nastavimo dalje 
 

Korak 5 . Uzmite Brush tool  i podesite vrednost 
Hardness na 100% na liniji osobina (tvrde ivice) i krenite sa 
bojenjem svega osim kože. Kako budete bojili četkica će 
ostavljati crveni trag iza sebe ali to je samo maska.  
 
Bacite se na maskiranje svih dijelova slike koje hoćete da 
zaštitite (izolirate) od buduće obrade. U slučaju greške da ste 
obojili dio kože upotrebite belu boju za brisanje maske.  
 
Kada dovršite vaša slika bi sada trebala izgledati kao ova 
levo. 
 
Šta ste uradili ? Površina slike koja je crvena je zamaskirana i 
zaštićena od obrade a u sledećem koraku videćete magiju 
ove alatke.  
 
Korak 6. Pritisnite taster Q ili ikonicu Edit in Standard Mode u 
kutiji sa alatima da izađete iz režima Quick Mask i oko 
površine koju nije prekrila maska se pojavila selekcija super 
zar ne). Na ovaj način smo odabrali kožu ove djevojke i to 
nam je bila prvobitna namjera. Istu stvar ste mogli uraditi sa 
nekom verzijom alatke Lasso ali mislim da je ovako lakše.  
 
   
Sada kad ste shvatili kako radi maska naučili ste najvažniji 
dio ovoga tutorijala pa možemo mirne duše da nastavimo 
dalje.  
 
Ok sad kad je koža u selekciji možemo da krenemo sa 
bojenjem. Ovo je mnogo lakši deo. 
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Korak 7. Napravite novi sloj Layer-New Adjustment Layer-
Curves i kada vam se otvori prozor kao na slici dole upišite 
ime sloja (koža) i obavezno potvrdite opciju ( Use Previous 
Layer........) a ostalo ne dirajte. 
 
Ako bacite pogled na paletu Layers videćete novi sloj. 
Istovremeno vam se otvara okvir za dijalog Curves i u njemu 
ćete da obojite selektovani dio (kožu). 
 
 

Korak 8. Okvir za dijalog Curves možete videti na slici dole s tim što sam ja prikazao dijagrame za sve tri 
boje koje ćete upotrebiti (umešati) da dobijete boju kože. U padajućoj listi (zaokruženo na slici) prvo 
odaberite boju Cyan i podesite krivu kao na slici (pritisnite mišem na krivu i povucite je približno na položaj 
kao na slici dole). Ponovite postupak i za Magentu i Yellow kao na slici dole a Black ne dirajte 
 

 
 
Povlačenje krive u dijagramu automatski daje rezultate na fotografiji pa ujedno pratite šta se dešava na slici 
dok ovo radite i dotjerujte boju do željenog rezultata. Vodite računa da konačna boja zavisi od mešanja sve 
tri boje .  
 
U ovom slučaju pomešali ste blago svetloplavu sa blago tamnijom crvenom i žutom. Bilo kako bilo kada ste 
završili sa ovim podešavanjem upravo ste uspješno obojili selektovani dio (kožu). 
 
Ponovite korake 4 i 5 pa nabacite masku preko djevojke da je izolirate od buduće obrade i ostavite slobodnu 
pozadinu fotografije. 
 

 
 

Ponovite korake 6 i 7 i bacite pogled na paletu Layers , 
trebala bi izgledati kao ova moja dole 

 

Korak 9. Kad vam se otvorio okvir za dijalog Curves podesite 
boju pozadine po vašoj želji mešajući ove tri boje kao iz 
koraka 8 (ne iste vrednosti mešanja). Slobodno povlačite 
krive u dijagramu i pronađite za vas optimalno rešenje. Na 
slici možete videti moj rezultat. 



PHOTOSHOP - Tutorijali 

 44 

 
Panoramska fotografija 
 
Ovo će se svideti našim članovima koji se bave fotografijom i njima je sve već jasno iz naslova tutorijala. 
Vjerovatno ste do sada videli panoramske fotografije na izložbama ili na internetu a ako niste potražite ih da 
pogledate kako to izgleda. Uglavnom zajednička im je stvar da su snimljene skupim kamerama veoma 
širokog objektiva. Drugim riječima takve kamere imaju mnogo šire »vidno« polje od običnih i mogu da 
zahvate-snime mnogo više prostora od običnih. Malo sam se zapetljao ali to je to siguran sam da shvatate. 
Ovde bi se trebao uključiti neko od naših članova ko bolje poznaje ovu tematiku. Sličnu stvar možemo postići 
sa običnim fotoaparatom i naravno uz malu pomoć našeg prijatelja Mr. Fotošopa. Bilo kako bilo, pogledajte 
ove četiri fotografije dole. Sve su snimljene sa iste pozicije i kamera je pomicana sa leva na desno dok su 
urađena ova četiri snimka. Prilikom snimanja treba paziti da se granični detalji preklapaju kao što možete 
videti po ovim stubićima ili prozorima ove zgrade. Na ovaj način ćemo pomoći Mr.Fotošopu da prepozna i 
savršeno izvrši skalpanje ove četiri fotografije u jednu. 
 

 
 

 
 
Jednom kada napravite snimke snimite ih na vaš disk. Savjet: napravite posebnu mapu za njih kao i ja a 
fotografijama dajte smislena imena. Ja sam im dao redne brojeve, sleva na desno. Nastavak ovoga tutorijala 
idemo u koracima. 
 

 
 
 

1. Idite na File-Automate-Photomerge i otvoriće vam 
se prozorčić kao na slici levo. U padajućoj listi 
odaberite Folder (ako ste fotografije snimili u 
posebnu mapu) ili File (ako to niste uradili). Nakon 
ovoga kliknite dugme Browse da pronađete vaše 
fotografije. 
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2. Otvara vam se prozorčić kao na slici levo gdje 
trebate da pronađete mapu sa fotografijama. Na slici 
levo možete malo da zaviriti u sadržaj mog 
kompjutera (šalim se). Kada ste ih jednom pronašli 
kliknite OK . 

 

3. Ponovo se vraćate u prozor Photomerge iz prvog 
koraka ali ovaj put možete videti da su se prikazali 
nazivi svih fotograqfija u toj mapi. Ako želite neku da 
izbacite kliknite na nju i potom na dugme Remove . 
Bilo kako bilo kada završite kliknite OK i to je to 

 
 
 
Nakon ovoga otvara vam se radni prozor Photomerge kao na slici dole u kom će program da izvrši sklapanje 
ovih fotografija. U nekim slučajevima kada su fotografije odlično snimljene on će to uraditi automatski, ako 
ne moraćete da mu pomognete. Kao što vidite ovaj prozor ima svoje alatke sa kojima ćete se služiti dok ovo 
radite. Najvažnija je Select Image tool i sa njom prevlačite fotografije iz kontejnera i namještate ih na 
željeno mesto. Tu je još Zoom tool da uvećate ili smanjite(Alt + ) prikaz fotografije, zatim tu je još Hand tool 
sa kojom pomičete platno u prozoru.  
 
Uzmite Select Image tool i prevucite fotografiju iz kontejnera ( na vrhu ) na radno polje i namestite je da 
pravilno izvršite preklapanje. Program vam pomaže što sam vrši fino podešavanje. Koristite Zoom tool da 
uvećate prikaz fotografija a Hand tool da pomičete platno u prozoru. Jednom kada ste zadovoljni kliknite OK 
i to je to. Fotošop će slijepiti ove četiri fotografije i od njih napraviti jednu. Radni prozor Photomerge se 
zatvara i vraćate se ponovo u osnovni prozor fotošopa. 
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Kao što možete videti na slici dole ne vide se nikakvi šavovi i fotografija izgleda kao da je snimljena sa 
nekom jako skupom kamerom. Ako je potrebno uzmite Crop tool  da obrežete nejednake ivice fotografije 
i to bi bilo sve. Vaša panoramska fotografija je gotova i ne postoji način da neko provali da je snimljena 
običnim fotoaparatom. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



PHOTOSHOP - Tutorijali 

 47 

 
Fade 
 
 

 
 
 
 

Pomoću ovoga tutorijala možete vaše 
fotografije učiniti drugačijim i 
interesantnijim a usput naučiti koristiti 
komandu Fade . Ona u osnovi služi za 
promenu djelovanja filtera koji ste 
upotrebili. Znači, da bi vam bila dostupna 
u meniju Edit prethodno ste morali 
upotrebiti neki od filtera na fotografiju. 
Takođe ona vam je dostupna odmah i 
samo nakon primene filtera. Da vam ne 
dosađujem dalje pogledajte u sledećoj 
vežbi kako ona radi.  
 
Otvorite neku fotografiju u Photoshop-u 
File-Open a moju možete videti levo. Ja 
sam je skinuo sa sajta Digital Vision-a. 
 

 
 
 
 

Idite na Filter-Blur-Gaussian Blur i 
podesite vrednosti kao na slici  ( Radius 7 
px ). 

 
 
 

Idite na Edit –Fade Gaussian Blur i 
promijenite model stapanja na Screen 
kao na slici (to je ona priča na početku). 
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Ponovite korak 1 . i upotrebite istu 
vrednost za filter Gaussian Blur (kratica- 
Ctrl +F ).  
 
Opet iskoristite komandu Fade Edit –Fade 
Gaussian Blur i promenite model stapanja 
na Soft Light kao na slici. 

 
 
 
 

Primenite još komandu Image-
Adjustments-Auto Levels da popravite 
ravnotežu boja na fotografiji.  
Na kraju ekstra tip, napravite okvir oko 
fotografije Image-Canvas Size i u okviru 
za dijalog kao na slici levo podesite 
vrednosti (obavezno potvrđena opcija 
Relative ). 

 

Gotovi smo i pogledajte rezultat koji sam 
ja dobio. 
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Fade 2 
 
Ovo je stvarno jednostavan i kratak tutorijal. U njemu ćete naučiti koristiti komandu Fade sa kojom možete 
promijeniti djelovanje filtera na vašoj fotografiju. Komandu Fade možete koristiti tek i samo nakon primjene 
filtera na vašoj fotografiji. Na kraju ove vježbe vaša fotografija će izgledati kao slika sa porcelana. 
 

 
 

1. Otvorite neku fotografiju File –Open i pronađite 
nešto na vašem disku. Moju fotografiju možete 
vidjeti levo.  

 

 
 

2. Primjenite filter Find edges  

Filter-Stylize-Find edges i dobićete rezultat kao 
na slici lijevo. Ovo je zbilja odvratno ali popravićemo 
stvar ubrzo.  

 

 
 

3. Idite na Edit-Fade Find edges (to je ona priča 
na početku) 

 
 

4. Otvorio vam se prozorčić kao na slici lijevo.  

Promijenite opciju Mode na Luminosity i slici će se 
vratiti boja.  

Klizač za opciju Opacity povucite ulijevo kao na 
slici do rezultata koji vas zadovoljava.  

 

 

5. Vaša fotografija bi trebala izgledati kao i ova moja 
lijevo. 
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Tekstura 
 
Dodavanje detalja na sliku je svakako od ključne važnosti i ovo je jedan od načina kako da obogatite vaše 
umjetničko djelo. Za početak obradite vašu fotografiju kako god želite i primenite filtere koje god želite i 
kada ste gotovi nabacite teksturu preko vašeg djela kao što je opisano u tutorijalu. Nadam se da će te biti 
zadovoljni krajnjim rezultatom. 
 

 
 
 

1. Idite na File-Open i pronađite neku fotografiju na 
vašem disku. Moju fotografiju možete videti levo. 

 
 
 

2. Ja sam upotrebio jedan od „umjetničkih“ filtera, 
Filter-Artistic- Dry brush (ovo je opcija a vi možete 
primeniti bilo koji od filtera koji želite).  
 
Bilo kako bilo na slici levo možete videti podešavanja 
za filter Dry Brush . Fotografija bi trebalo da izgleda 
kao slikarski rad. Ujedno to je sve što ćemo uraditi 
na ovome sloju. Fotografija je spremna za teksturu. 

 

3. Napravite duplikat Backgrounda prevlačenjem na 
ikonicu New Layer (strelica) i promijenite mu model 
stapanja na Overlay (zaokruženo).  
 
Ovaj novi sloj će nam poslužiti da napravimo 
teksturu . 
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4. Na novom sloju primenite Filter-Artistic-Palette 
knife i podesite vrednost kao na slici levo ili 
eksperimentišite.Veća vrednost Stroke Size daće vam 
krupniju teksturu a manja obratno. 

 
 
 
 

5. Nastavite rad na istom sloju i upotrebite Filter-
Stylize-Glowing Edges i upišite vrednosti kao na slici 
levo. Ovaj filter će definisati linije vaše teksture. 

 
 
 
 
 
 
 
 
 

6. Još jedan filter na istom sloju Filter-Stylize-Emboss 
i podesite vrednosti kao na slici levo. Linije koje ste 
definisali u prethodnom koraku će se „urezati“ u 
vašu sliku. 
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7. Oduzmite boju sa ovoga sloja komandom Image-
Adjustments-Desaturate i gotovi smo. Vaša paleta 
Layers bi trebalo da izgleda kao na slici levo. 

 

8. Pogledajte rezultat koji sam ja dobio. Slika je 
dobila lijepu teksturu (izgleda kao da je boja 
ispucala) i u svakom slučaju sada izgleda mnogo 
interesantnije. 
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Nešto između – Duotone 
 
Često puta fotografije u boji izgledaju isprazno i vještački naročito ako su boje prejake a i ove crno bele 
znaju biti dosadne. Za sve vas koji dijelite moje mišljenje spas je na vidiku, ima nešto između i to je 
Duotone. Vrlo interesantan efekat koji možete primeniti na vašoj fotografiji. Model boja Duotone prevodi 
vašu fotografiju u samo nekoliko boja (najviše četiri) u svijetlijim i tamnijim tonovima. Vaša fotografija će biti 
mnogo interesantnija i udahnućete joj malo duše. Krenite sa vežbom i bićete zadovoljni rezultatom. 
 

 
 
 

1. Otvorite neku fotografiju sa vašeg diska File-Open . Moju 
možete videti levo.  
 
Da bi uopšte bilo moguće primeniti ovaj efekat prvo je potrebno 
da fotografiju prevedete u Greyscale mode pomoću komande 
Image-Mode-Greyscale mode i slika će postati crno bela. Nakon 
ovoga idite ponovo na Image-Mode-Duotone pa pređite na 
sledeći korak. 

 

2. Otvario se okvir za dijalog Duotone Options u kom ćete 
definisati boje koje ćete koristiti u primeni ovoga efekta. Kao 
prvo treba da odredite koliko boja želite na fotografiji.  
 
Pritisnite padajuću listu kod broja 1 (na slici) i odaberite jednu od 
mogućnosti.  
 
Monotone-jedna boja  
 
Duotone-dvije boje  
 
Tritone-tri boje  
 
Quadtone-četiri boje  
 
Ja sam izabrao Tritone i ako želite da imate isti rezultat kao i ja 
uradite isto.  
 
Nakon ovoga pritisnite kvadratić (kod broja dva na slici) da 
izaberete prvu boju 
 
 

 

3. Otvara vam se okvir za dijalog Color Picker i na mesto 
označeno brojem 1 upišite 4E6172 (šifra boje) i nakon toga 
kliknite na dugme Custom (broj 2) da definišete vrstu boje. 
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4: Otvara vam se okvir za dijalog Custom color u kom je program 
već definisao željenu boju ili najbližu vašoj i preostaje samo da 
kliknete OK . 

 
 

5. Vratili ste se ponovo u okvir za dijalog Duotone Options da 
odaberete i ostale dvije boje (primjetićete da se pojavio naziv 
prethodne boje levo od prvog kvadratića).  
 
Ponovite korake 2,3 i 4 i za ostale dvije boje. Na slici levo vidite 
da sam upisao šifre boja koje ćete upisati u Color Picker (kao u 
koraku 3).  
 
Kada odredite sve boje kliknite OK i to je to. 
 
 

 
 
 

6. Ovo je rezultat prethodnih koraka. Ako ste koristili iste boje 
kao i ja vaša slika bi trebalo da izgleda kao i ova levo.  
 
Ako želite da vašu fotografiju snimite u JPEG ili nekom drugom 
formatu koji možete pregledati i bez pokretanja fotošopa ponovo 
prevedite sliku u RGB mod pomoću komande Image-Mode-RGB i 
potom je snimite File-Save as.  
 
U suprotnom snimite je u fotošopovom formatu PSD . 

 

Na slici levo sam pokušao sve to skupa uraditi malo 
interesantnije. 
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Mesečina 
 
 
Slikanje u fotošopu slobodnom rukom je gotovo nemoguća misija za one koji nemaju tablet (elektronsku 
olovku) a pošto većina nas to nema onda preostaje da „prevarimo kompjuter“ da nešto naslika za nas. U 
ovome tutorijalu ćete naučiti neke nove trikove i na kraju dobiti jednu sasvim pristojnu sliku koju čak možete 
odštampati i objesiti na zid. Nemojte da vas obeshrabri dužina ovoga tutorijala. Pobrinuo sam se da sve ide 
glatko i u koracima.  
Priprema platna:  
 
 
Otvorite novi dokument u fotošopu File-New a dimenzije i rezoluciju možete odrediti sami. Ako imate 
namjeru da ovo štampate onda je najbolje da radite u rezoluciji oko 200 ppi.  
Važne tehnike za ovaj tutorijal:  
 
 
U kutiji sa alatkama pronađite ikonice za foreground i background boje (vidite ih na slici dole levo). 
Foreground color je boja sa kojom slikate a background color je boja sa kojom brišete gumicom za brisanje 
(ovo važi samo za rad na Backgroundu a ne na sloju). Kada želite da slikate sa background bojom pritisnite 
taster X na tastaturi i njihov raspored će se promijeniti (ona koja je bila foreground postaće background boja 
i obratno).  
 
 
U ovome tutorijalu često ćete koristiti alatku Paint Bucket Tool ili kako je ja zovem kanta. Ova alatka prekrije 
vaše platno ili selekciju foreground bojom, dovoljno je da kliknete sa njom na platnu i ono će se obojiti 
izabranom bojom. 
 

 
 
 
 
 
Upoznajte boje :  
 

Vrijeme je da se upoznamo sa bojama koje ćemo koristiti u ovome tutorijalu. Na donjoj sličici vidite dvije 
osnovne boje koje ćemo koristiti a ispod njih se nalaze njihovi RGB kodovi. Ove dvije boje ćemo nazvati 
„boja noći“ i „boja mjesečine“ i siguran sam da znate koja je koja. 
 

 
 
 
 
 
 
 
 
 



PHOTOSHOP - Tutorijali 

 56 

Kako ove boje pronaći u fotošopu ? Vrlo jednostavno, kliknite na ikonicu Foreground color i otvoriće vam se 
Color Picker (prozor u kom možete odabrati boju) koji možete videti na slici dole. Kodove koje možete videti 
na gornjoj sličici upotrebite da pronađete ove boje.  
Zapišite prvi kod na komadić papira i kada otvorite Color Picker upišite ga u kućicu koju sam označio na 
donjoj slici. Kada kliknete na OK ova boja će postati vaša foreground color spremna da sa njom slikate. 
 

 
 
Crtamo noć :  
Korak 1 . Pošto ste već otvorili novo platno sa Paint Bucket tool zalijte platno sa „bojom noći“ koju ste 
odabrali za foreground color na način kako sam vam objasnio u prethodnom koraku. Kao što možete videti 
na slici dole napravili smo pozadinu za našu sliku. 
 

 
 
Crtamo zvezde :  
Korak 1. Na paleti Layers kliknite na ikonicu New Layer (označio sam je strelicom) i napravite novi sloj. 
Program će mu automatski dati ime Layer 1. Kliknite na taj tekst i promijenite mu ime u „zvijezde“.  
 

Korak 2. Uzmite alatku Rectangular Marquee tool iz kutije sa alatima.  
Sa ovom alatkom označite-odaberite gornju polovinu platna. Pritisnite alatkom u gornji levi ugao platna i 
povlačeći označite gornju polovinu platna.  
 

Korak 3. Pošto nam je u ovome koraku potrebna „čista bela“ pritisnite taster D da izaberete default boje 
(crnu i belu) i potom taster X da vam „čista bela“ bude foreground boja. Uzmite Paint Bucket tool i zalijte 
označeni dio platna sa čistom belom. Gornja polovina platna je obojena belom bojom i vjerovali ili ne za par 
sekundi pomoću ove bele ćemo nacrtati zvijezde. Pritisnite Ctrl +D da izađete iz selekcije. 
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Korak 4. Idite na Filter-Sketch-Reticulation i kad vam se otvori prozor za podešavanje opcija ovoga filtera 
podesite ih kao na slici dole.  
 

Korak 5. Na paleti Layers promijenite model stapanja ovoga sloja na Color Dodge (označeno na slici).  
 

Opcija : Ako želite, zvijezde možete istaknuti-posvijetliti pomoću komande Brightness/Contrast i možete je 
pronaću u meniju Image-Adjustments (nemojte pretjerati sa visokim vrednostima).  
 

Ovim smo završili rad na zvijezdama. Bilo je bezbolno zar ne. 
 

 
 
 
Crtamo more :  
Korak 1. Napravite novi sloj klikom na ikonicu New Layer u okviru palete Layers (označeno strelicom) i 
promijenite ime sloja u „more“ kao u prethodnom slučaju.  
 

Korak 2 . Iz kutije sa alatima ponovo uzmite Rectangular Marquee tool .  
 

Korak 3. Napravite kvadratnu selekciju sa ovom alatkom na donjem dijelu platna kao na slici. Ponovo 
podesite boje, za foreground boju odaberite boju noći a za background boju mjesečine na način kako sam 
vam to objasnio na početku tutorijala. Konačno kada ste to uradili uzmite Paint Bucket tool i sa „bojom noći“ 
zalijte ovu selekciju. Ponovo pritisnite Ctrl +D da izađete iz selekcije. 
 

 
 
 
Korak 4. Idite na Filter-Render-Fibers i kada vam se otvori prozor kao na slici dole podesite vrednosti kao na 
njoj (Variance-30, Strenght-3) i kliknite jednom na dugmence Randomize i na kraju OK.  
 
Korak 5. Dobili ste teksturu mora samo nam je naopako okrenuta pa zbog toga idite na Edit-Transform-
Rotate 90 0 CW da okrenete sloj za 90 stepeni i namestimo ovu testuru kako treba.  
 
Korak 6. Razvucite teksturu na željenu veličinu. Idite na Edit-Transform-Scale i kada vam se oko teksture 
pojave ručice koje sam označio na slici povlačite ih dok sa njom prekrijete donju polovinu platna. Kada ste 
jednom gotovi na liniji opcija kliknite znak potvrde i to je to. 
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Korak 7 . Umekšajte gornju ivicu mora da ne izgleda kao da smo ga makazama isjekli i nalijepili na 
platno.Uzmite Eraser tool (gumica) i na liniji opcija odaberite gumicu velikih dimenzija-Master 
Diametar(pogledajte kružnicu koju sam nacrtao) i mekih ivica ( Hardness 0).  
 
Korak 8. Držite pritisnut taster Shift dok brišete gornju ivicu mora.......sada to izgleda mnogo bolje.  
 
Korak 9. Promijenite model stapanja ovoga sloja na Overlay. 
 

 
 
Crtamo mjesec:  
Korak 1. Napravite novi sloj i dajte mu ime mjesec.  
 

Korak 2 . Uzmite Elliptical Marquee tool (on se nalazi na istom mestu kao i Rectangular Marquee tool, samo 
pritisnite malu strelicu kod alatke da otvorite meni).  
 

Korak 3. Pritisnite taster Shift i držeći ga označite malu kružnicu i potom je sa Paint Bucket tool obojite u 
boju mjesečine. Pritisnite Ctrl+D da izađete iz selekcije. 
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Korak 4. Napravite malo teksture na površini ovoga našeg mjeseca. Idite na Filter-Artistic-Sponge i kada vam 
se otvori prozor podesite vrednosti po vašoj želji ili kao na donjoj slici.  
 
Slika 5. je uvećana verzija mjeseca da vidite rezultat prethodne operacije. 
 

 
 
 

Korak 6. Idite na Layer-Layer Style-Outer Glow i kada vam se otvori prozor kao na slici dole podesite sledeće 
vrednosti.  
 
•  Kliknite na boju i potom pokazivač miša nanesite na ikonicu foreground boje (to je boja mjesečine), 
pokazivač će se promijeniti u pipetu i sa njom kliknite na boju da je uzorkujete.Ova boja će pojaviti u malom 
kvadratiću koji sam zaokružio na slici dole.  
 
•  Povećajte opciju Size na 150 px  
 
Oko mjeseca se pojavio oreol i to je ujedno sve na ovome sloju. 
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Crtamo mjesečinu :  
Korak 1. Napravite novi sloj i dajte mu ime mjesečina.  
 
Korak 2. Iz kutije sa alatima uzmite Brush tool a širinu četkice podesite slično kao na slici 3.  
 
Korak 3. Držeći taster Shift povucite sa četkicom potez prema dole (od mjeseca ka moru) kao na slici.  
 
Ako vam širina četkice nije odgovarajuća na meniju opcija za ovu alatku podesite Master diametar na 
odgovarajuću širinu. 
 

 
 
Korak 4. Idite na Edit-Free Transform i oko ove linije će se pojaviti ručice. Pritinite taster Ctrl i mišem 
povucite jednu od ručica. Uglavnom oblik koji bi trebali da dobijete je trapez kao na slici dole. Kada ste 
gotovi pritisnite znak potvrde na liniji opcija.  
 
Korak 5. Idite na Filter-Blur-Gaussian Blur i kad vam se otvori prozor kao na slici dole podesite Radius na 100 
px.  
 
Sada je ova linija koju ste nacrtali postala mjesečina. 
 

 
 
 
 
 
 
Crtamo odsjaj na vodi :  
Korak 1. Napravite novi sloj i dajte mu ime „Odsjaj“  
 
Korak 2. Sa alatkom Brush tool nacrtajte još jednu liniju kao u primeru crtanja mjesečine (ovaj put liniju 
nacrtajte preko mora).  
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Korak 3. Idite na Filter-Stylize-Wind i u prozoru podesite sledeće opcije  
 
-Method „Blast“  
 
-Direction „From Right“  
 
Ponovite ovaj filter još jednom ali ovaj put u prozoru promijenite opciju Direction u „From Left“ 
 
 
 
 

 
 

 
 
 
Slika 4. Rezultat koji bi trebali imati nakon primene ovoga filtera. Odsjaj na za sada i nije nešto ali nemojte 
se uzbuđivati stvar ćemo ubrzo popraviti pomoću dva filtera Blur.  
 
Korak 5. Idite na Filter-Blur-Motion Blur i podesite vrednosti  
 
-Angle na 0 0  
 
- Distance na 50 px  
 
Korak 6. Idite na Filter-Blur-Gaussian Blur i podesite vrednost Radius na 3 px. 
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Korak 7. Napravite opet trapezoidni oblik. Idite na Edit-Free Transform pa sa pritisnutim tasterom Ctrl 
povlačite ručice do željenog oblika. Kada ste gotovi pritisnite znak potvrde na liniji opcija.  
 
Korak 8. Na paleti Layers kliknite na ovaj sloj i držeći prevucite ga ispod sloja „More“.  
 
Smanjite opciju Opacity po želji (kod mene je oko 50%). 
 

 
 
 
 
Slika je gotova i možete je videti dole zajedno sa okvirom. Možda vam je sve ovo izgledalo zamorno ali sam 
sasvim siguran da se na kraju isplatilo. 
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Tonirane fotografije 
 
...... ili mnogo bolje crno bele fotografije.  
 
Bavite se umjetničkom fotografijom..... vjerujte ovo je fundamentalna tehnika za vas, jednostavno, morate 
je poznavati. Tonirane crno bele fotografije ste viđali i prije i ako niste znali kako to postići tu je stari dobri 
Dr. Photoshop da vam pomogne. Tehnika je u osnovi vrlo jednostavna, umešaćete malo boje u kontrolisanim 
omjerima pomoću komande Curves i dodati ih na vašu crno belu fotografiju.  
 
Ništa vas ne ograničava da upotrebite i kolor fotografiju, samo je potrebno da je „prevedete“ u sive tonove 
kao što sam i ja uradio u ovome tutorijalu. Pratite tutorijal u koracima i vaše fotografije će izgledati mnogo 
bolje i profesionalnije nego što ste to očekivali od njih. 
 
 
 
Korak 1.  
 
Otvorite vašu fotografiju u fotošopu File-Open i pronađite je na vašem disku (kolor ili crno bela, svejedno 
je). Prvo što je potrebno da uradite je da provjerite u kom modelu boja je prikazana. Idite na Image-Mode 
pa potom u meniju kliknite na RGB Color ako to već nije slučaj. 
 

 
 
 
 
Korak 2.  
 
Ako je vaša fotografije već crno bela onda možete preskočiti ovaj korak a ako nije kao kod mene idite na 
Image-Adjustments-Desaturate da fotografiji „oduzmete“ boju. 
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Korak 3.  
 
Na paleti Layers kliknite na ikonicu koju sam označio strelicom na donjoj slici (New Adjustments Layer) i u 
meniju koji će se otvoriti kliknite na Curves . Ovim postupkom ćete napraviti novi sloj za podešavanje i on će 
se pojaviti na paleti. Istovremeno na radnoj površini će se pojaviti prozor za podešavanje komande Curves. 
To je upravo ona „mašina“ sa kojom ćemo da mešamo boje. 
 

 
 
 
 
Korak 4.  
 
Na slici dole možete videti prozor za podešavanje komande Curves . Vidite dijagram sa krivom za 
podešavanje, spisak kanala itd. Kliknite na strelicu koju sam obilježio da otvorite spisak kanala. To su 
naravno Red, Green i Blue (to je ona skraćenica RGB colors). 
 

 
 
 
 
Korak 5.  
 
Na donjoj slici vidite tri prikaza ovoga prozora. Krenimo redom s leva na desno.  
odaberite kanal Red iz spiska kanala  
nanesite kursor na krivulju u ovome dijagramu i kada se kursor pretvori u krstić kliknite na krivu da napravite 
prvu tačku  
u polja Input i Output upišite vrednosti za tačku 1. iz donje tablice (prva napisana vrednost u kućici tablice je 
uvijek Input a Output je sledeća )  
 
Upravo ste napravili prvu tačku i definisali njenu poziciju na dijagramu.  
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Pređite na sledeću tačku.  
nanesite kursor na krivulju pa napravite drugu tačku  
upišite vrednosti Input i Output za tačku 2. iz donje tablice  
 
I na kraju napravite još jednu tačku  
nanesite opet kursor na krivulju i napravite treću tačku  
upišite vrednosti Input i Output za tačku 3. iz donje tablice  
 
Upravo ste završili podešavanje za crveni (Red) kanal. Siguran sam da ste shvatili kako ovo funkcioniše pa se 
zato bacite na podešavanje i ostala dva kanala (Green i Blue) na isti način kao što ste podesili vrednosti za 
ovaj. Na donjoj tablici imate vrednosti Input i Output za sve tačke i sve kanale. Vrednosti tačno upisujte ako 
želite da imate isti rezultat kao i ja. 

 
 

 
 

 
Slika1.  
 
Na donjoj fotografiji ja sam napravio mali miks prije i posle toniranja da lakše uočite razliku. 
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Korak 6 .  
 
Kada ste jednom gotovi sa podešavanjem svih kanala i tačaka te njenih pozicija sigurno ste pomislili dobra 
stvar ali mnogo muke oko ovoga. Da ne bi isti posao radili više puta sve skupa možete da snimite i kada vam 
se opet prohtije da tonirate fotografije to možete uraditi sa par klikova u programu.  
 
Na donjoj slici vidite da sam obilježio dugmence Save , kliknite na njega i snimite vaše podešavanje negdje 
na disku (dajte mu ime Sepia-tako se zove ova vrsta tona).  
 
Sada možete kliknuti na dugme OK i izaći iz ovoga prozora. 
 

 
 
Kada budete željeli da ponovo iskoristite ova podešavanja na nekoj drugoj fotografiji sve što treba da uradite 
je da napravite sloj za podešavanje Curves (kao na početku ovoga tutorijala) i potom u prozor komande 
Curves kliknete na dugmence Load . Pronađite na disku ovu datoteku a na slici dole možete videti kako ona 
izgleda na kompjuteru. 
 

 
 
 
 
Slika 2.  
 
Na donjoj slici vidite rezultat koji sam dobio i siguran sam da će i vaš biti potpuno isti. 
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Slika 3 i 4.  
 
Na donjoj slici vidite još jedan ton „Selenium“ i u tablici ispod fotografije imate sve vrednosti za Input i 
Output koje trebate upisati u prozor za podešavanje komande Curves da bi ga primenili na vašoj fotografiji. 
 

     
 

  
 

 
 
 
 
Slika 5 i 6.  
 
Još jedan ton „Palladium“ i ako vam se dopada ništa vas ne sprečava da ga „skinete“ , tablica sa podacima 
je tu i bacite se na posao. 
 

     
 

  
 
 

 
 
 
 
 
 



PHOTOSHOP - Tutorijali 

 68 

 
Kreiranje providne sfere 
 
 
Predstavljamo vam način kreiranja prozirnog sferičnog objekta, koji možete upotrebiti za svakojake potrebe. 
Iskoristite ovaj tutorijal i kreirajte sjajne dugmiće za vaše interfejse ili poboljšajte izgled već postojećih 
radova. Ovaj tutorijal spada u složenije, ali opisaćemo svaki detalj, pa verujemo da neće biti problema. Pa, 
da odmah krenemo.  
 
 

 
 
 
 

Sa prečicom [Ctrl+N] otvorite novi dokument (širina:400px, visina 400px). Zatim 
sa prečicom [Ctrl+Shift+N] postavite novi layer (dajte mu naziv Krug) i isključite 
vidljivost pozadinskog (background) sloja, tako što kliknete na ikonicu oka.  
Zatim, izaberite alatku Elliptical Marquee Tool i držeći [Shift] napravite kružnu 
selekciju. Kliknite na foreground color na paleti alati i u novom prozoru pređite 
na RGB mod i unesite sledeće vrednosti: R-100, B-58 i G-9. Popunite selekciju 
prečicom [ALT+BACKSPACE]. 
 

 
 
 
 

Prevucite sloj "Krug" na dugme novog sloja radi dupliranja. Kliknite na ikonu oka, 
pored originalnog sloja "Krug", da bi ga sakrili. Smanjećeno selekciju preko 
menija Select > Modify > Contract... i to za 32 piksela. Pritisnite prečicu 
Ctrl+Alt+D i u novom dijalogu unesite 25 piksela. Pritisnite Delete za brisanje 
viška i potom Ctrl+D, radi deselektovanja. 

 
 
 
 

Prevucite dati sloj na radi dupliranja i preimenujte ga u "Vatra". Kliknite Preserve 
Transparency ili Lock Transpaernt pixels (verzija 6), postavite belu boju za 
foreground i obijite sloj sa Alt+Backspace. 
Podesite moda na Color Dodge, i providnost na 70%. 

 
 
 
 
 
 
 
 

Držeći Ctrl, kliknite sloj "Krug",pa kreirajte novi sloj klikom na i preimenijte ga u 
"Senka". Potom za foreground boju postavite crnu. Ispunite selekciju na novom 
sloju crnom bojom - Alt+Backspace. Tasterima strelicama pomerite selekciju 
gore i levo za oko 60 piksela.  
Ctrl+Alt+D i podesite 40 piksela, te sa Delete izbrišite selekciju. Deselektujte 
sa Ctrl+D. 
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Podesite providnost sloja "Senka" na 60% i prevucite ga na dugme novog sloja, 
radi kopiranja. Postavite transparentnost novog sloja na 15%, a mod na Color 
Burn. 

 
 
 
 

Držeći Ctrl, kliknite na original "Krug" layer. Sad, kreirajte novi layer na samom 
vrhu i preimenujte ga u "Svetlost". Izaberite crnu boju (foreground color) i 
popunite novi sloj sa Alt+Backspace. Podesite blending mod sloja na Screen, i 
deselektujte selekciju. Promenite providnost layer-a - Opacity na 60%. 

 
 
 
 

zaberite meni Filter > Render > Lighting Effects..., promenite svetlost u 
Omni, i intenzitet postavite na 100. Postavite svetlo u gornji, levi ugao (kao na 
slici), prevlačenjem pomoću miša. Povećajte malo svetlost, prevlačenjem spoljnih 
tačkica. 
Promenite vrednosti vezane za materijal: 
Gloss: 100 
Material: -100 
Ambience: 0 
Exposure: 0 
Kliknite OK i pozovite meni Image > Adjust > Auto Levels. 
 

 
 
 
 

Napravite kopiju layer-a "Svetlost", i podesite blending mod novog layer-a na 
Color Dodge, a opacity na 50%. 
Trebalo bi da imate situaciju kao na slici.  

  

 

 

Na kraju možete dodati neki tekst unutar kruga. Kreirajte neku novu sliku i 
unesite neki tekst, pa selektujte ceo tekst i kopirajte u clipboard. 
Držeći taster [Ctrl], kliknite na layer "Svetlost", radi selekcije. pa izaberite meni 
Edit > Paste Into. 
Ponovo držite [Ctrl], kliknite na layer "Svetlost". I izaberite meni Filter > 
Distort > Sphereize..., te u novom dijalogu unesite 100%. Na samom kraju 
promenite mod u Color Dodge, i podesite providnost na najbolju moguću meru.  
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Vizit karte – dizajn 
 
Kreiranje vizit karti zna biti prilično mukotrpan posao ako želite da napravite nešto interesantno i dopadljivo. 
Osim osnovnih podataka i logo-a firme sve ostalo je stvar vaše mašte i kreativnosti. Zato pustite mašti na 
volju a u sledećem primeru naučite neke osnovne tehnike koje će vam poslužiti da vaš rad pretočite u gotov 
proizvod. Mnogo priče oko tako malog komadića kartona.  
 
Kao osnovnu stvar prilikom dizajniranja potrebno je odabrati boje koje ćete koristiti u izradi vaše vizitke. To 
mogu biti samo crna i bela i sa njima ne možete nikada pogrešiti ili kao u ovome tutorijalu više različitih 
boja. Boje koje sam ja koristio možete „skinuti“ pomoću RGB kodova koje sam napisao ispod svake boje. 
Takođe ne postoji razlog da ne radite sa svojim bojama, na kraju ovo je samo prijedlog koji može da vam se 
dopadne ili ne. U ovom tutorijalu ja sam koristio i dvije fotografije ali to je samo opcija- može i bez njih.  
 
 

 
 

Korak 1.  
 
Otvorite novi dokument File-New i podesite opcije 
Widht 90 mm i Height 50 mm a Resolution na 300 ppi 
. 
 

 
 

 
 

Korak 2.  
 
Opcija: Pronađite dvije fotografije na vašem disku i 
otvorite ih u fotošopu File-Open . Na slici dole možete 
videti moje. Takođe ispod možete videti boje koje 
ćemo koristiti u ovome tutorijalu. Njihove RGB kodove 
zapišite na komadić papira ako želite da ih koristite. 

 
 

Korak 3.  
 

Sa alatkom Move tool  prevucite obadve 
fotografije na platno koje ste napravili u prvom 
koraku. Sa ovom alatkom ih poređajte na platnu kao 
na slici dole. Nemojte se previše zamarati sa detaljima 
na fotografiji, najbitnije su boje. Ovde fotografije 
služe samo kao grafički element. 
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Korak 4.  
 
Napravite novi prazan sloj klikom na ikonicu New 
Layer (strelica). Dajte mu ime koje hoćete a kod 
mene se zove „pravougaonici“. 

 

Korak 5.  
 

Uzmite Rectangular Marquee tool  i sa njim 
označite gornju levu četvrtinu platna kao na slici dole. 

Sa alatkom Paint Bucket tool  zalijte ovu selekciju 
sa nijansom žute. Uzmite opet Rectangular Marquee 

tool  i nanesite alatku u selekciju pa prevucite 
selekciju u donji desni ugao. Ponovite postupak 
bojenja sa drugom bojom i vaš rezultat bi trebao biti 
kao na slici dole. Pritisnite Ctrl +D da izađete iz 
selekcije. 
 

 
 

Korak 6.  
 
Napravite novi sloj klikom na ikonicu New Layer na 
paleti Layers kao u koraku 4. Uzmite Polygonal Lasso 

tool  i sa njim klik po klik označite selekciju kao 
na donjoj slici. Napomena: selekcija se zatvara u 
prvoj tački kada se pored alatke pojavi ikonica kruga . 

 

Korak 7.  
 

Ispunite sa alatkom Paint Bucket tool  ovu 
selekciju sa nijansom plave. Pritisnite Ctrl +D da 
izađete iz selekcije. Napravite još jedan prazan sloj pa 

sa Rectangular Marquee tool  označite jednu 

traku na vrhu platna i sa Paint Bucket tool  zalijte 
je sa nijansom crvene. Pritisnite opet Ctrl +D da 
izađete iz selekcije. Završili ste sa dizajnom i potrebno 
je da uradite još par stvari da završite posao. 
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Korak 8.  

Uzmite Text tool  odaberite font i veličinu slova 
pa unesite tekst na vizit kartu. Moj rezultat možete 
videti na slici dole. Snimite vaš rad u JPEG formatu da 
„slijepite“ slojeve i možete ga odnijeti vašem 
omiljenom štamparu ili ako imate štampač u boji i 
naravno dovoljno boje i odgovarajućeg papira možete 
uraditi istu stvar u kućnoj radinosti. 
 
 
Ako ste se odlučili da vizitke štampate kući nastavite 
dalje u koracima. 
 

 
 
 

Korak 9.  
 
Otvorite novi dokument File-New pa u padajućoj listi 
Preset pronađite i kliknite na A4 (predpostavljam da 
ćete štampati na tom formatu papira). 

 
 
 

Korak 10.  
 
Idite na View-Show-Grid da prikažete mrežu preko 
platna da vam je lakše redati vizitke po ovom novom 
platnu (mreža se isključuje na potpuno isti način). 
Aktivirajte prozor sa vizitkom i idite na Image-Rotate 
Canvas-90 0 CV da je okrenete u odgovarajući položaj 
za redanje po novom platnu. Kada ste ovo uradili 

uzmite Move tool  i sa njom prebacite vašu vizitku 
na novo platno. Sa istom alatkom i uz pomoć mreže 
nađite joj mesto na novom platnu (savjet-ostavite 
malo margine sa strane oko 0,5 cm). Postupak 
ponavljajte dok potpuno prekrijete platno sa 
vizitkama. 
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Slika 1.  
 
Na fotografiji vidite kako to kod mene izgleda. Vidite 
da sam sa strana ostavio malo margine da bi štampač 
mogao sve da odštampa. Jednostavno sam se 
poslužio sa mrežom i ravnomjerno poređao vizitke. 

 
Korak 11.  
 
Idite na File-Print with Preview.  
Broj 1. U prozoru koji će vam se otvoriti kliknite na dugmence Page Set Up .  
Broj 2. U novom prozoru koji će se otvoriti u padajućoj listi Size odredite format papira A4 i kliknite OK .  
Broj 3. Vratićete se ponovo u prozor kao na slici dole i sve što preostaje je da u štampač stavite papir i 
kliknite na dugme Print . Odštampajte kopija koliko vam je potrebno i bacite se na posao sa makazama da 
isječete vaše vizitke.  
Opcija. Ako na prvom odštampanom primerku primjetite da margine nisu dovoljne velike i ivice dokumenta 
nisu dobro odštampane povećajte margine. To možete vrlo lako uraditi sa opcijom Scale . Jednostavno 
smanjite vrednost za nekoliko procenata a u prozoru levo možete videti kako to izgleda (npr na 95 0 ). 
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Foto montaža 
 

 
 

Otvorite fotografiju na kojoj ćete raditi ili uzmite našu. 
 
TIP: 
Extract funkcija je korisna samo ako imate fotografiju 
koja nema puno detalja u pozadini. 
 
Zahtjevnije izbijanje podloge ne prolazi bez Pen alata. 

 
 

EDIT - Extract ili Ctrl+Alt+X 

 
 

Otvara se novi prozor.  
 
Namestite setinge kao na slici... 
 
 
 
 

 

U alatima izaberite Highlighter tool... 
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...i nacrtajte outline oko cure. 
 
Malo je teže opcrtati s mišem ali ako nemate crtaći 
tablet nema vam druge. 

 
 

Sada u alatima odaberite PaintBucket tool... 

 
 

... i kliknite jednom na curu da ju pobojite tj. da 
označite delove koje želite odvojiti od podloge. 
 
Kad ste sve napravili kliknite Prewiev i ako je sve 5 
kliknite OK. 
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... imate situaciju kao mi i ponovo ste u glavnom PS 
prozoru. 

 

Sada otvorite fotografiju koju ćete koristiti kao novu 
podlogu i jednostavno primite layer na kojem se nalazi 
cura i povucite je na novi dokument tj. dokument koji 
je vaša nova podloga. 
 
Ako vam je ostalo nekakvih sitnih detalja oko cure 
uzmite gumicu i pažljivo ih pobrišite. Da bolje 
"blendate" djevojku u novu okolinu, u alatima 
selektirajte Blur tool i prođite lagano preko rubova 
cure. 
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Obrada portreta – Retuširanje 
 

 
 

Ok ajmo po redu... prva stvar je sto ovo nije u startu 
100% primenjivo jer neke stvari radim na velikoj 
fotki pa kod resize-a ispadnu bolje... isto tako svaka 
fotka ima drukcije parametre i ne funkcioniraju stvari 
isto... 
 
al evo jedna rutina :  
 
1. fotka izvucena iz rawa ... nista nije dirano : 

 

2. crop kakav nam se sviđa : 
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3. korekcije : maknemo sve nezeljeno smece s fotke, 
dlake pristice ( healing i clone tool ) i popunimo rupe 
na rubovima ... 

 
 

4. levelsi , boje ( saturacija +30 ) 
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5. fine tuning boja i kontrasta ... u selektive colors 
podignem crvenu i žutu oko +30 prema crnoj ... 
malo crnu i neutral prema crnoj ... ovo je 
individualno za svaku fotku drukcije ... sharpen 

 
 

6. sad zanimljivi dio .... duplicate layer i goussian 
blur 4.0 pixela ( dobijemo ovo mutno ) 
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7. opacity tog mutnog layera na 40% ( opet svaka 
fotka drukcije ) sad je vec fino zblurano, al problem 
je da je sve zblurano ... 

 
 

8. uzme se neki eraser srednje velicine ( neki 
sprejasti , ne kružni ) na jedno 40% jacine i fino 
pobriše šta hočemo da bude oštro 
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9. i to je to... za kraj za full plastic-fantastic po želji 
provuči kroz neat image ( optional ) 
 
 
 
 
 
 

 
 
to je sad jedna rutina koja pali , ali poenta je da je svaka fotka individualna i da stvari koje pale na jednoj 
fotki potpuno isto primenjene upropaste drugu .... ponavljenje ovog gore na nekoj fotki kojoj to ne odgovara 
napravit ce je totalno neprirodnom .... treba se igrati i napraviti svoju rutinu.. Ima milion tutorijala, i masu 
puta sam nesto probao primeniti 1:1 na neku fotku i nikad to nije izgledalo kao na originalu s kojeg sam 
kopirao... 
Da bi se nesto dobro napravilo mora se raditi s razumevanjem sta se radi , inace ponavljanje ovih koraka je 
besmisleno. Ovo moze poslužiti kao uvid u postupak i neki princip ali nije to čarobni štapić nakon kojeg će 
sve super izgledati.... 
 
Bluranje i sharpanje , pogotovo brisanje zavisi o osećaju i vrlo lako ako se ne napravi dobro i s merom 
napravi fotku smešnom.... 
 
Nadam se da će ovo pomoči ali osnovni savet je , raditi u PS-u i sami doći do svog postupka.... Ja sam isto 
krenuo sa raznim tutorijalima i napravio svoju kompilaciju akcija koja mi paše i funkcionira... 
na taj način manje više svuda imam prepoznatljiv stil i ne kopiram nikoga ... ima bezbroj mogućnosti za 
razne rutine i najbolje je napraviti originalno svoju ... nekad mi se zamera plastičnost i sl. ( nekad i ja 
preteram ) ali bar je vrlo prepoznatljivo i originalno... 
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Retuširanje lica 
 

 
 

Otvorite fotografiju na kojoj ćete raditi ili uzmite 
našu. 
 
Strelice na slici pokazuju na "smeće" kojeg ćemo se 
rešavati. 

 
 

FILTER - NOISE - Dust&Scratches. 

 
 

U History prozoru Alt+Klik na Make new Snapshot 
ikonu i imenujte Snapshot Veliki. 
 
Nakon toga kliknite na Open u history prozoru da se 
vratite korak unazad. 
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Opet FILTER - NOISE - Dust&Scratches. 

 
 

...opet Alt+Klik na Create new snpshot ikonu i 
imenujte snapshot Mali. 
 
Ponovo kliknite na Open da se vratite u prvobitno 
stanje. 

 
 

Sada u alatima odaberite History Brush.. 

 

... i u History paleti kliknite pored Snapshota Mali. 
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... Povećajte fotku i počnite lagano uklanjati 
nečistoće. 

 

Veće nečistoće čistite tako da selektiraš Snapshot 
Veliki a manje sa Snapshotom Mali. 
Kombinarajte ovu tehniku sa CloningStamp alatom i 
daleko ćete dogurati. Pazite, dobro retuširanje 
zahtjeva vremena i strpljenja, nemojte kao mi za 
ovaj slučaj biti gotovi za 10-ak minuta. Naš rezultat 
nije nešto posebno no nije ni loš s obzirom na 
utrošeno vrijeme. 
Nakon svega ubacite UnsharpMask filter ali ne 
pretjerujte sa Sharpanjem 
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Izbeljivanje zuba 
 

 
 

Selektujte zube koristeci Magic Wand  i postavite 
Tolerance na 20, s tim da mora biti ukljuceno Add to 
selection. 

 
 

 

 
 

Zatim otidjite na Image -> Adjustments -> Hue/ 
Saturation ili pritisnite (CTRL+U), promijenite Edit 
polje u "Yellows", i podesite Saturation i Lightness da 
bi zubi sto prirodnije ispali. 

 
 

Zubi pre i posle 
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Stapanje više fotografija u jednu 
 

 
 

Otvorite sve slike u PS-u. 
 
Kao podlogu tj. osnovnu sliku možete koristiti bilo 
koju. 
 
Dakle ovo će nam biti podloga. 

 
 

Ctrl+A selektirajte cijelu sliku krupnog plana i zatim 
Ctrl+V na podlogu. 
 
Ne obazirite se na kvalitet slika koje gledate, to su 
gifovi u 128 boja. 
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Sada dodajte Layer Mask na novi layer koji imate 
tako da kliknete na Add Layer Mask ikonu  

 
 

...u Brushes prozoru odaberite veliki Soft Brush... 

 
 

...i namestite setinge kao mi. 

 
 

Počnite crtati po maski layera i dobit ćete situaciju 
kao mi. 
 
Šta se ustvari dešava? 
Crtate po maski od layera i zapravo brišete tj. 
skrivate suvišne djelove. 

 

...ovako izgleda naš layer prozor, a i vaš bi trebao 
tako izgledati. 
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Lepo pratite korake od 1 do 4 i ukomponirajte sve 
slike koje želite u montažu. 
 
Što više slika dodate tj. više detalja, publika će duže 
gledati u vaš rad. 
Ne zaustavljajte se samo na komponiranju 
fotografija dodajte koji efekt, MISLITE MALO, BE 
CREATIVE. 
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Natpis od fotografije 
 
 
 

 
 
 
 

Otvorite sliku od koje zelite napraviti neki natpis. Mi 
smo izabrali ovu! 

 
 
 
 

Otidjite na Edit -> Define Pattern i nazovite ga Proba 
ili kako vec zelite. 

 
 
 
 

Napravite novi dokument i napisite neki tekst, za 
primer smo napisali "Zoran". Otidjite na Layer -> 
Layer Style -> Pattern Overlay i izaberite "Proba" ili 
kako ste vec nazvali. 

 

Malo se poigrajte se efektima i to je to... 
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Dodavanje TV linija na fotografiju 
 

 
 

Novi dokument Ctrl+N 1x2 pix sa TRANSPARENTNIM 
Backgroundom. 
 
Povećajte sliku 1200% to je maximum, tako da držite Ctrl+Alt i 
pritiskom + na tastaturi. 

 
 

Izaberite foreground boju za TV linije, mi smo izabrali crnu. 
Uzmite Pencil tool i polovicu obojite u crno. Da izgleda kao na 
našoj slici. 

 
 

Zatim EDIT - DEFINE PATTERN. Upišite TV linije. 

 
 

Sada otvorite neku sliku na koju želite primeniti efekt na njoj 
napravite novi layer Ctrl+Shift+N i idite EDIT - FILL i iz menija 
odaberite Pattern - TV linije 

 

Ostalo je samo da namestite Blending mod layera na OVERLAY i 
spustite OPACITY da odovara približno našoj fotografiji i 
promenite Blending mod iz Normal u Overlay. 
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Dodavanje mreže na fotografiju 
 

 
 

Novi dokument Ctrl+N 10x10 pix sa TRANSPARENTNIM 
Backgroundom. 
 
Povećajte sliku 1600% to je maximum, tako da držite Ctrl+Alt i 
pritiskom + na tastaturi. 

 
 

Povuci vodilice 1pix do desnog ruba i 1pix do donjeg ruba. 
Napravite pravougaonu selekciju. 
 
NAPOMENA: Radite 2 pravougaone selekcije. Prvo jedan dio a 
onda držite Shift dok selektirate drugi dio. 
 
Pobojaj selekciju u crno. 

 
 

Sada selektirajte sve Ctrl+A i onda kopirajte Ctrl+C. 
 
Zatim EDIT - DEFINE PATTERN. 

 
 

Sada otvorite neku sliku na koju želite primeniti efekt na njoj 
napravite novi layer Ctrl+Shift+N i idite EDIT - FILL i iz menija 
odaberite Pattern. 

 

Ostalo je samo da namestite Blending mod layera na OVERLAY i 
spustite OPACITY na cca. 50%. 
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Dodavanje kiše na fotografiju 
 

 
 

Odaberite neku sliku lepog i sunčanog dana kao mi ili 
uzmite našu. (Desni klik i "Save picture as") 

 
 

Ctrl+Shift+N novi layer i FILTER - NOISE - AdNoise. 

 
 

FILTER - BLUR - Motion Blur. 

 
 

 
 

FILTER - BLUR - Motion Blur. 
 
 
 
 
 
 
....imamo kišu ali izgleda loše. 
 
Idemo dalje.... 



PHOTOSHOP - Tutorijali 

 93 

 
 

 
 

Ctrl+L i namestite Levels kao mi. 
Povucite crni trokutić prema sredini da stanjite kapljice. 
 
 
 
 
 
...sad je već malo bolje, ali nam je nebo još uvijek previše 
sunčano. 

 
 

 
 

Ctrl+Shift+N novi layer. 
Stisnite D da resetirate boje. 
U alatima odaberi Linear Gradien  te povucite odzgora i 
završite malo ispod polovice slike. 
Namestite Blending Mod na Multiply i spustite Opacity na 
75%. 
 
 
 
...ovo je već nešto, no može biti još bolje. 

 
 

Duplirajte Layer 1 tako da ga povučete na Create new 
layer ikonu  
 
Stisnite Ctrl+T i povećajte novi layer. 

 

Ponovite korak 7 još jedanput i povećajte novi layer još 
više od prethodnog. 
Korak 7 i 8 služe da dobijete dubinu tj. da izgleda kao da 
su neke kapljice bliže kameri. 
 
Ako treba još malo podesite Levels na novim layerima. 
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Nebo - kako ga "doterati" i intezivirati 
 

 
 
 

U fotografisanju neba je vrlo bitno da se 
sunce nalazi iza ledja kako bi se dobilo lepo 
plavo i intezivno nebo i naravno da bude 
suncan dan. Narocito je bitno d aje nebo iza 
ledja zbog pojave Hromatske aberacije 
prilikom pada sunceve svetlosti u objektiv ( 
sledeci put o aberaciji ) . Medjutim , kako mi 
ne mozemo uticati na vremenske prilike ako 
vec mozemo na polozaj slikanja onda se cesto 
dodje do losih rezultata , mimo ocekivanih. 
Tako je i jedna moja fotka ispod ocekivanja... 
 

 

Posto je nebo tako kako jeste isao sam 
sledecim fazama ne bi li uspeo da dodjem do 
rezultata: 
1 - Posao sam sa opcijom Select > Color 
Range pa pipetom direktno na slici selektovao 
nebo. Skalu Fuzziness sam isao na 55 ( barem 
je za ovu fotku toliko trebalo ) 
2 - U okviru za dijalog Select > Feather sam 
podesio na minimum odn. 0,2 
3 - Otvorio novi layer (Shift+Ctrl+N ) 
4 - U alatima otvorio Gradient tool 
5 - Za boju prednjeg plana ( foreground ) sam 
uzeo belu a za zadnji plan ( background ) 
zeljenu nijansu plave 
6 - U toolbaru u opciji mode podesio Multiply 
a pored njega Opacity na 58% 
7 - Na vec otvorenom novom layeru alatkom 
gradient prevukao preko njega 
8 – Image > Adjustment > 
Brightness/Contrast pa Contrast isao na +3 
 
I evo fotke za nekih dva minuta .... 
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Onda sam hteo probati da od ovog letnjeg 
predela stvorim jesenji pa sam isao sledecim 
fazama: 
1 – Opet sam posao sa opcijom Select > Color 
Range pa pipetom direktno na slici selektovao 
nebo drzeci taster Shift. Skalu Fuzziness sam 
isao na 55 . 
2 - U okviru za dijalog Select > Feather sam 
podesio na minimum odn. 0,2 
3 – Select > Inverse da bi mi se selektovala 
trava i drvece jer mi je bilo brze prethodno da 
selektujem nebo kao ravnu povrsinu, nego 
direktno travu i drvece... 
4 – Image > Adjustment > Hue/Saturation ... 
Hue isao na -13, Saturation na +8 
5 – deselektovao sliku Ctrl+D 
6 – Image > Adjustment > Selective Color, 
cekirao yelow i podesio Cyan na – 25 a Yelow 
na +80 
 
Evo rezultata, moglo je i bolje sa vise 
strpljenja ( mozda je malo preterano sa 
efektima ...) a i bilo je i drugih nacina da se 
dodje do ovakvih efekata ali bice prilika jos... 
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Promena boja na fotografiji 
 
 
 

 
 
 
 
 

Otvorite sliku na kojoj zelite izmeniti boje. Mi smo 
izabrali ovu za primer gdje cemo od "letnje" slicice 
napraviti "jesenju! 

 
 
 
 
 

Zatim otidjite na Image -> Adjustments -> Hue/ 
Saturation ili pritisnite (CTRL+U), promijenite Edit 
polje u "Greens", i podesite Hue i Saturation kao mi. 

 
 

Ovako nesto bi trebali da dobijete. 
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Zatim otidjite na Image -> Adjustments -> 
Variations, kliknite prvo na Original sliku, a zatim na 
More red i kliknite OK. 

 

Malo se poigrajte se raznim efektima i to je to... 
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Veštački DOF (Depth of field - dubinska ostrina) 
 
 
 
Vezite se, polecemo... Ovo je polazna fotka (dubinska ostrina kriminalna, sve je ostro da se moze iseći gde 
god da pipnes fotku): 
 

 
 
 
 
 
uz taj filter pretvara se u ovu: 
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a sve to uz pomoc ovoga: 
 

 
 
 
 
 
OPIS RADOVA: 
 
Cela prica i tehnika bazira se na strpljivom odredjivanju maske objekta. Konkretno motor, odluka je pala da 
su sve njegove tacke priblizno iste udaljensti. Otuda sam ga filovao u toj sivoj. Inace intenzitetom od 0 do 
255 (dakle zivom bojom) docharavate udaljenost svake od tacaka sa original fotke u odnosu na lokaciju 
kamere. Malo vjezbajuci, napravi samo ovu 3d masku koliko toliko korektnu (ostalo je malo nesavrsen dof 
ispod zandnjeg tocka - ivicnjak, ali oprosticete ovo je ipak samo u edukativne svrhe). 
 
 
Kada se napravi ta maska, odnosno definisu udaljenosti svih tacaka/povrsina od kamere, tu masku mozete 
da snimiti ili kao kanal, ili da je ostavite kao layer mask. 
 
Dalje ide se u Filter, Blur, Lens Blur i tu je glavna prekretnica: 
 
DEPTH MAP: Izaberite iz lista Layer Mask, alpha ili transparency mask ili zeljenu zelekciju (stvar navike, ja 
radim sa layer maskom). Zatim krsticem (ili onim slajderom 0-255) izaberite tacke koje su strogo u fokusu. 
Nakon toga podesite dolje kozmeticke stvari oko velicine irisa, vrste blura, shuma, sve sve sve i opa, 
videcete zanimljive rezultate. Normalno ne treba ni pomenuti da ova tehnika trazi dosta truda i strpljenja uz 
naravno dosta eksperimentisanja, ali svakako je vredi primeniti na neki detalj za koji smo zažalili što nema 
lepsi bokeh i sto nije naglaseniji. 
 
Autor se zahvaljuje MUP-u Sarajevskog kantona, bez cije pomoci ove fotografije (pa i sami eksperiment) 
nebi bile realizovane. Mala napomena: fotografije gledajte sa cisto edukativne strane, jer one su tu iskljucivo 
u funkciji tutoriala. Sama tehnika objasnjena je u grubim crtama i podrazumjeva se elementarno poznavanje 
photoshopa i rada sa selekcijama i layer maskama, i ... Naravno ogradjujem se od upotrebe ove tehnike na 
fotke koje se salju na hrpc, ali kako kazu sve sto se ne vidi dozvoljeno je.  
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Izrada bar koda 
 

 
 
 
 

Kreirajte novi dokument 200px - 100px bjele pozadine. Uzmite 

single row marquee tool   
 
i selektujte sliku na dnu kao i mi. 

 
 
 
 

Otidjite na Filter -> Noise -> Add Noise i namestite Amount of 400, 
Distribution of Gaussian, potvrdite Monochromatic. Nakon toga, 
Edit > Free Transform > Scale i razvucite do vrha slike i pritisnite 
ENTER. Treba da izgleda kao na nasoj slici. 
 

 
 
 
 

Koristite rectangular marquee tool i koristite DELETE na tastaturi i 
obrisite visak linija da bi licilo na pravi bar kod. Uradite kao i mi. 

 
 
 
 

Obrisite donji dio sa rectangular marquee tool i DELETE. 

 

Dodajte brojeve i eto ga, dobili ste bar kod ;) 
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High Pass (kako izoštriti fotografiju) 
 
U Photoshopu postoji mnogo načina da izoštrite svoju fotografiju a ovo je jedan od najjednostavnijih. 
Izoštrićete vašu fotografiju uz pomoć filtera High Pass i njega možete naći u novijim verzijama photoshopa 
( 7, CS i CS2). Nadam se da posjedujete jednu od novijih verzija ovoga programa. Pa da krenemo. 
 

 
 

1.Otvorite fotografiju u photoshopu File-Open a 
moju sliku možete videti levo 

 
 

2. Napravite duplikat Backgrounda prevlačenjem na 
ikonicu New Layer na paleti Layers kao na slici 
dole. 

 
 

3. Na ovom novom sloju primenite filter High Pass, 
Filters-Other-High Pass i podesite vrednost kao 
na slici levo. 
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4. Promijenite model stapanja na Hard Light kao na 
slici dole. Napomena: ako je fotografija zrnasta znači 
da je previše izoštrena onda smanjite vrijednost 
Opacity (zaokruženo). 

 
 
 

5. Na slici možete vidjeti fotografiju prije i poslije 
izoštravanja. 

 

6. Levo imate kompletnu fotografiju i nadam se da 
ste uživali. 
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Efekti na fotografiji 
 
Ovo je još jedan od bezbrojnih trikova u fotošopu. Pomoću njega vaša fotografija će izgledati mnogo 
interesantnije. Pored interesantne tehnike koju ćete ovdje naučiti možete se bliže upoznati i sa alatkom 
Gradient , kako je koristiti i podesiti za upotrebu. Bilo kako bilo otvorite nešto sa vašeg diska i isprobajte ovaj 
sasvim jednostavan trik. 
 

 
 
 

1. Otvorite neku fotografiju za obradu sa vašeg diska a moju 
možete vidjeti lijevo. 

 
 

2. Kliknite alatku   Gradient u kutiji sa alatkama i na liniji 
osobina koju možete vidjeti na slici lijevo kliknite kućicu koju sam 
označio strelicom da otvorite Gradient editor. 
 
 

 
 
 

3. Na slici lijevo vidite prozor Gradient editora u kom možete 
mijenjati podešavati i praviti nove gradiente.  
 
Na već prikazanom gradientu obrišite sve boje koje se nalaze 
između graničnih klizača (u mom slučaju između žute i zelene) na 
sljedeći način.  
 
•  kliknite na jedan od klizača (broj 1) između ova dva granična i 
potom dugme Delete (broj 2 ) kao na slici da obrišete postojeću 
boju  
 
•  ponovite postupak i za ostale boje 

 
 

4. Podesite boje graničnih klizača da napravite novi gradient.  
 
•  kliknite prvi granični klizač (broj 1) kao na slici i kliknite kućicu 
(broj 2) da otvorite Color Picker i odaberite u njemu crnu boju  
 
•  ponovite postupak i za desni granični klizač i ovaj put u Color 
Pickeru odaberite bijelu boju. Rezultat koji ćete dobiti biće kao na 
slici lijevo. 
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5. Podesite Opacity ( providnost) bijele boje i to se radi uz pomoć 
gornjeg klizača označenog sa brojem 1.  
kliknite na njega i podesite Opacity (providnost) na 0% (vidi broj 2)  
ako želite da sačuvajte ovaj gradient ukucajte mu ime (maska) koje 
želite u kućicu (broj 3)  
kliknite na dugme New (broj 4) da ga dodate u postojeću kolekciju 
gradienta i on će biti snimljen da ga možete ponovo koristiti kada 
vam ustreba. 

 
 
 

6. Vratite se na liniju osobina ove alatke i odaberite  
tip gradienta Radial (označeno na slici lijevo) 

 
 
 

7. Pritisnite taster D da izaberete default boje (vidite prikaz boja kod 
broja 1)  
pritisnite dugme Edit in Quick mask mode (vidi broj 2). 

 
 
 

8. Vratimo se fotografiji,  
sa alatkom gradient koju smo podešavali sve do sada pritisnite 
negdje na sredinu vaše fotografije i povucite u jednu stranu. U mom 
slučaju ja sam kao početnu tačku izabrao vrh nosa a završna tačka 
mi je negdje iznad ramena Anđeline Džoli 

 
 
 

9. Nakon ovoga postupka vaša fotografija bi trebala da izgleda kao 
ova lijevo. Ova crvena boja je maska i ona označava područje koje 
neće biti obrisano. Ne brinite što maska ne pokriva čitavo lice samo 
hrabro nastavite dalje. 

 
 

10. Izađite iz režima  
Quick Mask Mode pritiskom na dugme kao na slici lijevo ili taster Q 
na tastaturi i na vašoj fotografiji će se pojaviti selekcija u vidu 
marširajućih mrava.  
Pritisnite taster Delete na vašoj tastaturi da obrišete sve što je izvan 
selekcije i završili ste posao. 
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11. Na slici lijevo možete vidjeti moj rezultat. 
 
 
 
 
 
 
 
 
 
 
 
 
Na slici lijevo možete vidjeti praktičnu primjenu ovoga efekta . Sa 
gradientom »maska« sam povukao iz desnog gornjeg ugla 
dijagonalno i dobio sam ovakav rezultat. U svakom slučaju 
eksperimentišite dok ne dobijete zadovoljavajući rezultat. Dodao 
sam mali natpis sa igrom riječi »foto grad – beo art« ili »foto art -
beograd« , čitajte kako hoćete. 
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Popravka loših fotografija 
 
Ako izuzmemo profesionalce i zaljubljenike u fotografiju većina ljudi ima problema sa snimanjem fotografija i 
konačnim rezultatom. Zbog nedostatka znanja i uslova mnogo mojih fotografija je ispalo očajno, ili su 
previše tamne ili su boje isprane itd. Na svu sreću u fotošopu postoji mnogo alata za popravku grešaka 
prilikom snimanja. Svakako da ne treba očekivati da fotošop »izmisli« nove detalje na vašoj fotografiji ali ono 
što je već zabilježeno na filmu ili memorijskoj kartici može se popravljati.  
 
Kada otvorite neku fotografiju u fotošopu kao prvo potrebno je da uspostavite »dijagnozu« jer je svaka 
fotografija »priča« za sebe. Utvrdite u čemu je problem i onda upotrebite neki od opisanih komandi u ovome 
tutorijalu. Ako je fotografija »katastrofa« onda upotrebite sve opisane alatke da izvučete što više života iz 
nje. 
 

 
 
 

1. Ja sam pronašao jednu fotografiju iz porodičnog 
albuma. Na prvi pogleda odmah je jasno da je 
fotografija pretamna zbog male snage blica na 
fotoaparatu i da bih je posvijetlio koristiću komandu 
Shadow-Highlight . Možete je naći u meniju  
 
Image-Adjustments-Shadows/Highlights . 

 
 
 

2. Kada vam se otvorio okvir za dijalog kao na slici 
lijevo pomoću klizača (zaokruženi) podesite 
vrijednosti za Shadows i Highlights po želji (ili 
ostavite podrazumjevane vrijednosti kao i ja ) i 
kliknite OK . 

 
 
 

3. Rezultat ove operacije je mnogo svjetlija 
fotografija ali su boje prilično »isprane«. Boje su 
isprane zbog loše ravnoteže između svijetlih, 
srednjih i tamnih tonova. Popravljanjem ove 
ravnoteže uradićemo korekciju boja i fotografija bi 
trebala izgledati mnogo bolje. Idite na Image-
Adjustments-Levels i pređite na sljedeći korak. 
Usput, ovo je jedan od jednostavnijih načina da se 
ovo uradi 

 

4. Slika lijevo pokazuje okvir za dijalog komande 
Levels i kao što vidite označio sam crvenim okvirom 
pipete za uzorkovanje sa kojim ćemo popraviti 
ravnotežu tonova u sljedećem koraku. 
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5. Kliknite prvu pipetu sa lijeve strane , nanesite 
kursor na sliku i on će se pretvoriti u pipetu, pa sa 
njom uzorkujte klikom crnu boju sa fotografije. Ja 
sam je pronašao na majici mog starijeg sina (vidi 
sliku).  
 
Nakon ovoga na kliknite pipetu u sredini i sa njom 
uzorkujte sivu boju sa slike (pronašao sam je na 
postolju) i na kraju kliknite na poslednju pipetu 
(zadnja desno) i sa njom uzorkujte bijelu boju ( 
pronašao sam je na majici mog mlađeg sina). Nakon 
ovoga kliknite OK i to je to. 

 
 
 
 

6. Na slici lijevo možete vidjeti rezultat prethodnih 
operacija. Boje na slici su življe i uopšte sada ova 
fotografija izgleda sasvim pristojno. Opcija: Ako boje 
nisu po vašem ukusu možete ih još pojačati. Idite na 
Image-Adjustments-Hue/Saturation i u okviru za 
dijalog koji će se otvoriti povećajte vrijednost opcije 
Saturation . Ali ne valja pretjerivati. 

 
 
 
 

7. I na kraju ali ne i najmanje bitno, jedna od 
tehnika izoštravanja slike . Zbog boljeg prikaza 
uvećao sam dio prethodne fotografije i u sljedećem 
postupku ću je malo izoštriti da objasnim ovu 
tehniku. 

 
 

8. Iako ima mnogo načina da se dobije isti rezultat 
ovo je jedan od sigurnijih načina za izoštravanje pa 
ga možete isprobati. Promijenite model boja na 
vašoj slici tako što ćete ići na Image-Mode-Lab color 
. Na paleti kliknite karticu Chanels da otvorite tu 
paletu i aktivirajte samo Lightness kanal klikom na 
njega (vidi sliku lijevo). 
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9. Idite na Filter-Sharpen-Unsharp Mask i kad vam 
se otvori okvir za dijalog kao na slici lijevo podesite 
vrijednosti po potrebi (ili kao na slici). Na paleti 
Chanels kliknite Lab da prikažete sve kanale i 
ponovo vratite sliku u model boja RGB sa komandom 
Image-Mode-RGB 

 
 

10. Rezultat prethodnih koraka. Slika je izoštrena i to 
možete vidjeti ako je uporedite sa slikom prije ovoga 
postupka. 
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Manipulacija slojevima 
 
Slojevi u stvarnom životu ne postoje i najbliže poređenje za njih je nešto kao tanka plastična folija koju 
možemo postaviti preko fotografije. Slojevi mogu biti potpuno prazni-znači providni, mogu na sebi imati 
boje, fotografiju, tekst ili bilo šta drugo što možete na njega nabaciti u fotošopu. Možemo praviti duplikate 
slojeva, brisati ih, pomicati, mijenjati im sadržaj i još mnogo toga što ne bi možda ni sanjali. Postoji takođe i 
par stvari koji ćemo obraditi u ovome tutorijalu a to su modeli stapanja i vidljivost slojeva . Kada stapamo 
dva sloja po nekoj od opcija modela stapanja, program miješa boje sa ta dva sloja i često nam daje izuzetne 
efekte koje bi u stvarnom životu bilo veoma teško postići. Da bi izvršili stapanje nekog sloja on ispod sebe 
mora imati drugi sloj sa kojim će se stopiti. Ako sloj ispod sebe nema ništa onda ne može biti ni stapanja. 
Drugi efekat koji ćemo koristiti u ovoj vježbi je opcija Opacity i sa njom regulišemo vidljivost nekog sloja, 
tačnije sadržaja nekog sloja. Obe ove opcije se nalaze na paleti Layersi sigurno ste se susretali sa njima. OK 
dosta je teorije da krenemo sa poslom. Pronađite na vašem disku neki portret koji će vam poslužiti kao 
model ili bilo šta drugo sa suvislim sadržajem i još nekoliko fotografija sa različitim teksturama. Ako nemate 
ovakvih fotografija pretražite malo po internetu i siguran sam da ćete naći nešto. Moj model i teksture 
možete vidjeti dole. 
 

 
 

Otvorite vaše fotografije u fotošopu File-Open i krenite sa poslom. U prozoru aktivirajte fotografiju sa 
modelom koji ćemo iskoristiti za ovu vježbu a to je u mom slučaju portret ove djevojke. Ako je vaš model u 
koloru pritisnite Shift+Ctrl+U da ga pretvorite u crno bijeli ako nije onda preskočite ovaj korak. 
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Korak 1 .  
 
Napravite duplikat Backgrounda prevlačenjem 
na ikonicu New Layer (strelica). Sada imate 
dva sloja Background i Background Copy.  
 
Napravite bijelu pozadinu za naš rad. 
Aktivirajte klikom sloj Background (to je ovaj 
donji), na tastaturi pritisnite taster D pa potom 
taster X i potom Alt + Backspace . Sloj 
Background će se ispuniti bijelom bojom i to 
ćete vidjeti na ikonici ovoga sloja na paleti 
Layers. 

 
 

Korak 2.  
 
Aktivirajte sloj Background copy klikom na 
njega u paleti Layers. Uzmite Eraser tool (vidite 
ga na slici lijevo zaokruženo) pa izbrišite 
pozadinu. Ne morate biti posebno precizni, ovo 
je samo vježba i u njoj se malo zezamo. 
Izbrišite čitavu pozadinu da na sloju samo 
ostane lik koji ste odabrali za ovu vježbu.  
 
 

 
 

Korak 3.  
 

Sa alatkom Move tool  prevucite prvu 
teksturu na vaš model i idite na Edit-
Transform-Scale i kada vam se pojave ručice 
povlačite ih dok sa teksturom potpuno 
prekrijete fotografiju modela. 

 

Korak 4.  
 
Na paleti Layers pritisnite sloj sa teksturom i 
prevucite ga ispod sloja sa modelom. 
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Korak 5.  
 
Ponovite prethodni postupak i sa ostalim 
teksturama, redoslijed tekstura možete 
mijenjati kako vam god odgovara.  
 
Poigrajte se sa modelima stapanja .  
 
Na slici lijevo možete vidjeti da sam svakom 
sloju dao ime po modelu stapanja koji sam 
primjenio na njega. Takođe se možete poigrati 
i sa opcijom Opacity i podešavajte je za svaki 
sloj kako vam odgovara. Eksperimentišite sa 
ove dvije opcije i isprobajte razne kombinacije. 
Uopšte se ne morate držati mojih modela 
stapanja. 

 
 
 

Korak 6.  
 
Na kraju, napravio sam duplikat sloja Overlay 
prevlačenjem na ikonicu New Layer i postavio 
ga na vrh (iznad sloja sa modelom) na njega 
sam primjenio model stapanja Multiply jer sam 
htio tamniji ambijent na kraju. 

 
 

Rezultat koji sam dobio prethodnim postupkom 
i očigledno je da tu treba još dorade. Tamna 
mrlja je prekrila desnu polovinu fotografije koju 
moramo eliminisati. 
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Korak 7.  
 
   
 
Uzeo sam opet Eraser tool (vidite ga na slici 
zaokruženo) i podesio njenu veličinu na paleti 
opcija i jednostavno obrisao dijelove koji su 
prekrivali lice modela.  
 
Na paleti opciju podesite da ivice gumice budu 
mekane (Hardness 0%) a veličinu odaberite po 
potrebi (Master Diameter). Ne morate biti 
precizni i brišite slobodnim pokretima. 

Na slici dole možete vidjeti kakav sam rezultat dobio na kraju. Dodao sam i malo teksta da ovo sve skupa na 
nešto liči i to je to. Kao što možete vidjeti iz ove vježbe eksperimentisanjem možete doći do veoma 
interesantnih efekata i nadam se da će vas ovo potaknuti da što više radite sa slojevima. 
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Zabava sa kanalima 1 
 
Šta su kanali ? Vjerovatno vam je poznata priča o osnovnim bojama (plava, crvena i žuta) sa čijim se 
miješanjem mogu dobiti sve ostale boje iz spektra. Na vašem ekranu se boje prikazuju sa osnovnim bojama 
Red, Green, Blue (crvena, zelena i plava) i njihovim miješanjem je moguće prikazati i sve ostale boje na 
vašem monitoru. Ukratko, separacije ovih boja možete vidjeti na paleti Chanels i naravno, oni se zovu kanali. 
Pošto to nije tema ovoga tutorijala i previše je opširna da bi je ovdje predstavili da skratimo i vratimo se 
osnovnoj temi ovoga tutorijala a to je pravljenje efekata na fotografiji uz pomoć novoga kanala koji ćete 
sami napraviti a koji će nam poslužiti sa maskiranje (izdvajanje) jednog dijela fotografije. 
 

 
 

Korak 1.  

Otvorite vašu fotografiju File-Open a moju možete 
vidjeti lijevo. Idite na Image-Mode da provjerite u 
kom modelu boja je vaša fotogafija. Potvrdite RGB 
ako to već nije slučaj.  

 

 
 

Korak 2.  

Uzmite Eliptical Marquee tool  i sa njom 
označite dio fotografije (napravite selekciju). Na 
slici lijevo vidite kako sam ja označio dio ove 
fotografije.  

 

 
 

Korak 3.  

Idite na Select-Feather i kada vam se otvori 
prozorčić kao na slici desno podesite vrijednost kao 
na slici ili slično i kliknite OK. Ova vrijednost zavisi 
od veličine i rezolucije fotografije. Bilo kako bilo 
pokušajte za početak sa ovom vrijednošću.  
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Korak 4.  

Pronađite paletu Channels , ako je ne vidite idite 
na liniju menija Window-Channels , da prikažete 
sve kanale.  

Napravite novi kanal klikom na ikonicu koju sam 
označio strelicom. Program će kanalu automatski 
dati ime Alpha 1. Ovaj kanal će nam poslužiti kao 
maska da napravimo efekte na fotografiji.  

 

 
 

Korak 5.  

Ispunite vašu selekciju bijelom bojom sa kraticom 
Alt+ Backspace . Na kraju ovoga koraka na 
vašem monitoru bi trebali imati rezutat kao na slici 
lijevo. Izađite iz selekcije kraticom na tastaturi Ctrl 
+ D .  

 

 
 

Korak 6.    

Idite na Filter-Pixelate-Color Halftone i kad 
vam se otvori prozor kao na slici lijevo ostavite 
podrazumjevane vrijednosti i kliknite OK. Upravo 
ste napravili masku koja će nam poslužiti za 
brisanje dijelova fotografije.  

 

 
 

Korak 7.  

Na paleti Chanels kliknite na RGB prikaz i vratite sa 
na paletu Layers klikom na njenu karticu.  
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Korak 8.  

Idite na Select-Load selection i otvoriće vam se 
prozor kao na slici lijevo. Skinućete selekciju uz 
pomoć maske koju ste napravili u prethodnim 
koracima. Podesite opcije kao na slici lijevo i 
obavezno kliknite opciju Invert pa na kraju OK .  

 

 

Korak 9.  

Na vašoj fotografiji će se pojaviti selekcija, pritisnite 
taster D da izaberete podrazumjevane boje i 
potom taster Delete da izbrišete selektovano 
područje. Rezultat koji sam ja dobio vidite na slici 
lijevo. Siguran sam da ćete i vi dobiti isto.  

 

 
Umjesto fiiltera Color Halftone koji ste primjenili u koraku 6. možete isprobati i neki drugi. Na donjim 
fotografijama vidite primjenu filtera Mosaic i Crystalize. Ova dva filtera takođe možete naći u meniju Filter-
Pixelate kao i Color Halftone. Isprobajte ove filtere i izaberite efekat koji vam se najviše dopada. 
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Zabava sa kanalima 2 
 
Ovo je nastavak tutorijala „Zabava sa kanalima 1. dio“ i u nastavku sam upotrebio istu fotografiju kao i u 
prvom dijelu. Bilo kako bilo, uradite prvih 5 koraka iz prvog tutorijala da dođete u fazu odakle možete slijediti 
uputstva u ovome tutorijalu. 
 

 
 
 

Korak 6.  

Kada ste uradili prvih 5 koraka iz prvog dijela ovoga 
tutorijala vaš rezultat bi trebao biti kao na slici lijevo.  

 

 
 
 

Korak 7.  

Idite na Filter-Noise-Add Noise i kada vam se 
otvori prozor kao na slici lijevo podesite vrijednosti 
kao na njoj.  

 

 
 

Korak 8.  

Ovo je rezultat prethodnog koraka.  
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Korak 9.  

Idite na Filter-Brush Strokes-Angled Strokes i 
kada vam se otvori prozor kao na slici lijevo podesite 
vrijednosti kao na njoj.  

 

 
 
 

Korak 10.  

Skinite selekciju sa komandom Select-Load 
Selection i kada vam se otvori prozor podesite ga 
kao na slici lijevo.  

 

 

Korak 11.  

Kada se na vašoj fotografiji pojavi selekcija u vidu 
marširajućih mrava pritisnite taster D i potom taster 
Delete (1-2 puta) da izbrišete izabrano područje.  

Vaša fotografija bi trebalo da izgleda kao na slici 
lijevo. 
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Novo za staro 
 
Vjerovatno vam se ovaj naslov ne čini suviše razumnim ali ko zna možda ćete nekada poželjeti da novu 
fotografiju pretvorite u staru. Ovo je jedan od načina kako da vašu fotografiju „postarate“ i date joj onaj 
šmek starih, davno snimljenih fotografija. 
 

 
 
 

Korak1.  

Otvorite vašu fotografiju File-Open , moju možete 
vidjeti lijevo.  

 

 
 
 

Korak 2.  

Idite na Image-Adjustments-Hue/Saturation i 
kada vam se otvori prozor kao na slici lijevo potvrdite 
opciju Colorize i podesite opcije Hue i Saturation 
kao na slici.  

 

 

Slika 1.  

Rezultat koji ste dobili na vašoj fotografiji bi trebao 
biti kao na slici lijevo.  
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Korak 3.  

Na paleti Layers napravite duplikat backgrounda 
prevlačenjem na ikonicu New Layer. Sada imate 
dva sloja.  

 

 
 

Korak 4.  

Na paleti Layers aktivirajte Background klikom na 
njega, pritisnite taster D i potom taster X i na kraju 
Alt+Backspace da Background pretvorite u bijelo 
platno. Sada bi vaša paleta Layers trebala da izgleda 
kao na slici lijevo.  

 

 
 
 

Korak 5.  

Na paleti Layers aktivirajte klikom sloj Background 
copy (to je ovaj iznad) i potom kliknite ikonicu Add 
Layer Mask (označeno strelicom). Maska će se 
pojaviti pored ikonice slike. To je ova bijela ikonica. 
Pomoću maske ćemo napraviti „oštećenja“ na 
fotografiji.  

 

 
 
 

Korak 6.  

Idite na Filter-Render-Clouds i potom na Edit-
Fade Clouds i kad vam se otvori prozorčić kao na 
slici lijevo smanjite vrijednost Opacity na 50% . 
Ako želite veća oštećenja ovaj procenat možete 
ostaviti veći.  
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Korak 7.  

Na kraju idite na Filter-Noise-Dust & Scratches 
pa podesite opcije kao na slici lijevo.  

 

 

Slika 2.  

Ovoje rezultat koji sam ja dobio, siguran sam da će i 
vaš biti sličan mom. Nadam se da vam se dopao ovaj 
tutorijal i ako imate neko pitanje za mene možete mi 
pisati na forumu i rado ću vam odgovoriti.  
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Art foto – tekstura 
 
U ovome tutorijalu ćete naučiti kako da vašu fotografiju učinite zanimljivijom uz nekoliko trikova i sve to za 
pet minuta. Naučićete kako da napravite lijepu teksturu na vašoj fotografiji a koju možete iskoristiti i za 
nešto drugo. OK, da ne davim, najbolje je da krenemo sa radom. 
 

 
 
 

Korak 1.  

Pronađite neku lijepu fotogafiju na vašem disku i 
otvorite je u fotošopu. Moju možete vidjeti lijevo. 
Provjerite u kom modelu boja je fotografija. Idite na 
Image-Mode i potvrdite opciju RGB ako to već nije 
slučaj. Ako je fotografija u boji na tastaturi pritisnite 
Ctrl+Shift +U da fotografiju pretvorite u crno 
bijelu.  

 

 
 
 

Korak 2.  

Na paleti Layers kliknite dva puta na Background da 
ga pretvorite u sloj (program će mu automatski dati 
ime Layer 0) i vaša paleta Layers bi trebala izgledati 
kao na slici lijevo.  

 

 
 

Korak 3.  

Na paleti Layers kliknite na ikonicu Create New 
Layer da napravite novi prazan sloj i potom 
pritisnite na njega i prevucite ga ispod sloja sa 
fotografijom.  

Isključite ikonicu oka pored sloja sa fotografijom. 
Aktivirajte prazni sloj klikom na njega ako slučajno 
nije aktivan. OK sada radimo na praznom sloju i 
napravićemo na njemu teksturu.  
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Korak 4.  

Idite na Filter-Render-Clouds i poslije toga na 
Filter-Render-Diffrent clouds.  

Podesite ravnotežu boja sa komandom Image-
Adjustments-Auto Levels.  

Nakon ova dva slična filtera primjenite još i filter 
Filter-Stylize-Emboss i kada vam se otvori prozor 
kao na slici lijevo podesite vrijednosti kao na njoj.  

 

 
 
 

Korak 5.  

Dajte malo boje vašoj teksturi pa idite na Image-
Adjustments-Hue/Saturation pa kada vam se 
otvori prozor kao na slici lijevo prvo potvrdite opciju 
Colorize i potom podesite vrijednosti kao na slici 
lijevo.  

 

 
 

Korak 6.  

Napravili ste veoma lijepu teksturu i skoro smo 
gotovi. Na slici lijevo možete vidjeti moj rezultat i 
siguran sam da je i vaš identičan.  
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Korak 7.  

Aktivirajte sloj sa fotogafijom klikom na njega i 
uključite ikonicu oka pored njega.  

Promijenite model stapanja na Soft Light i gotovi 
ste.  

Moj rezultat možete vidjeti na slici dole.  
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Korekcija boja 
 
Konačni izgled neke fotografije zavisi od mnogo stvari i vjerovatno vam se dogodilo da niste zadovoljni 
nekim fotografijama koje ste snimili sa vašim fotoaparatom. U ovome tutorijalu ćete naučiti kako popraviti 
boje na vašoj fotografiji da one izgledaju prirodnije i ljepše. Ako imate takvih fotografija pronađite ih i 
otvorite ih u fotošopu pa se bacite na posao. Usput ovo je jedan od najjednostavnijih načina kako to možete 
da uradite. Rezultati su svejedno odlični. Mala napomena : u starijim verzijama fotošopa filter Average koji 
ćemo ovdje upotrebiti ne postoji i na žalost ova vježba sa njima neće moći da se uradi. OK naučite šta to 
radi direktor fotografije na filmu.  
 

 
 
 

Korak 1.  
Otvorite vašu fotografiju u fotošopu File-Open .  
Kao što možete vidjeti lijevo na mojoj fotografiji je dominantna 
zelena boja i fotografija prosto vapi za korekcijom boja.  
 

 
 
 

Korak 2.  
Napravite duplikat Backgrounda.  
Na paleti Layers prevucite Background na ikonicu New layer i 
dobićete još jedan identičan sloj.  
   
 

 

Korak 3.   
Pronađite dominantnu boju sa Filter-Blur-Average i ovaj sloj će 
se ispuniti bojom (kod mene je maslinasto zelena).  
Potom na tastaturi pritisnite Ctrl+I da pronađete kontrastnu boju 
u spektru. Umjesto prve boje sloj će se ispuniti kontrastnom 
bojom (kod mene plavo-ljubičasta).  
Pomoću ove nove boje napravićete korekciju boja na vašoj 
fotografiji.  
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Korak 4.  
Na paleti Layers promijenite model stapanja za ovaj sloj u Color i 
u opciju Opacity smanjite procenat na 50% .  
 

 

Korak 5.  
Nakon prethodnih koraka boje na slici su se popravile ali su ostale 
dosta isprane(slabog inteziteta) pa je potrebno da ih pojačate.  
Napravite sloj za podešavanje Hue/Saturation. Kliknite ikonicu 
New Adjustments Layer (obilježena strelicom) i u meniju koji 
će iskočiti kliknite Hue/Saturation .  
 

 

Korak 6.  
   
U prozoru koji će se pojaviti povucite klizač udesno opcije 
Saturation do željenog rezultata. Promjene su automatski 
vidljive na fotografiji i možete pratiti šta radite.  
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Stilovi slojeva 
 
Stlilove slojeva možete naći u meniju Layer-Layer Styles i oni na različite načine obrađuju sadržaj vašeg 
sloja. Kako to sve skupa radi , vrlo lako. Dovoljno je da imate sloj i nešto na njemu (liniju,slovo, crtež itd.) i 
možete da primjenite stil-stilove koji god hoćete. U ovoj vježbi poslužićemo se tekstom i na njega primjeniti 
različite stilove da vidite kako to izgleda.  
 OK za početak bacite pogled na sliku dole da vidite prozor Layer Style . On je podijeljen na lijevi dio sa 
spiskom svih stilova i dovoljno je da kliknete na ime nekoga i u desnom dijelu prozora pojaviće se opcije za 
podešavanje tog stila. Na slici vidite stil Drop Shadow (sjenka) i opcije za podešavanje tog stila. Poslije ovog 
kratkog upoznavanja krenimo sa vježbom. 
 

 
 

 
 

Korak 1.  

OK otvorite novi dokument File-New 
proizvoljne veličine i potom uzmite Text tool 

 i napišite nešto.  

 

 
 

Korak 2.  

Idite na Layer-Layers Style-Drop Shadow i 
ostavite podrazumjevane vrijednosti, samo 
kliknite OK.  

 

 

Rezultat prva dva koraka. Tekst je dobio lijepu 
ambijentalnu sjenku. 
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Korak 1.  

Otvorite novi dokument ( File-New) proizvoljne 
veličine i sa text tool napišite nešto. Lijevo 
možete vidjeti djelić mog teksta jer sam ga 
povećao da lakše vidite ovaj efekt.  

 

 
 
 
 

Korak 2.  

Idite na Layer-Layers Style-Bevel & Emboss 
i kada vam se otvori prozor za podešavanje 
ovoga stila pronađite opciju Technique i u 
padajućoj listi odaberite Chisel Hard . Opciju 
Size podesite po želji.  

 

 
 

Rezultat prethodna dva koraka. Tekst je 
ispupčen i izgleda kao da je trodimenzionalan. 



PHOTOSHOP - Tutorijali 

 128 

 
 
 
 

Korak 1.  

Otvorite novi dokument ( File-New ) 
proizvoljne veličine. Pritisnite taster D i potom 
Alt + Backspace da pozadinu obojite u crno. 
Uzmite Text tool odaberite boju slova na liniji 
opcija za ovu alatku i napišite nešto. Djelić 
moga teksta možete vidjeti lijevo.  

 

 
 
 
 

Korak 2.  

Idite na Layer-Layers Style-Outer Glow i 
kada vam se otvori prozor kao na slici lijevo 
pronađite opciju Size i podesite je po želji.  

 

 
 

Rezultat prethodnih koraka. Oko teksta se 
pojavio sjajni oreol. 
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Korak 1.  

Otvorite novi dokument ( File-New ) 
proizvoljne veličine i sa Text tool napišite nešto.  

 

 
 

Korak 2.  

Idite na Layer-Layers Style-Stroke i kada 
vam se otvori prozor kao na slici lijevo kliknite 
kućicu sa bojom da odaberete boju obruba 
teksta. Pošto je kod mene pozadina zlatno žuta 
ja sam odabrao bijelu boju obruba a vi se 
ravnajte prema boji vaše pozadine pa odaberite 
boju koja vam odgovara. Na kraju podesite 
opciju Size po želji.  

 

 
 

Rezultat koji sam dobio nakon prethodnih 
koraka. Tekst je dobio lijepi bijeli obrub. 

 

Uz malo znanja sa stilovima možete postići 
sjajne stvari i ako bude interesovanja napisaću 
još nešto na ovu temu. Primjer možete vidjeti 
lijevo i na ovome crtežu sam primjenio Drop 
Shadow,Inner Glow,Bevel & Emboss,Satin i 
Color Overlay. 
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Spirala 
 
Poigrajte se sa nekoliko filtera i dobićete zanimljiv efekat koji možete upotrebiti za izradu avatara ili 
interesantne pozadine. 
 

 
 

Korak1.  

Otvorite novi dokument File-New 
proizvoljne veličine (kod mene je 500x500)  

 

 
 

Korak 2.  

Pritisnite taster D da izaberete crnu i bijelu 
boju pa idite na Filter-Render-Clouds i 
dobićete rezultat kao na slici lijevo.  

 

 
 

Korak 3.  

Idite na Filter-Pixelate-Mezzotint i u 
prozoru koji će vam iskočiti u padajućoj listi 
Type odaberite Medium Strokes .  

 

 

Korak 4.  

   

Idite na Filter-Blur-Radial Blur i podesite 
opcije kao na slici lijevo.  
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Korak 5.  

   

Idite na Filter-Distort-Twirl i zadajte 
vrijednost za Angle 120 .  

 

 
 

Korak 6.  

   

Napravite duplikat Backgrounda 
prevlačenjem na ikonicu New Layer.  

 

 
 

Korak 7.  

   

Na ovome novo sloju primjeni opet  

Filter-Distort-Twirl i ovaj put podesi 
vrijednost Angle na -180 .  

 

 
 

Korak 8.  
   
Promijeni model stapanja za ovaj sloj na 
Lighten i dobićete zanimljiv efekat.  
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Korak 9.  
Vrijeme je da nabacimo malo boje.  
1. Kliknite na paleti Layers Background da ga aktivirate  
2. i potom pozovite prozor Hue/Saturation sa kraticom na tastaturi Ctrl+U . Kada vam se otvorio ovaj 
prozor koji možete vidjeti na slici dole prvo potvrdite opciju Colorize i bacite se na podešavanje opcija.  
Prvo da objasnim šta znače ove opcije.  
Hue -ovim klizačem birate osnovnu boju i pomjerajući ga na jednu ili drugu stranu prikazujete boje iz 
spektra.  
Saturation -ovim klizačem podešavate zasićenost boje, što je ova vrijednost veća, boja je intezivnija i 
obratno.  
Lightness -ovim klizačem podešavate svijetliju ii tamniju nijansu neke boje,  
Ovo je bilo malo poučno ali da nastavimo sa radom. Kao što možete vidjeti na slici dole ja sam podesio 
Saturation na 62 a Hue i Lightness sam ostavio na nuli a vi možete podešavati kako god hoćete. Kada 
završite kliknite OK .  
 

 
 
 
Korak 10.  
Podesite i boje za gornji sloj ( Background copy ). Prvo ga aktivirajte klikom na njega na paleti Layers i 
potom ponovo pozovite prozor Hue/Saturation kraticom Ctrl+U . Opet prvo potvrdite opciju Colorize i 
podesite boju gornjeg sloja pomoću klizača u prozoru. Kada ste jednom gotovi kliknite OK i gotovi ste. Na 
slici dole možete vidjeti kako sam ja to uradio.  
 

 
 
Na donjoj fotografiji možete vidjeti moj rezultat. 
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Dreamy efekat 
 
Ovo je veoma popularan efekat i što je još važnije vrlo lako ga je primjeniti na nekoj fotografiji. Najbolje 
rezultate daje na panoramskim fotografijama pa ćemo u ovome tutorijalu koristiti baš jednu takvu. Pa da 
krenemo. 
 

 
 

Korak 1.  
 
Idite na File-Open i pronađite neku lijepu 
fotografiju a moju možete vidjeti lijevo.  
 

 
 

Korak 2.  
 
Da bi ovo funkcionalisalo kako treba za početak 
moramo posvijetliti fotografiju a to se radi sa 
komandom Image-Adjustments-
Shadow/Highlights. Kada vam iskoči prozor kao 
na slici lijevo, ostavite podrazumjevane vrijednosti, 
samo kliknite OK . Ovo će biti sasvim dovoljno za 
početak. Finom podešavanju ćemo se vratiti u 
nastavku ovoga tutorijala.  
 

 

Korak 3.  
   
Napravite duplikat backgrounda prevlačenjem na 
ikonicu New Layer ili kraticom na tastaturi Ctrl+J i 
promijenite mu model stapanja na Multiply kao na 
slici lijevo.  
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Korak 4.  
   
Na ovome novom sloju primjenite Filter-Blur-
Gaussian Blur i podesite vrijednost kao na slici.  
Napomena: ako radite sa fotografijom većih 
dimenzija možete staviti i veću vrijednost ili svejedno 
pokušajte sa ovom kao na slici lijevo.  
 

 
 

Korak 5. 
  
Ovo je opcija.  
Ako je vaša fotografija i dalje pretamna (vjerovatno 
jeste) možete je još posvijeliti na isti način kao u 
koraku 2 .  
Kliknite na Background da ga aktivirate i opet 
upotrebite komandu Image-Adjustments-
Shadow/Highlights . Kada vam se otvori prozor sa 
opcijama podesite vrijednosti Shadow i Highlights 
do zadovoljavajućeg rezultata.  
 

 

Na slici lijevo vidite kako je to kod mene ispalo 

 



PHOTOSHOP - Tutorijali 

 135 

 
Contact sheet (kako da odštampate veliki broj fotografija) 
 
Ako imate digitalni fotoaparat onda sasvim sigurno imate i gomilu fotografija na kompjuteru. U ovome 
tutorijalu ćete naučiti kako da ih odštampate a ne morate dizati kredit za to. Ja sam prije nekih mjesec dana 
pregledavao porodične fotografije koje su se nakupljale godinama i na sopstveni užas otkrio da se toga 
nakupilo za jedan pun CD - preko 700. Ali nije ni čudo, kada imate digitalni aparat samo škljocate a kada se 
napuni memorijska kartica jednostavno se isprazni na kompjuter i sve skupa se zaboravi.  
Najjeftiniji način da ovo uradite je da fotografije odnesete u neku od malih štamparija kojih danas ima na 
svakom koraku. Oni imaju moderne digitalne mašine sa kojim rade razne stvari od vizit karti do raznih 
brošura.  
U ovome tutorijalu ćete naučiti kako da pripremite fotografije za štampu. Poredaćete ih na list papira 
dimenzija 29,7cm x 42cm (format A3) i tako pripremljene ih možete odnijeti u štampariju da ih urade.  
   
Korak 1.  
   
Prebacite vaše fotografije u jednu mapu. Na slici dole možete vidjeti moju mapu sa porodičnim fotografijama 
(to je samo jedan mali djelić). Kada ste to uradili zatvorite je i pokrenite Photoshop .  

 
 
Korak 2.  
   
Kada ste ga otvorili, idite na File-Automate-Contact Sheet i otvoriće vam se prozor kao na slici dole.  
U dijelu prozora Source Images u opciji Use u padajućoj listi odaberite Folder ako kojim slučajem nije 
odabrana.  
Ostale opcije podesite čitajući uputstva u sljedećem koraku.  
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Korak 3. (pratite fotografiju gore)  
   
1.kliknite dugme Browse i kada vam iskoči prozorčić kao 
na slici lijevo pronađite u njemu vašu mapu sa 
fotografijama i kliknite OK  
2.podesite opciju Units na cm (centimetri)  
3.unesite dimenzije lista na kom će se štampati vaše 
fotografije (ovo su dimenzije A3 formata)  
4.unesite rezoluciju 150 i odaberite u padajućoj listi 
pixel/inch  
5.u padajućoj listi Mode odaberite RGB ako to nije slučaj  
6.potvrdite opciju Flatten All Layers  
7.povrdite opciju Use Auto Spacing  
8.unesite broj kolona i redova Columns-2 i Rows-4  
9.potvrdite opciju Rotate for Best Fit  
10.obavezno isključite opciju Use Filename as Caption  
   
Na kraju kliknite OK .  
 

  
Program će automatski poredati vaše fotografije na listove papira A3 formata i napraviće upravo onoliko 
listova koliko je potrebno. Na slici dole možete vidjeti dio tog processa na mom kompjuteru. Uglavnom 
odmorite se dok kompjuter završi posao.  

  
 
Na donjoj fotografiji vidite jedan list sa fotografijama i kao što možete primjetiti kompjuter ih je pravilno 
poredao bez obzira na orijentaciju fotografije. 

 

Na kraju snimite listove File-Save As u neku mapu i 
sve skupa zapecite na CD i odnesite štamparu da 
vam ih odštampa. On će to lijepo da uradi za male 
pare na odgovarajućem papiru i lijepo ih isječe. Ja 
sam na primjer u ovoj vježbi koristio 56 fotografija i 
one su stale na 7 listova A3 formata. Jedan list A3 
formata, kvalitete Super Gloss je oko 0,80 eura. 
Jednostavnom računicom ovo sve skupa bi me 
koštalo 5,6 eura a kod fotografa bi to bilo oko 14 
eura. Ušteda nije beznačajna naročito ako imate 
čitavu gomilu fotografija. Nadam se da vam se 
dopao ovaj tutorijal i ako imate neko pitanje za 
mene možete mi pisati na forumu i rado ću vam 
odgovoriti. Pozdrav. 
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Save for web 
 
Siguran sam da ste čuli za riječ rezolucija i mnogi od vas tačno znaju šta je to ustvari. Za one koji nisu 
sigurni jedno malo i kratko objašnjenje. Rezolucija označava broj piksela (malih kvadratića iz kojih se sastoji 
fotografija) na dužini jednog centimetra ili inča. Što je veći broj piksela na tom dužnom centimetru ili inču 
fajl je veći ali i fotografija je oštrija i jasnija. Napravite jednostavnu računicu:  
Ako je fotografija 10x10 cm i rezolucije 100 piksela po centimetru (što je jednako 254 piksela po inču) onda 
jednostavnim množenjem zaključujemo da je veličina ove fotografije izraženo u pikselima 1000x1000 piksela 
ili opet množenjem na površini fotografije se nalazi ukupno  
1 000 000 piksela . Svaki piksel je podatak koji kompjuter mora da pročita i prenese ga na vaš monitor. 
Kada skidate ovakvu fotografiu sa weba onda za tako nešto treba vremena ako imate sporu konekciju.  
Ako postavimo fotografiju na web i želimo da je svako može lako učitati i vidjeti bez obzira na brzinu 
konekcije, onda moramo da napravimo kompromis i smanjimo veličinu fajla (broj piksela). Fotografija će 
izgubiti na svojoj kvaliteti ali će bar svima biti dostupna ili vidljiva. U ovome tutorijalu ćete naučiti kako da 
pravilno optimizujete fotografiju sa zgodnom alatkom u fotošopu. Razlika u količina podataka-veličini fajla 
između originalne i optimizovane fotografije će biti ogromna a fotografija će biti gotovo nepromjenjena osim 
za iskusno oko.  
 

 
 

Korak 1.  
   
Otvorite fotografiju koju želite da optimizujete File-
Open . Moju možete vidjeti lijevo.  
 

 
 

Korak 2.  
   
Na paleti History kliknite ikonicu Create new..... 
(označeno strelicom) da napravite duplikat 
fotografije. Zatvorite originalnu fotografiju da je 
sačuvate u tom obliku i nastavite rad sa duplikatom.  
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Korak 3.  
   
Idite na Image-Image Size i otvoriće vam se 
prozor kao na slici lijevo. U njemu možete pronaći 
informacije o vašoj fotografiji.  
Podesite rezoluciju na 72 ppi (crveni okvir), to je 
uobičajena rezolucija za web. Ako želite izmjenite 
fizičku veličinu fotografije upišite u kućicu Widht ili 
Height novu dimenziju. Zeleni okvir označava da će 
promjenom jedne od dimenzija ostati sačuvane 
proporcije fotografije, drugim riječima kada 
promijenite jednu od dimenzija program će 
automatski i proporcionalno promijeniti i drugu 
dimenziju. Kada ste gotovi kliknite OK 
 

 
Korak 4.  
   
Idite na File-Save for web i otvoriće vam se novi prozor kao na slici dole. U ovome prozoru možete 
optimizovati vašu fotografiju za web i vidjeti rezultat prije nego što je postavite. Upoznajte najvažnije opcije 
u ovome prozoru.  
   
kartice sa različitim prikazima fotografije (originalna fotografija,optimizovana, 2 prikaza fotografije i 4 prikaza 
fotografije) –odaberite prikaz koji vam najbolje odgovara a to je kod mene prikaz 2-Up -originalna i 
optimizovana fotografija  
razne alatke kao što je Hand tool -za pomicanje fotografije u prozoru, Slice tool -za pravljenje isječaka, 
Zoom tool za uvećavanje prikaza ( pritisnuti Alt za smanjivanje ), Eye droper tool za ispitivanje boja 
(rezultati se vide na statusnoj liniji), Eye droper color -prikaz uzorkovane boje i Toggle slice visibility -
alatka za prikazivanje granica isječaka. Sve u svemu ove alatke ćete rijetko koristiti pa nemojte da se 
zamarate previše sa njima.  
izaberite format fotografije u padajućoj listi, ja upotrebljavam uglavnom JPEG što i vama savjetujem bar što 
se fotografija tiče  
izaberite nivo kvaliteta, možete eksperimentisati, što je kvalitet veći i fajl je veći a moj savjet je da ova opcija 
bude podešena na 30 jer daje najbolji odnos između veličine fajla i kvaliteta prikaza fotografije.  
prozor sa prikazom originalne fotografije i veličinom fajla  
prozor sa prikazom optimizovane fotografije i veličinom fajla sa predviđenom brzinom učitavanja pri brzini od 
28 kb u sekundi (ova brzina je prevaziđena ali možete lako izračunati za koliko se fotografija može učitati sa 
modemom 56 kb u sekundi)  
na kraju prozor Image size i u njemu možete mijenjati dimenzije vaše fotografije ali pošto smo to već uradili 
u koraku 3 onda nema potrebe da vam objašnjavam. Glavno je da znate da vam je i u ovome prozoru data 
mogućnost da to podešavate.  
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Vatreni tekst 
 

 
 

Korak 1.  
   
Otvorite novi dokument File-New i podesite 
vrijednosti kao na slici lijevo. Dimenzije su 
proizvoljne, važno je da pozadina bude bijela.  
 

 
 

Korak 2.  
   
Uzmite Text tool i napišite nešto. Odaberite 
neki „deblji“ font, kod mene je Cancun a ako ga 
nemate dobro će poslužiti i Arial Black ili Impact. 
Veličinu slova podesite prema veličini platna.  
 

 
 

Korak 3.  
   
Rasterizujte vaš text (podijelite ga u pixele) 
Layer-Rasterize-Type da bi mogli da 
primjenimo jedan filter. Nakon ovog aidite na 
Filter-Distort-Glass i kada vam iskoči prozor 
kao na slici lijevo podesite vrijednosti kao na 
njoj. U padajućoj listi Texture odaberite 
Frosted . U ovoj fazi vaš tekst bi trebao da 
izgleda kao na slici lijevo.  
 

 

Korak 4.  
   
Pritisnite na tastaturi Shift+Ctrl+E da slijepite 
slojeve. Potom pritisnite Ctrl +I da obrnete 
boje-šta je bilo bijelo postaće crno i šta je bilo 
crno postaće bijelo.  
Iz kutije sa alatima uzmite Magic Wand tool i 
sa njom kliknite negdje na crnu površinu 
pozadine da je ubacite u selekciju. Nakon ovoga 
idite na Select-Inverse da odaberete text.  
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Korak 5.  
   
Snimite vašu selekciju, trebaće vam kasnije. 
Idite na Select-Save selection i kada vam se 
otvori prozor kao na slici lijevo u kućicu Name 
upišite „selekcija“ . Na ovaj način ste snimili 
selekciju na posebnom kanalu. Kliknite OK i to 
je to. Izađite iz selekcije sa kraticom na 
tastaturi Ctrl+ D.  
 

 
 

Korak 6.  
   
Pravimo plamene jezičke. Idite na Image-
Rotate Canvas-90 CCW da okrenete platno 
za 90 stepeni obrnuto od kazaljke na satu.  
Idite na Filter-Stylize-Wind i podesite 
vrijednosti kao na slici lijevo i kliknite OK. Na 
tastaturi protisnite 2-3 puta Ctrl+F da 
ponovite ovaj filter da bi vaši plameni jezičci bili 
duži.  
 

 
 

Korak 7.  
   
Okrenite platno nazad. Idite na Image-Rotate 
Canvas-90 CW . Nakon ovoga idite na Filter-
Distort-Ripple i kada vam iskoči prozor kao na 
slici lijevo podesite vrijednosti kao na njoj i 
kliknite OK . Plameni jezičci već na nešto liče.  
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Korak 8.  

   

Napravite još jedan prazan sloj klikom na 
ikonicu Create New Layer .  

 

 
 
 
 

Korak 9.  

   

Pozovite selekciju koju ste snimili u koraku 
5. Idite na Selection-Load Selection i kada 
vam iskoči prozor kao na slici lijevo u 
padajućoj listi Channel potražite kanal 
„selekcija“ i kliknite OK.  

 

 
 

Korak 10.  

   

Selekcija se pojavila oko slova ali ne i oko 
plamenih jezičaka (tako i treba). Idite na 
Edit –Stroke i kada vam iskoči prozor kao 
na slici lijevo podesite vrijednosti kao na 
njoj i kliknite OK.  

Slijepite ponovo slojeve sa kraticom na 
tastaturi Shift- Ctrl+E i izađite iz selekcije 
sa kraticom Crtl+D .  
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Korak 11.  

   

Najlakši način da obojimo naš tekst je da ga 
pretvorimo u format GIF. Idite na Image-
Mode-Indexed Color , vidite prozor koji će 
iskočiti na slici lijevo, u njemu samo 
kliknite OK .  

 

 
 
 

Korak 12.  

   

Idite na Image-Mode-Color Table i kada 
vam se otvori prozor kao na slici lijevo u 
padajućoj listi Table odaberite Black 
Body . Kliknite OK to je to.  

 

 

Čitava stvar se pretvorila u plameni tekst. 
Vratite sliku u model RGB pomoću komande 
Image-Mode-RGB i snimite je File-Save As 
u JPEG formatu. Nadam se da vam se dopao 
ovaj tutorijal i ako imate neko pitanje za mene 
možete mi pisati na forumu i rado ću vam 
odgovoriti. Pozdrav. 
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Clliping group 
 
Komandu Create Clliping Mask možete naći u meniju Layer i pomoću nje možete vašu fotografiju ubaciti u 
bilo koji objekat koji se nalazi na sloju ispod fotografije. U ovoj vježbi ubacićemo fotografiju u tekst i sve to 
za 5 minuta . Otvorite vašu fotografiju a moju možete vidjeti dole. To može biti bilo koja fotografija i uopšte 
ne mora da bude panoramska kao ova moja. 

 
 
Na paleti Layers kliknite dva puta na Background da pozadinu pretvorite u sloj. Program će mu automatski 
dati ime Layer 0.  
Nakon ovoga na paleti Layers kliknite ikonicu New Layer da napravite novi sloj pa ga prevucite ispod 
sloja sa fotografijom.  
Obojite ovaj sloj sa bijelom bojom. Upotrebite sljedeće kratice da to uradite.  
-pritisnite taster D pa potom taster X da vam foreground boja bude bijela  
-zatim pritisnite Alt + Backspace ili Alt + Delete i sloj će se obojiti bijelom bojom.  
Na kraju ovoga koraka vaša paleta Layers bi trebala izgledati kao na slici dole.  
 

 
 
Na paleti Layers kliknite na sloj sa fotografijom da ga aktivirate i potom ponovo kliknite na taster D da 
izaberete crnu boju. U kutiji sa alatkama kliknite na Text tool i na liniji opcija koju možete vidjeti na slici 
dole odaberite neki font sa debelim slovima (karakterima). Ja sam odabrao Impact a vi koji hoćete i 
podesite veličinu slova po potrebi (kod mene je 250 pt). 
 

 
 

Napišite nešto preko fotografije i kada ste završili kliknite znak potvrde  a liniji opcija. Dotjerajte ponovo 
veličinu slova na liniji opcija da ona prekriju vašu fotografiju i sa Move tool   podesite poziciju teksta. 
Vaša rad bi sada trebao izgledati kao na slici dole. 



PHOTOSHOP - Tutorijali 

 144 

 
 
Na paleti Layers kliknite na sloj sa fotografijom i prevucite ga na vrh iznad sloja sa tekstom. Ovo je od 
ključne važnosti jer fotografiju možemo ubaciti u objekat samo ako se nalazi iznad objekta. 
 

 
 
Idite na Layer-Create Clliping Mask ili prečicom na tastaturi Ctrl +G . Vaša fotografija je „upala“ u slova 
i možete uzeti Move tool  i slobodno je micati da pronađete odgovarajuću poziciju. Na slici dole možete 
vidjeti moj rezultat. 
 

 
 
Dodajte malo šminke. Aktivirajte sloj sa tekstom pa idite na Layer-Layer Style-Stroke i kada vam se 
otvori prozor kao na slici dole podesite vrijednosti kao na njoj ili po volji (boju odaberete tako što ćete 
kliknuti na ovaj mali kvadratić sa bojom). Dodajte i malo sjenke Layer-Layer Style-Drop shadow i 
ostavite podrazumjevane vrijednosti u prozoru. 
 

 
 
Na kraju ove vježbe vaša fotografija bi trebala izgledati kao na slici dole. Slika je u slovima, dodali smo malo 
crnog okvira oko slova i na kraju malo senke. 
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Plakat- Total football 
 
Približava nam se Svjetsko prvenstvo u fudbalu i red je da to propratimo sa jednim tutorijalom. Napravićemo 
jedan jednostavan plakat uz pomoć dvije fotografije i uz malo strpljenja postići sjajne rezultate. Pošto je 
tema našeg plakata fudbal potrebna vam je jedna fotografija fudbalera u pokretu da plakat bude što 
atraktivniji i u nastavku ovoga tutorijala ćemo ga zvati model .  
Takođe potrebna vam je i jedna fotografija zalaska ili izlaska sunca koja će poslužiti za pozadinu vašeg 
plakata i ako takvu nemate vrlo lako je možete pronaći na internetu upisujući klučne riječi „sunset“ ili 
„sunrise“. Vodite računa da je na fotografiji jasno vidljiv horizont kao i na ovoj mojoj. Bilo kako bilo kada 
pronađete odgovarajuće fotografije možete početi sa radom.  
Napomena: vaš plakat može imati sasvim drugu temu i za model umjesto fudbalera uzmite nešto drugo.  
   
Korak 1.  
Otvorite ove dvije fotografije File-Open i pronađite ih na vašem disku. Moje fotografije možete vidjeti dole.  
 

 
 
Korak 2.  

Uzmite Pen tool  iz kutije sa alatima i na paleti svojstava(opcija) za ovu alatku kliknite ikonicu koju 
sam zaokružio na slici dole. Uz pomoć ove alatke ćete napraviti čistu i lijepu putanju koja će obuhvatiti naš 
model. Ovo se obično radi sa nekim od programa za vektorsku grafiku (Illustrator ili Corel Draw) ali možemo 
to uraditi vrlo uspješno i u fotošopu. 
 

 
 
Korak 3.  
Kliknite na sliku sa modelom i uvećajte je na paleti Navigator da lakše radite i počnite praviti putanju oko 
vašeg modela klik po klik. Svaki klik pravi po jedan čvor i program ih automatski povezuje linijom. Uglavnom 
potrebno je malo strpljenja da se obuhvati kompletna kontura modela ali ništa vas ne sprečava da se 
povremeno odmarate i nastavite kasnije. Što budete precizniji i vaša kontura će biti ljepša.  
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Korak 4.  
Na donjoj fotografiji vidite da sam crvenom linijom obojio putanju sa kojom sam obuhvatio naš model i to je 
samo zato da se bolje vidi (inače u stvarnosti to je obična siva linija). OK nastavite dalje, alatku Pen tool 

 nanesite unutar konture i kliknite desno dugme miša i u meniju koji će iskočiti kliknite na opciju 
Make Selection . 
 

 
 

Korak 5.  

Nakon prošlog koraka iskočiće novi prozor koji možete vidjeti na slici dole i u njemu upišite za 
vrijednost Feather Radius 0 pixela . Sa ovim postupkom smo naznačili programu da hoćemo čistu 
selekciju bez „umekšavanja“. Kada ste kliknuli OK tamo gdje se nalazila putanja pojavila se linija 
selekcije u vidu marširajućih mrava.  

 
 
Korak 6.  
Pošto smo „izolovali“ model od pozadine vrijeme da je obrišemo jer nam neće biti potrebna. Kao prvo 
pritisnite taster D na vašoj tastaturi da izaberete podrazumjevane boje (crnu i bijelu).  
Sljedeće što treba da napravite je da idete na Select-Inverse da izaberete pozadinu i potom kliknite taster 
Delete . Pozadinu ste izbrisali pa opet idite na Select-Inverse da ponovo izaberete model i potom na 
tastaturi pritisnite Alt+Backspace . Vaš model se obojio u crno i ovim smo upravo završili lavovski dio 
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posla. Još samo jedna stvar, uzmite Magic Wand tool  iz kutije sa alatima i sa njom kliknite unutar 
našeg modela (crnu boju) da ga ubacite u selekciju. Na donjoj slici možete vidjeti moj rezultat. Napravili ste 
lijepu konturu fudbalera.  
 

 
 
Korak 7.  

Aktivirajte fotografiju koja će nam poslužiti za pozadinu plakata, uzmite Rectangular Marquee tool  z 
kutije sa alatima, pa sa njom označite donji dio fotografije sve do horizonta kao na donjoj slici. Pritinite 
Alt+Backspace da ovaj dio fotografije obojite u crno i to bi bilo sve na ovoj fotografiji. Izađite iz selekcije 
sa Select-Deselect ili kraticom na tastaturi Ctrl+D . 
 

 
 
 
Korak 8.  
Uzmite iz kutije sa alatima Move tool  aktivirajte fotografiju sa modelom pa nanesite alatku unutar 
selekcije (modela) i prevucite model na novu pozadinu koju smo pripremili za njega. 
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Korak 9.  
Kada ste prevukli model na novu pozadinu vjerovatno je da ćete morati dotjerati njegove dimenzije. Na mom 
primjeru model je prevelik i moram da ga smanjim (vidi sliku dole).  
Da bi ovo uradili idite na Edit-Transform-Scale i kada se oko modela pojave „ručice“ pritisnite taster 
Shift i držite ga dok povlačite jedan od ugaonih ručica prema unutra ili van zavisi od toga šta radite, 
smanjujete ga ili povećavate.  

 
 
Korak 10.  
Na donjoj slici vidite kako sam ja to uradio. Smanjio sam model i našao mu dobro mjesto na pozadini. Da ne 
bude zabune stvari pomjerate sa alatkom Move tool 

Na kraju uzmite Text tool  iz kutije sa alatima, smislite neki tekst i nešto napišite. Ja se nisam baš 
iskazao pa sam samo napisao „Total football“ i „Germany 2006“. Svakako da jedan plakat mora da sadrži 
više informacija ali to ipak nije tema ovoga tutorijala. Bilo kako bilo plakat je zamalo gotov i preostaje da 
odsječemo dio pozadine koja nam nije potrebna. 
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Korak 11.  

Iz kutije sa alatima izmite Crop tool  i sa njim označite dio fotografije koji želite da ostavite. Kao i u 
koraku 9. oko izabranog područja će se pojaviti ručice koje možete povlačiti da pronađete idealne proporcije 
za vaš plakat. Kada ste jednom gotovi kliknite znak potvrde na liniji opcija i plakat će biti isječen. Na donjoj 
fotografiji vidite kako sam ja to radio. 
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Na slici dole možete vidjeti kako to kod mene izgleda. Iako je bilo mnogo posla da se ovo postigne vjerujem 
da se na kraju isplatilo.  
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Popunjavanje bojom (filling) 
 
"Bojenje" (filling) selekcije (odabranog dela slike) ili celog sloja (layer) predstavlja popunjavanje određenom 
bojom datog elementa slike 

 
Nema dobrog objašnjenja izraza "popunjavanje bojom" 
(bojenja) bez same definicije: "Bojenje" (filling) selekcije 
(odabranog dela slike) ili celog sloja (layer) predstavlja 
popunjavanje određenom bojom datog elementa 
slike (selekcije ili sloja). Slična ovoj funkciji je i funkcija 
"Stroke" koja vrši popunu bojom, ali samo po ivicama 
izabranog dela slike, i to u određenoj veličini (u pikselima) i u 
određenom smeru (spolja, iznutra ili centralno). 
Sama popuna bojom može da se izvrši na nekoliko načina, uz 
pomoć različitih alatki: 
 
 
 
 
 
 

 
Prva mogućnost je putem alatke "Paint Bucket Tool" (takođe poznata kao i "Fill tool"). Ova alatka leži u istoj 
"kućici" (na paleti alatki) kao i alatka "Gradient tool". Ovom alatkom možete izvršiti popunu neke selekcije 
prednjom (foreground) bojom ili nekom šarom-obrascem (pattern), jednostavnim izborom alatke, te klikom 
na datu površinu. Pored popuna izabranih selekcija, možete izvršiti i bojenje određenih površina koje nisu 
selektovane, a imaju istu boju. Na primer, ako je deo slike prekriven određenim brojem piksela crvene boje, 
a vi kao foreground boju izaberete plavu, te kliknete na bilo koji od crvenih piksela - izvršiće se popuna 
plavom bojom svih crvenih piksela. 
 
Druga mogućnost je "Fill" komanda. Izaberite padajući meni [Edit > Fill] za popunu foreground bojom ili 
izabranom šemom. U novoj verziji Photoshop-a (verzija 6), nije više potrebno da bude selektovan deo slike 
da bi komanda Fill uopšte bila dostupna. Ukoliko pozovete ovu komandu, a ni jedan deo slike nije izabran, 
bojom će se popuniti cela površina sloja. Prečica sa tastature za ovu komandu je [Shift+Backspace] 
 
Treća mogućnost je uz pomoć tastera [Backspace]. Nakon selekcije dela površine sloja (kod slika sa jednim 
slojem) ili dela pozadine (background layer), možete izvršiti popunu sa background bojom (ne foreground) - 
jednostavnim pritiskom tastera [Backspace] ili [Delete]. Kod bilo koje druge vrste slojeva, pritisnite 
kombinaciju [Ctrl+Backspace]. Kombinacija za popunu foreground bojom je [Alt+Backspace]. 
 
Još jedna mogućnost je popuna slojeva uz pomoć funkcije "Layer Style", kojom sloj možemo da "ofarbamo" 
standardnim bojama, gradijentima i šemama. 
 
Uz pomoć prethodno navedenih načina za popunu bojom, probajte da što više vežbate, jer se samo stalnom 
vežbom stiče prava rutina, te onda nije teško postići bilo šta što se zamisli. 
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Kreiranje sličice za Desktop 
 
 

 
Verovatno vam se bar jednom desilo da vam se svidi neka 
pozadinska boja, nekog DeskTop-a. Posebno su lepe pastelne boje 
koje dolaze uz nove Windows-e i novi OfficeXP. Evo kako možete da 
uz malo truda i Photoshop kreirate lepe pozadine i osvežite stari 
DeskTop:  
 
Pokrenite neki od Office programa ili bilo koju aplikaciju koja ima 
određene boje koje vam se sviđaju, a za koje neznate njihov kod 
(heksadecimalni RGB  
triplet). Bitno je da prozor date apliakcije bude vidljiv. Kada prozor 
posatne vidljiv, pritisnite taster "Print Screen", koji se nalazi levo od 
tastera "F12" na tastaturi. Ovim smo snimili sadržaj (sliku) ekrana u 
privremenu memoriju 
(clipboard). 
 
 

 
 
 
Zatim pokrenite Photoshop(ili bilo koji drugi grafički program) i izaberite "File > New", te u novom dijalogu 
samo kliknite "OK". Potom pritisnite kombinaciju"Ctrl+V" radi dobijanja sadržaja clipboard-a. 
 
Izaberite alatku "Eyedropper Tool(I)" (pipetu) sa palete alatki i kliknite unutar slike, i to na ono mesto gde se 
nalalazi tražena boja. Na ovaj način smo izvukli uzorak tražene boje. 
 
Kreiraćemo novu sliku, koja će biti buduća pozadina, pa zato pozovite "File > New", te u dijalogu unesite da 
veličina slike bude 1 puta 1 piksel (rezolucija neka bude standardnih 72 piksela/inču). Na kraju kliknite "OK". 
 
Dobićete prazno platno veoma male veličine (1 puta 1 piksel). Da bi ga uvećali i lakše obavili farbanje, 
pritiskajte kombinaciju "Ctrl+znak[+]", sve dok ne budete dovoljno jasno videli ovu malu tačku. 
 
Izaberite alatku "Paint Bucket Tool(G)" (kanticu sa bojom) i kliknite bilo gde u kvadrat 1 puta 1 piksel. 
 
Ostaje još samo da snimimo rad, izaberite "File > Save for Web". U "Settings" sekciji izaberite GIF format i 
kliknite "OK", pa će vas Photoshop upitati gde želite da snimite ovaj grafički fajl. Odredite neko zgodno 
mesto na disku i kliknite "Save". 
 
Na ovaj način smo kreirali grafički fajl koji ćemo iskoristiti za pozadinu. Da bi ovaj mali fajl (1 puta 1) prekrio 
celu radnu površinu, izvršićemo slaganje date slike, i to jedne pored druge duž čitavog ekrana. Tako će na 
primer za ekran rezolucije 800 puta 600 piksela, biti poslagano 480.000 ovih malih tačaka. Da bi podesili da 
ova slika bude pozadina uradite sledeće: 
 
1. Kliknite desnim tasterom na DeskTop i izaberite "Properties". 
 
2. U novom prozoru, na kartici "Background", kliknite dugme "Browse..." i pronađite malu sliku na disku. 
 
3. I na kraju da bi izvršili slaganje sličice duž celog ekrana, iz liste "Picture Display" izaberite "Tile". Kliknite 
"OK" i posao je završen 
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Isecanje slike 
 
Na koji način smaniti veličinu ili izdvojiti jedan deo originalne slike?  
Pa naravno, uz pomoć vrlo moćne alatke 
Crop 

Termin "isecanje slike" se odnosi na smanjenje aktuelne 
veličine slike u pikselima, odnosno izdvajanje jednog njenog 
dela i odbacivanje ostatka. Dok je za suprotnu aktivnost 
(povećanje slike - platna) najsvrsishodnija komanda Image > 
Canvas Size. Naravno, ova komanda može da posluži i 
smanjenje slike, ali veću kontrolu imamo ako koristimo alatku 
Crop. Pa da vidimo kako se ova alatka koristi. 
 
 
 
 

U Photoshop-u otvorite bilo koju sliku, pa pritisnite C na tastaturi ili kliknite na Crop alatku u paleti alatki. U 
novoj verziji Photoshop-a ova alatka je dobila posebno mesto, dok se u pređašnjim nalazila zajedno sa 
alatkama za obeležavanje (Marquee). Sve što treba da uradite je da kliknete bilo gde na slici i "nacrtate" 
(dijalognalnim prevlačenjem pokazivača miša) pravougaonik. Pri samom obeležavanju onoga što želimo da 
"isečemo", isecanje možemo da kontrolišemo na dva načina: 
 
Da bi bolje radvojili (razgraničili) deo slike koji izdvajamo i "višak" slike, Photoshop prikazuje providno obojen 
deo slike van Crop pravougaonika (kao na slici). Ukoliko vam ova opcija smeta, samo poništite polje za 
potvrdu Shield cropped area koje se nalazi na liniji opcija (ispod linije menija). Takođe, ako kliknete na 
dugme pored ovog polja - Color, moćićete da izaberete boju za markiranje. Zapazite samo, da se nijedna od 
ovih kontrola 
neće pojaviti sve dok ne napravite selekciju. 
 
Druga bitna opcija je što sada pored toga što možete da "odbacite" višak piksela, sada možete i samo da ga 
sakrijete, što znači da nema isecanja. Zato pre nego što krenete sa kreiranjem selekcije, odaberite dugme 
Delete ili Hide na liniji opcija. Ukoliko ste izabrali opciju Hide, moćićete da povratite skriveni deo slike 
komandom Image > Reveal All. 
 
Nije bitno da li ste u prvi mah zadovoljni selekcijom, pošto kasnije možete napraviti potrebna korekcije: 
 
Za premeštanje selog selekcionog pravougaonika, kliknite unutar njega i prevucite ga na drugo mesto. 
 
Za promenu veličine selekcionog pravougaonika, kliknite na neki od malih kvadratića na ivicama 
pravougaonika i "razvucite" selekciju. Za proporcionalnu promenu veličine, prilikom prevlačenja držite 
pritisnut taster [Shift] 

-  Za rotiranje selekcije, treba da pokazivač miša postavite van selekcije i kada se pokazivač miša 
promeni u dvostruku zakrivljenu strelicu, kliknite i pomerajte pkazivač kružno. Selekcija će se 
okretati oko centralne tačke, koju takođe možete izmeštati. 

 
Kada ste zadovoljni selekcijom, pritisnite [Enter] na tastaturi ili dvostruko klik 
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Upotreba "magnetnog lasoa" 
 
Opcrtavanjem nekog lika na slici uz pomoć alatke Magnetic lasso možemo da izvršimo vrlo preciznu selekciju. 

 
Da bi vam bio jasniji princip rada ove alatke (Magnetic lasso), 
vratićemo se u vreme crno-belih monitora i iste takve grafike. U 
programima koji su bili prethodnica alata kakav je Photoshop, kod 
crtanja niste imali mogućnost biranja boja, već ste imali samo crnu 
boju na beloj pozadini. Popunjavanjem belih piksela crnom bojom, 
gradili ste crteže koji se nisu mogli pohvaliti naročitim kvalitetom. Da bi 
izvršili selekciju nacrtanog lika, bilo je dovoljno običnim "lasom" 
(lasso) opcrtati oko željenog lika i program bi automatski izdvojio crne 
piksele. Ovo je upravo bio početak "pametne" selekcije. U današnjici 
Photoshop je unapredio i prebacio ovu tehnologiju u svet boja, tako da 
ako sada magnetnim lasom opcrtate neki lik na nekoj grafici biće 
besprekorno izdvijen (naravno u idealnim uslovima). 

 
 
Sada ćemo da vidimo kako se koristi ova alatka. Neiskusni korisnici Photoshop-a često imaju dosta problema 
u radu sa ovom alatkom, i to uglavnom zato što pokušavaju da naprave vrlo složene selekcije. Morate imati 
na umu da ova alatka ima ograničenu upotrebu samo na određene tipove grafika. Radi probe, izaberite neku 
sliku na kojoj postoji jasna kolorna razlika između pozadinskog dela slike i nekog centralnog lika (kao na 
našoj slici), i tu sliku učitajte u Photoshop: 
 

- U plutajućoj paleti alatki izaberite "Magnetic Lasso Tool" ili držeći taster "Shift" pritiskajte slovo "L" 
sve dok ne bude aktivna data alatka. 

 
- Kliknite bilo gde na prelazu, između glavnog lika (obris telefona) i pozadinskog dela slike 

 
- Počnite sada lagano da pomerate pokazivač miša uz dati prelaz. Pri tome ne morate da držite levi 

taster miša i ne morate da klikćete na njega. Photoshop će, kako vi pomerate pokazivač, ostavljati 
liniju selekcije uzduž prelaza. Pored toga možete, na određenim rastojanjima, primetiti i kontrolne 
tačke. Ukoliko vam se pri selekciji ne svidi linija, potrebni je samo da kurzor vratite do prethodne 
kontrolne tačke i ponovo započnete selekciju. Ukoliko vam se ne svidi pozicija određene kontrolne 
tačke, potrebno je da pritisnete taster "Backspace" radi brisanja problematične tačke. Nakon ovoga 
vratite kurzor na početak prethodne tačke i ponovo krenite u selekciju. Inače, i sami možete 
postavljati kontrolne tačke, jednostavnim klikom na levi taster miša. 

 
- Kada napravite ceo krug oko objekta, i stignete do početne tačke, samo kliknite na prvu tačku radi 

zatvaranja selekcije. Ili, jednostavno napravite levi dvoklik mišem. 
 
 
Naravno, "magnetni laso" ne može načiniti čuda, ali će biti od velike pomoći kod određenih slika. Potrebi je 
samo da dobro izvažete - gde ovu alatku možete koristiti, a gde ne možete. 
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Minijaturne 3D tačke 
 
Predstavljamo tehniku kreiranja minijaturnih 3D tačkica i dugmića, gde se sav posao odvija na nivou 
pojedinačnih piksela. 
 

Evo priloga i poslastice za ljubitelje Photoshop-a. Radi se o tehnici kreiranja 
minijaturnih3D tačkica i dugmića, gde se sav posao odvija na nivou pojedinačnih 
piksela. Za ove potrebe radićemo sa najvećim uvećanjem, a to je 1600%. Da ne 
gubimo vreme, pokrenite Photoshop i prečicom Ctrl+N kreirajte novi dokument, 
čije će dimenzije biti recimo 20 puta 20 piksela, a rezolucija - ekranska 72 
pixel/inch. Pozadina, tj. boja platna neka bude bela (Contents - White). 
 
Da bi bolje videli ovo prazno platno (poligon sa 20 puta 20 kvadrata), 
naizmenično više puta pritisnite kombinaciju tastera "Ctrl + Alt + znak(+)". 
Uvećavajte do maksimuma -1600%. Sada imamo sve uslove za rad, a da bi 
dobili odgovarajući rezultat ispratite sledeće korake: 
 
U paleti alatki izaberite Pencil tool (prečica sa tastature B), a veličina vrha 
(brush) olovke neka bude samo 1 piksel. 
 
Pritisnite taster "D" radi uspostavljanja podrazumevanih boja, crna kao 
foreground i bela kao background. 
 
 

Kreirajte novi sloj (layer) klikom na dugme "Create new layer" na paleti Layers, ili samo pritisnite 
kombinaciju tastera "Ctrl + Shift + N". Dovedite pokazivač miša iznad platna i iscrtajte oblik kao na slici 1, 
gde je veličina samog oblika 4 puta 4 piksela(jedan prazan - dva puna - jedan prazan). 
 
Sada ćemo našoj tački-dugmiću dodati boju. Kliknite na polje Foreground i izaberite boju koja se vama sviđa. 
Ponovo izaberite Pencil tool i unutar nacrtanog oblika obojite bilo koja tri piksela, a onaj četvrti obojite belom 
bojom. Četvrti piksel će predstavljati odsjaj tačke. 
 
Na kraju, ostalo nam je da dodamo senku, radi 3D efekta. Kliknite na polje Foreground, pa izaberite neku 
blagu sivu nijansu, te iscrtajte oblik oko našeg pređašnjeg elementa kao na slici 2. Obratite pažnju da vam 
se siva nijansa nalazi u suprotnom uglu u odnosu na belu unutrašnju tačku. 
 
Ostalo nam je samo da smanjimo uvećanje i vidimo rezultat. Pritisnite više puta kombinaciju tastera "Ctrl + 
znak(-)" sve do vidljivosti platna od 100%. Na vama je samo da pronađete odgovarajuću primenu ovih malih 
3D tačkica. 
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Korišćenje Plug-In modula 
 
Plug-in's, softverski dodaci, predstavljaju dodatne module koje uglavnom razvijaju nezavisne softv. kuće, a 
sve u cilju poboljšanja Adobe alatki 
 

 
 
Plug-in moduli predstavljaju softverske dodatke, razvijene od strane firme Adobe (koja je i kreator 
Photoshop-a) ili drugih softverskih kompanija koje su vezane za firmu Adobe, koji proširuju mogućnosti 
Photoshop-a i ImageReady-ja. Jedan deo ovih modula dolazi i sa samom instalacijom Photoshop-a, a možete 
ih videti u folderu"Plug-Ins". Takođe, možete kreirati i koristiti, i neki drugi folder za instalaciju modula, s tim 
što ćete morati da dodate njihove prečice u folder "Plug-Ins". 
 
Jednom kada su instalirani, plug-in moduli se pojavljuju kao opcija menija Import ili Export; kao dodatni fajl 
format dijalog prozorima: Open, Save As i Export Original; ili kao filteri u meniju "Filter". Photoshop i 
ImageReady mogu da prihvate veliki broj plug-in modula, ali ukoliko njihov broj pređe kritičnu granicu, 
možda neće moći biti svi prikazani (izlistani). Najčešće se novoinstalirani plug-in moduli smeštaju u 
odgovarajuće podmenije menija "Filter" 
 
 
Za instalaciju "Adobe"-jevog plug-in modula uradite sledeće: 
 

- Za instalaciju iskoristite tzv. plug-in installer, ili 
- iskopirajte modul u odgovarajući "Plug-ins" folder, unutar Photoshop foldera. 

 
 
Za instalaciju plug-in modula drugih proizvođača uradite sledeće: 
 

- Pročitajte instrukcije u vezi instalacije, ako ih je proizvođač obezbedio uz isporuku plug-in modula. 
- Ako se plug-in moduli nalaze u nekom drugom folderu, potrebno je da "obavestimo" Photoshop da 

se dati moduli nalaze u odgovarajućem folderu. 
- Izaberite meni "Edit > Preferences > Plug-Ins & Scratch Disk", i potvrdite polje "Additional Plug-Ins 

Directory". Nakon ovoga kliknite dugme "Choose" i pronađite folder sa modulima u klasičnom 
"Browse" dijalog prozoru. 

- Restartujete Photoshop, da bi plug-in moduli imali efekta. 
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Kreiranje plastičnog dugmića 
 
Postupak izgradnje realističnog, plastičnog dugmića, koji može da posluži višestrukoj nameni. 
 
U izradi interfejsa, bio za Web ili za neku aplikaciju (softverski proizvod) gotovo je sigurno da ce vam 
zatrebati dugmić.  
 
Komandni dugmići mogu da budu klasičnog pravougaonog oblika, ali mogu biti i mnogo privlačniji - okrugli, i 
to vrlo zanimljivog plastičnog izgleda kojim možete oduševiti korisnike vaših proizvoda (interfejs). 
 
U narednim redovima ćemo vam po principu korak po korak, uz odgovarajuće ilustracije prikazati postupak 
dobijanja ovakvih dugmića. Alatka koju ćemo koristiti u procesu kreiranja je, naravno Photoshop. 
 
 
 

 
 

Pokrenite Photoshop i kreirajte novi dokument. Veličina neka bude recimo 200 puta 200 
piksela, a rezolucija 72 dpi. Kreirajte novi sloj (prečica [Ctrl+Shift+N]) pa izaberite 
alaku za kružno selekcionisanje - Elliptical marquee tool [M] i iscrtajte kružnu selekciju. 
Da bi dobili perfektni krug, prilikom kreiranja držite pritisnut taster [Shift]. 
 

 
 

Kliknite na foreground boju i u dijalogu Color picker podesite boju: R 255 , G 125 i B 
96. Izaberite alatku Paint Bucket Tool [G] i kliknite unutar kruzne selekcije kako bi 
popunili krug podedenom bojom. Nakon ovoga neka selekcija ostane netaknuta. 

 
 

Izaberite padajući meni Select > Modify > Contract, pa u dijalogu unesite 6, kako bi se 
selekcija smanjila za 6 piksela. Ova veličina moze biti različita, a sve u zavisnosti od 
veličine vaše kružne selekcije 
 
 

 
 

Proverite da li je još uvek u paleti sa alatkama izabrana Elliptical marquee tool alatka, a 
zatim uz pomoć tastera-strelica na tastaturi premsetite selekciju malo dole. U našem 
primeru, kliknuli smo dva puta taster - strelica dole. 
 
 

 

Pritisnite sada dugmiće [Ctrl] i [Alt], i kliknite jednom iznad sloja unutar palete Layers. 
Ovim ćete izvršiti deselekciju površine kruga u odnosu na pomerenu selekciju, tako da 
će vam ostati mali polumesec na dnu kružnice. 
 

 
 

Sada ponovite četvrti korak i pomerite selekciju vertikalno prema gore, koristeći 
tastere-strelice. Osigurajte da se vratite na istu poziciju sa koje se prethodno premestili 
selekciju. U našem primeru, pritisnuli smo strelicu gore, desetak puta. 
 

 
 

Kreirajte novi sloj (prečica [Ctrl+Shift+N]), izaberite meni Select > Feather i unesite 5. 
alatkom Paint Bucket Tool [G] popunite novonastalu selekciju belom bojom. Izvršite 
deselekciju i izaberite padajući meni Filter > Blur > Gaussian Blur, pa u dijalog za 
podešavanje unesite 5. 
 

 

Promenite modus sloja (unutar palete Layers) na Color dodge i transparentnost - 
osobinu Opacity na 75%. 
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Sada ćemo malo istaći osvetljenjem. Da bi ovo uradili držite pritisnute tastere [Ctrl] i 
kliknite sloj sa prvim krugom. Izaberite meni Select > Modify > Contracti u dijalogu 
unesite 6. Za razliku od prethodnog pomeranja, pomerite selekciju na gore, koristeći 
tastere-strelice. Potom, držeći tastere [Ctrl] i [Alt] kliknite na sloj sa kružnicom. Vratite 
ovu "okrnjenu" selekciju unutar kruga. 
 

 
 

Pređite na paletu Channels i kreirajte novi kanal, te selekciju obojte belom bojom. 
Izvršite deselekciju i primenite filter Filter > Blur > Gaussian Bluri unesite 5. 
 
 

 
 

Izaberite meni Image > Adjust > Levels, te unutar sekcije Input Levels unesite redom: 
110, 1.00 i 150. 
 
 

 
 

Držeći pritisnut taster [Ctrl] kliknite na novi kanal, pa se vratite na paletu Layersi 
kreirajte novi sloj. 
 
 

 
 

Izaberite sada alatku Gradient Tool [G], pa pritisnite taster [D], a zatim i [X] kao bi 
postavili podrazumevane boje (bela-crna). Pređite na paletu Options i u opcijama 
postavite Foreground to transparent. Napravite gradijent koji će startovati od vrha 
selekcije, a završiće se na dnu selekcije. 

 
 

Dodaćemo dugmiću i nešto senke. Kreirajte novi sloj, i držeći [Ctrl] kliknite na sloj sa 
kružnicom, popunite novi sloj crnom bojom, pa izaberite padajući meni Select > Modify 
> Contract. Kontrakcija (sužavanje) selekcije neka bude 3 piksela. 
 

 

Idite na meni Select > Feather i unesite 5. Pritisnite taster [Delete] i poništite selekciju 
(prečica[Ctrl+D]). Promenite još transparentonst ovog sloja - postavite Opacity na 
30%. 
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Kreiranje sloja sa grafičkim objektom 
 
U Photoshop-u možete kreirati posebnu vrstu layer-a, takozvane shape layere, koji se dobijaju korišćenjem 
alatki shape tool ili pen tool 
 

Photoshop nudi mogućnost kreiranja posebnih slojeva sa 
grafičkim objektima, tzv. shape layer-a, korišćenjem alatki 
shape tool() ili pen tool. Tehnički gledano, shape layer 
predstavlja obični fill(popunjavajući) layer sa popunjenim 
vektorskim putanjam (clipping path). Popunjavajući sloj 
definiše boju grafičkog objekta, dok vektorske putanje 
određuju geometrijski oblik objekta. Pri tome, vi možete 
izmeniti boju popune i druge atribute grafičkog objekta 
preuređenjem popunjavajućeg sloja i primenom različitih 
stilova na sloj. Tajođe, možete promeniti i sam geometrijski 
oblik, preuređenjem vektorskih putanja. 
Za kreiranje novog sloja sa grafičkim objektom, uradite 
sledeće: 
Odredite foreground boju, koja će zapravo biti boja ispune 
grafičkog objekta. 
 
Izaberite alatku rectangle tool (), zatim rounded rectangle 
tool (), ili ellipse tool (), ili alatku line tool (); dodatno, u 
Photoshop-u, možete izabrati polygon tool (), custom shape 
tool (), pen tool (), ili alatku freeform pen tool (). 
 
Na paleti Options, kliknite dugme Create New Shape Layer (), 
i podesite naredne opcije: 
 
Izaberite stil za sloj preko palete Layer Style, radi primene 
predefinisanog stila na grafički objekat. 
 
Odresite transparentnost sloja preko klizača Opacity unutar 
palete Layer Style. 
 
Ukoliko koristite alatku custom shape tool, izaberite neki od 
predefinisanih oblika sa palete Shape. 

 
Dodatno, možete podesiti opcije koje su vezane za pojedinačne alatke. 
 
Ako pri formiranju sloja koristite alatku shape tool, prevucite oblik na platno (canvas) radi iscrtavanja 
objekta. 
 
Ukoliko pak, koristite pen tool alatku, kliknite ili prevucite mišem na platno radi iscrtavanja objekta. 
Ako želite, možete na istom sloju (shape layer-u) iscrtati više objekata, zato samo nastavite sa daljim 
crtanjem: 
 

- Izaberite opciju shape area radi određivanja šta će se desiti u slučaju pojave preseka kod 
preklapanja objekata. 

 
- Možete izabrati i druge alatke sa palete, radi iscrtavanja više različitih objekata na istom sloju. 
 
- Kada koristite alatku shape tool, takođe možete selektovati različite grafičke oblikepreko palete 

Options. 
 

Na kraju, kliknite dugme OK () na paleti Options, ili pritisnite taster Enter, radi oslobađanja alatki za crtanje 
geometrijskih oblika. 
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Smooth Blending Old and Young Faces 
 

 
 

Otvorite sliku mlade osobe, sa licem u prvom planu. 

 
 

Ubacite sliku starije žene, čije je lice pod istim uglom 
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Smanjite opacity da bi videli donji layer.  
Prilagodite veličinu slike i postavite je preko lica na 
donjem layeru. 

 
 

Klikni na add vector mask dugme na layer paleti. 

 
 

Odaberi black to white gradient u linear modu. 
 
Primeni gradient sleva na desno. 
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Izaberi crnu kao foreground boju.  
 
Izaberi brush tool i izbriši nepotrebne delove slike. 

 
 

Promeni layer mode u luminosity. 

 

Krajnji rezultat bi trebao da bude otprilike ovakav. 

 
 


